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Executive Summary 1 

The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and 2 
Technology (NIST) built a laboratory to emulate a medical imaging environment, performed a risk 3 
assessment, and identified controls from the NIST Cybersecurity Framework to secure the medical 4 
imaging ecosystem. This project used Picture Archiving Communications Systems (PACS) and a Vendor 5 
Neutral Archive (VNA), and implemented controls to safeguard medical images from cybersecurity 6 
threats. PACS and VNA, hereafter referred to as “PACS,” comprise the systems to centrally manage 7 
medical imaging data. This effort resulted in a NIST Special Publication 1800 series Cybersecurity 8 
Practice Guide, based on the following considerations relative to PACS: 9 

 PACS allows for the acceptance, transfer, display, storage, and digital processing of medical 10 
images. PACS centralizes functions surrounding medical imaging workflows and serves as an 11 
authoritative repository of medical image information. Medical imaging is a critical component 12 
in rendering patient care. The PACS ecosystem serves as the repository to manage these images 13 
and accompanying clinical information within the healthcare delivery organization (HDO). 14 

 PACS fits within a highly complex HDO environment that includes back-office systems, electronic 15 
health record systems, and pharmacy and laboratory systems, as well as an array of electronic 16 
medical devices. In managing these systems, HDOs work with a diverse group of individuals who 17 
interact with the enterprise information technology (IT) infrastructure and may include IT 18 
operations staff, internal support teams, and biomedical engineers, as well as vendors and 19 
manufacturers.  20 

 Securing PACS presents several challenges. Various departments operating in the HDO have 21 
unique medical imaging needs and may operate their own PACS or other medical imaging 22 
archiving systems. Further, HDOs may use external medical imaging specialists when reviewing 23 
patient medical data. The PACS ecosystem, therefore, may include multiple systems for 24 
managing medical imaging data, along with a diverse clinical user community, accessing PACS 25 
from different locations. This complexity leads to cybersecurity challenges. 26 

 PACS may have vulnerabilities that, given its central nature, may impact an HDO’s ability to 27 
render patient care or to preserve patient privacy. These vulnerabilities could impede the timely 28 
diagnosis and treatment of patients, if medical images are altered or misdirected. These 29 
vulnerabilities could also expose an HDO to risks of significant data loss, malware and 30 
ransomware attacks, and unauthorized access to other parts of an HDO enterprise network. 31 

 This NIST Cybersecurity Practice Guide features a reference architecture using commercially 32 
available, standards-based tools and technologies demonstrating how HDOs can securely 33 
configure and deploy PACS.  34 

CHALLENGE 35 

PACS, by its nature, is a system that cannot operate in isolation. The overall PACS ecosystem consists of 36 
diverse technologies that include medical imaging devices, patient registry systems, worklist 37 
management systems, and systems used to manage and maintain medical image archives. The primary 38 
role of PACS is interaction with disparate medical imaging devices, interconnectivity with other clinical 39 
systems, and allowing a geographically and organizationally diverse team of healthcare professionals to 40 
review medical images to provide quality and timely patient care. Therefore, the threat landscape is 41 
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broad. If not properly secured, vulnerabilities may be introduced into the PACS ecosystem, either 42 
affecting clinical information stored in the PACS environment or allowing  malicious actors to leverage 43 
components within the ecosystem as pivot points into the integrated healthcare information system. 44 

SOLUTION 45 

This practice guide demonstrates how an organization may implement a solution to mitigate identified 46 
risks. The reference architecture includes technical and process controls to implement:  47 

 a defense-in-depth solution, including network zoning that allows for more granular control of 48 
network traffic flows and limits communications capabilities to the minimum necessary to 49 
support business function 50 

 access control mechanisms that include multifactor authentication for care providers, 51 
certificate-based authentication for imaging devices and clinical systems, and mechanisms that 52 
limit vendor remote support to medical imaging components 53 

 a holistic risk management approach that includes medical device asset management, 54 
augmenting enterprise security controls and leveraging behavioral analytic tools for near real-55 
time threat and vulnerability management in conjunction with managed security solution 56 
providers  57 

In building the reference architecture, the NCCoE sought existing technologies that provided the 58 
following capabilities: 59 

 role-based access control 60 

 authentication 61 

 network access control 62 

 endpoint protection 63 

 network and communication protection 64 

 micro segmentation 65 

 behavioral analytics 66 

 tools that use cyber threat intelligence 67 

 anti-malware 68 

 data security 69 

 segregation of duties 70 

 restoration and recoverability 71 

 cloud storage 72 

While the NCCoE used a suite of commercial products to address security challenges, this guide does not 73 
endorse these particular products, nor does it guarantee compliance with any regulatory initiatives. 74 
Information security experts should identify the products that will best integrate with existing tools and 75 
IT system infrastructure. Organizations can adopt this solution or one that adheres to these guidelines in 76 
whole, or this guide can be used as a starting point for tailoring and implementing parts of a solution. 77 
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BENEFITS  78 

The NCCoE’s practice guide to Securing PACS can help an organization: 79 

 improve resilience in the network infrastructure, including limiting a threat actor’s ability to 80 
leverage components as pivot points to attack other parts of the HDO’s environment 81 

 limit unauthorized movement within the HDO environment by authorized system users to 82 
address the “insider threat” as well as unauthorized actors once they gain network access 83 

 analyze behavior and detect malware throughout the ecosystem to enable HDOs to determine 84 
when components evidence compromise and to enable those organizations to limit the effects 85 
of a potential advanced persistent threat such as ransomware 86 

 secure sensitive data (e.g., personally identifiable information or protected health information) 87 
at rest and in transit, limiting adversarial ability to exfiltrate or expose that data 88 

 consider and address risks that may be identified as HDOs examine cloud solutions as part of 89 
managing their medical imaging infrastructure 90 

SHARE YOUR FEEDBACK 91 

You can view or download the guide at https://www.nccoe.nist.gov/projects/use-cases/health-it/pacs. 92 
Help the NCCoE make this guide better by sharing your thoughts with us as you read the guide. If you 93 
adopt this solution for your own organization, please share your experience and advice with us. We 94 
recognize that technical solutions alone will not fully enable the benefits of our solution, so we 95 
encourage organizations to share lessons learned and best practices for transforming the processes 96 
associated with implementing this guide.  97 

To provide comments or to learn more by arranging a demonstration of this example implementation, 98 
contact the NCCoE at hit_nccoe@nist.gov. 99 

 
TECHNOLOGY PARTNERS/COLLABORATORS 100 

Organizations participating in this project submitted their capabilities in response to an open call in the 101 
Federal Register for all sources of relevant security capabilities from academia and industry (vendors 102 
and integrators). The following respondents with relevant capabilities or product components (identified 103 
as “Technology Partners/Collaborators” herein) signed a Cooperative Research and Development 104 
Agreement (CRADA) to collaborate with NIST in a consortium to build this example solution.  105 

 

 106 

 

 

 

https://www.nccoe.nist.gov/projects/use-cases/health-it/pacs
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Certain commercial entities, equipment, products, or materials may be identified by name or company 107 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 108 
experimental procedure or concept adequately. Such identification is not intended to imply special 109 
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 110 
intended to imply that the entities, equipment, products, or materials are necessarily the best available 111 
for the purpose. 112 

 

The National Cybersecurity Center of Excellence (NCCoE), a part of the 
National Institute of Standards and Technology (NIST), is a collaborative 
hub where industry organizations, government agencies, and academic 
institutions work together to address businesses’ most pressing 
cybersecurity challenges. Through this collaboration, the NCCoE develops 
modular, easily adaptable example cybersecurity solutions 
demonstrating how to apply standards and best practices using 
commercially available technology. 

 LEARN MORE  
Visit https://www.nccoe.nist.gov 
nccoe@nist.gov 
301-975-0200 
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DISCLAIMER 
Certain commercial entities, equipment, products, or materials may be identified by name of company 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 
experimental procedure or concept adequately. Such identification is not intended to imply special 
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 
intended to imply that the entities, equipment, products, or materials are necessarily the best available 
for the purpose. 
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FEEDBACK 
You can improve this guide by contributing feedback. As you review and adopt this solution for your 
own organization, we ask you and your colleagues to share your experience and advice with us.  

Comments on this publication may be submitted to: hit_nccoe@nist.gov. 

Public comment period: September 16, 2019 through November 18, 2019 

As a private-public partnership, we are always seeking feedback on our practice guides. We are 
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you 
have implemented the reference design, or have questions about applying it in your environment, 
please email us at hit_nccoe@nist.gov . 

All comments are subject to release under the Freedom of Information Act. 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 1 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 2 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 3 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 4 
public-private partnership enables the creation of practical cybersecurity solutions for specific 5 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 6 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 7 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 8 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 9 
solutions using commercially available technology. The NCCoE documents these example solutions in 10 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 11 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 12 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 13 
Maryland. 14 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 15 
https://www.nist.gov. 16 

NIST CYBERSECURITY PRACTICE GUIDES 17 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 18 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 19 
adoption of standards-based approaches to cybersecurity. They show members of the information 20 
security community how to implement example solutions that help them align more easily with relevant 21 
standards and best practices, and provide users with the materials lists, configuration files, and other 22 
information they need to implement a similar approach. 23 

The documents in this series describe example implementations of cybersecurity practices that 24 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 25 
or mandatory practices, nor do they carry statutory authority. 26 

ABSTRACT 27 

Medical imaging plays an important role in diagnosing and treating patients. The system that manages 28 
medical images is known as the picture archiving communication system (PACS) and is nearly ubiquitous 29 
in healthcare environments. PACS is defined by the Food and Drug Administration (FDA) as a Class II 30 
device that “provides one or more capabilities relating to the acceptance, transfer, display, storage, and 31 
digital processing of medical images.” PACS centralizes functions surrounding medical imaging 32 
workflows and serves as an authoritative repository of medical image information.  33 

https://www.nccoe.nist.gov/
https://www.nist.gov/
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PACS fits within a highly complex healthcare delivery organization (HDO) environment that involves 34 
interfacing with a range of interconnected systems. PACS may connect with clinical information systems 35 
and medical devices and may involve engaging with health professionals who may be both internal and 36 
external to the HDO. This complexity may introduce or expose opportunities that allow malicious actors 37 
to compromise the confidentiality, integrity, and availability of the PACS ecosystem. 38 

The NCCoE at NIST analyzed risk factors regarding the PACS ecosystem by using a risk assessment based 39 
on the NIST Risk Management Framework, and the NCCoE leveraged the NIST Cybersecurity Framework 40 
and other relevant standards to identify measures to safeguard the ecosystem. The NCCoE developed an 41 
example implementation that demonstrates how HDOs can use standards-based, commercially available 42 
cybersecurity technologies to better protect the PACS ecosystem. This practice guide will help HDOs 43 
implement current cybersecurity standards and best practices, to reduce their cybersecurity risk while 44 
maintaining the performance and usability of PACS. 45 

KEYWORDS 46 

Access control; auditing; authentication; authorization; behavioral analytics; DICOM; encryption 47 
microsegmentation; multifactor authentication; PACS; picture archiving and communication system; 48 
PAM; privileged account management; vendor neutral archive; VNA. 49 
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1 Summary 143 

Medical imaging is a critical component in rendering patient care. The system that provides for the 144 
acceptance, transfer, display, storage, and digital processing of medical images is known as the Picture 145 
Archiving Communications System (PACS) [1] and is nearly ubiquitous in healthcare environments. The 146 
PACS environment serves as the repository to manage these images and accompanying clinical 147 
information within the healthcare delivery organization (HDO). Vendor Neutral Archive systems (VNAs) 148 
perform similar archive management functions as PACS, and this practice guide hereafter includes VNAs 149 
when it refers to PACS. PACS fits within a highly complex HDO environment and may interface with a 150 
range of enterprise information technology (IT) systems and healthcare professionals both internal and 151 
external to the HDO. This complexity leads to cybersecurity challenges. 152 

To develop practical cybersecurity guidance securing PACS, we must consider the ecosystem 153 
surrounding PACS, which includes interconnected medical imaging equipment generally described as 154 
modalities. The ecosystem includes modalities; connected clinical systems such as radiology information 155 
systems (RIS), health information systems (HIS), or the electronic health record (EHR); viewer and 156 
administration workstations; VNAs; and the PACS itself. 157 

The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and 158 
Technology (NIST) built a laboratory to emulate a medical imaging environment, performed a risk 159 
assessment, and developed an example implementation that demonstrates how HDOs can use 160 
standards-based, commercially available cybersecurity technologies to better protect the PACS 161 
ecosystem. The example implementation, which represents one of many possible solutions and 162 
architectures, can be used by any organization that is deploying PACS and medical imaging systems and 163 
that is willing to perform its own risk assessment and implement controls based on its risk posture. 164 

For ease of use, the following paragraphs provide a short description of each section of this volume. 165 

Section 1, Summary, presents the challenge addressed by the NCCoE project, with an in-depth look at 166 
our approach, the architecture, and the security characteristics we used; the solution demonstrated to 167 
address the challenge; benefits of the solution; and the technology partners that participated in 168 
building, demonstrating, and documenting the solution. The Summary also explains how to provide 169 
feedback on this guide. 170 

Section 2, How to Use This Guide, explains how business decision makers, program managers, IT 171 
professionals (e.g., systems administrators), and biomedical engineers might use each volume of the 172 
guide. 173 

Section 3, Approach, offers a detailed treatment of the scope of the project and describes the 174 
assumptions on which the security platform development was based, the risk assessment that informed 175 
platform development, and the technologies and components that industry collaborators gave us to 176 
enable platform development. 177 
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Section 4, Architecture, specifies the components within the PACS ecosystem from business, security, 178 
and infrastructure perspectives and details how data and processes flow throughout the ecosystem. This 179 
section also describes the security capabilities and controls referenced in the NIST Cybersecurity 180 
Framework through tools provided by the project collaborators. 181 

Section 5, Security Characteristic Analysis, provides details about the tools and techniques used to 182 
perform risk assessments pertaining to PACS. 183 

Section 6, Functional Evaluation, summarizes the test sequences employed to demonstrate security 184 
platform services, the NIST Cybersecurity Framework Functions to which each test sequence is relevant, 185 
and the NIST Special Publication (SP) 800-53 Revision 4 controls applicable to the functions being 186 
demonstrated.  187 

Section 7, Future Build Considerations, is a brief treatment of other applications that NIST might explore 188 
in the future to further protect the PACS ecosystem. 189 

The appendixes provide acronym translations, references, a mapping of the PACS project to the NIST 190 
Cybersecurity Framework, and a list of additional informative security references cited in the 191 
framework. 192 

1.1 Challenge 193 

The challenge with PACS is securing disparate, interconnected systems. A medical imaging infrastructure 194 
offers a broad attack surface with equipment that may have varying vulnerabilities, configurations, and 195 
control implementations. Devices deployed in the ecosystem likely come from different vendors and 196 
suppliers, and how one may implement defensive measures may vary based on the nature of the 197 
devices and how they function vis-à-vis patients and other clinical systems. The ecosystem may also 198 
include legacy devices potentially more vulnerable to cyber risks. The care provider team (clinicians and 199 
other healthcare professionals) may reside in different departments and may have components hosted 200 
and used across a wide geography. Some actors may be external to the HDO, interacting with sensitive 201 
information across the internet. 202 

As threats to the operational environment increase, PACS and other healthcare systems may become 203 
increasingly vulnerable to: 204 

 disruption of the system, leading to 205 

• inability to render timely diagnosis and treatment 206 

• inability to access the system for standard use, including inability to schedule procedures 207 

 compromise of image data, leading to incorrect diagnosis and treatment 208 

 compromise of components, allowing malicious actors to use the components as pivot points to 209 
attack other parts of the HDO infrastructure 210 
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 privacy concerns that may lead to 211 

• fraudulent or improper use of data 212 

• patient identity theft 213 

1.2 Solution 214 

This NIST Cybersecurity Practice Guide, Securing Picture Archiving and Communication System (PACS), 215 
shows how biomedical engineers, networking engineers, security engineers, and IT professionals can 216 
help securely configure and deploy PACS within HDOs by using commercially available, open-source 217 
tools and technologies that are consistent with cybersecurity standards. 218 

The reference architecture includes technical and process controls to implement the following solutions: 219 

 a defense-in-depth solution, including network zoning that allows more granular control of 220 
network traffic flows and limits communications capabilities to the minimum necessary to 221 
support business function 222 

 access control mechanisms that include multifactor authentication for care providers, 223 
certificate-based authentication for imaging devices and clinical systems, and mechanisms that 224 
limit vendor remote support to medical imaging components 225 

 a holistic risk management approach that includes medical device asset management 226 
augmenting enterprise security controls and leveraging behavioral analytic tools for near real-227 
time threat and vulnerability management in conjunction with managed security solution 228 
providers 229 

1.3 Benefits 230 

The NCCoE’s practice guide to securing PACS in HDOs can help your organization: 231 

 improve resilience in the network infrastructure, including limiting a threat actor’s ability to 232 
leverage components as pivot points to attack other parts of the HDO’s environment 233 

 limit unauthorized movement within the HDO enterprise network, to address the potential risk 234 
of an “insider threat” or malicious actors who gain network access 235 

 analyze behavior and detect malware throughout the ecosystem to enable HDOs to determine 236 
when components evidence compromise and to enable those organizations to limit the effects 237 
of a potential threat such as ransomware 238 

 secure sensitive data (e.g., personally identifiable information or protected health information) 239 
at rest and in transit, limiting adversarial ability to exfiltrate or expose that data 240 

 consider and address risks that may be identified as HDOs examine cloud solutions as part of 241 
managing their medical imaging infrastructure 242 
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2 How to Use This Guide 243 

This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides 244 
users with the information they need to help secure a medical imaging ecosystem. This practice guide 245 
builds upon the network zoning concept described in NIST SP 1800-8, Securing Wireless Infusion Pumps 246 
in Healthcare Delivery Organizations. As part of the implementation, the project used  247 
microsegmentation, role-based access controls, and behavioral analytics in the lab’s security controls. 248 
This reference design is modular and can be deployed in whole or in part. 249 

This guide contains three volumes: 250 

 NIST SP 1800-24A: Executive Summary 251 

 NIST SP 1800-24B: Approach, Architecture, and Security Characteristics – what we built and why 252 
(you are here) 253 

 NIST SP 1800-24C: How-To Guides – instructions for building the example solution 254 

Depending on your role in your organization, you might use this guide in different ways: 255 

Business decision makers, including chief security and technology officers, will be interested in the 256 
Executive Summary, NIST SP 1800-24A, which describes the following topics: 257 

 challenges that enterprises face in securing PACS 258 

 example solution built at the NCCoE 259 

 benefits of adopting the example solution 260 

Technology or security program managers who are concerned with how to identify, understand, assess, 261 
and mitigate risk will be interested in this part of the guide, NIST SP 1800-24B, which describes what we 262 
did and why. The following sections will be of particular interest: 263 

 Section 3.4, Risk Assessment, provides a description of the risk analysis we performed. 264 

 Section 3.5, Security Control Map, maps the security characteristics of this example solution to 265 
cybersecurity standards and best practices. 266 

You might share the Executive Summary, NIST SP 1800-24A, with your leadership team members to help 267 
them understand the importance of adopting standards-based, commercially available technologies that 268 
can help secure the PACS ecosystem. 269 

IT professionals who want to implement an approach like this will find the whole practice guide useful. 270 
You can use the how-to portion of the guide, NIST SP 1800-24C, to replicate all or parts of the build 271 
created in our lab. The how-to portion of the guide provides specific product installation, configuration, 272 
and integration instructions for implementing the example solution. We do not recreate the product 273 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 274 
incorporated the products together in our environment to create an example solution. 275 
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This guide assumes that IT professionals have experience implementing security products within the 276 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 277 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 278 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 279 
parts of the NCCoE’s risk assessment and deployment of a defense-in-depth strategy. Your 280 
organization’s security experts should identify the products that will best integrate with your existing 281 
tools and IT system infrastructure. We hope that you will seek products that are congruent with 282 
applicable standards and best practices. Section 3.6, Technologies, lists the products we used and maps 283 
them to the cybersecurity controls provided by this reference solution. 284 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 285 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 286 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 287 
hit_nccoe@nist.gov. 288 

2.1 Typographic Conventions 289 

The following table presents typographic conventions used in this volume. 290 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

3 Approach 291 

An HDO enterprise network environment is complex, with IT infrastructure to handle a range of 292 
functions, including back office billing, supply chain and inventory management, EHRs, and a vast array 293 

mailto:hit_nccoe@nist.gov
https://www.nccoe.nist.gov/
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of connected medical devices. PACS serves an important function within this already complex 294 
environment, through its role in aggregating and centralizing the medical imaging ecosystem while 295 
interfacing with other clinical systems. Specialists involved in the workflow may reside in different 296 
departments, be in different parts of an HDO campus, and be external to the HDO, accessing systems 297 
and images from the internet. This practice guide seeks to help the healthcare community evaluate the 298 
security environment surrounding PACS and medical imaging in a clinical setting. 299 

Throughout the PACS project, we collaborated with our NCCoE healthcare Community of Interest and 300 
technology and cybersecurity vendors to identify standard medical imaging workflows, identify actors, 301 
define interactions between actors and systems, and review risk factors. Based on this analysis, the 302 
NCCoE developed an architecture and reference design, identified applicable mitigating security 303 
technologies, and designed an example implementation to help better secure the PACS ecosystem. This 304 
volume provides the approach used to develop the NCCoE reference solution. Elements include risk 305 
assessment and analysis, logical design, build development, test and evaluation, and security control 306 
mapping.  307 

To develop the reference solution, we reviewed known vulnerabilities in PACS, the Digital Imaging and 308 
Communications in Medicine (DICOM) protocol [2], [3], and medical imaging process flow, leveraging 309 
use cases described by Integrating Health Enterprise (IHE) [4]. We examined how the architecture and 310 
component integration could be designed to increase the security of the device. 311 

The systems security engineering (SSE) framework discussed in NIST SP 800-160 Volume 1 [5] was 312 
utilized to introduce a disciplined, structured, and standards-based set of SSE activities and tasks to the 313 
project. This SSE framework provides the starting point and the forcing function to introduce 314 
engineering-driven actions that lead to more defensible and resilient systems. The SSE framework starts 315 
with and builds upon standards for systems and software engineering then infuses SSE techniques, 316 
methods, and practices into these standard system engineering processes. 317 

Additionally, this project reviewed NIST SP 800-171 Rev. 1, Protecting Controlled Unclassified 318 
Information in Nonfederal Systems and Organizations [6], as well as NIST SP 800-181, National Initiative 319 
for Cybersecurity Education (NICE) Cybersecurity Workforce Framework [7], for further guidance. 320 
Organizations may refer to these documents in expanding their safeguarding environment as 321 
appropriate. These documents serve as background for this project, with primary emphasis placed on 322 
the NIST Cybersecurity Framework [8] and the NIST Risk Management Framework [9]. 323 

3.1 Audience 324 

This guide is primarily intended for professionals implementing security solutions within an HDO. It may 325 
also be of interest to anyone responsible for securing nontraditional computing devices (i.e., the 326 
Internet of Things [IoT]). More specifically, Volume B of this practice guide (NIST SP 1800-24B) is 327 
designed to appeal to a wide range of job functions, including IT operations, storage support engineers, 328 
network engineers, PACS support biomedical engineers, cybersecurity engineers, healthcare technology 329 
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management (HTM) professionals, and support staff who have responsibility for medical imaging 330 
devices, viewing or administrative workstations, PACS, or VNAs. For cybersecurity or technology decision 331 
makers within HDOs, this volume provides a view into how they can make the medical device 332 
environment more secure, to help improve their enterprise’s security posture and reduce enterprise 333 
risk. Additionally, this volume offers guidance to technical staff on building a more secure medical device 334 
network and instituting compensating controls. 335 

3.2 Scope 336 

The NCCoE project focused on securing the environment of the PACS ecosystem but not on 337 
reengineering medical devices or altering medical imaging processes themselves. This project has led to 338 
a standards-based practice guide that is applicable to the wider healthcare ecosystem. This practice 339 
guide has been derived from implementation of a secure PACS in a laboratory environment at the 340 
NCCoE that seeks to replicate parts of a typical HDO environment. The project considers PACS users 341 
internal to the HDO as well as external users and partners needing access to certain components of the 342 
HDO environment. 343 

3.3 Assumptions 344 

In building this healthcare practice guide, the NCCoE began the project with the following fundamental 345 
assumptions: 346 

 Medical devices will include flaws or weaknesses that may be leveraged as vulnerabilities. 347 

 Patches or fixes for these vulnerabilities may not be available or deployable in a timely fashion. 348 

 Other components within an HDO’s network may include flaws and vulnerabilities. 349 

 Security controls that one may deploy may themselves include flaws or weaknesses that could 350 
be used to compromise the HDO network. 351 

This practice guide identifies controls that may be appropriate for mitigating risks associated with the 352 
medical imaging ecosystem made up of PACS and VNA systems. The actual build and example 353 
implementation of this architecture occurred in a lab environment at the NCCoE. Although the lab is 354 
based on a clinical environment, it does not mirror the complexity of an actual hospital network. It is 355 
assumed that any actual clinical environment would represent additional complexity. As such, in 356 
addition to the assumptions noted above, we also assume the implementation of pervasive controls, 357 
discussed in more detail in Appendix C. 358 

3.4 Risk Assessment 359 

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments [10], states that risk is “a measure of 360 
the extent to which an entity is threatened by a potential circumstance or event, and typically a function 361 
of: (i) the adverse impacts that would arise if the circumstance or event occurs; and (ii) the likelihood of 362 
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occurrence.” The guide further defines risk assessment as “the process of identifying, estimating, and 363 
prioritizing risks to organizational operations (including mission, functions, image, reputation), 364 
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of 365 
an information system. Part of risk management incorporates threat and vulnerability analyses, and 366 
considers mitigations provided by security controls planned or in place.” 367 

The NCCoE recommends that any discussion of risk management, particularly at the enterprise level, 368 
begin with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for 369 
Information Systems and Organizations [11] —publicly available material. The Risk Management 370 
Framework (RMF) [9] guidance, as a whole, proved to be invaluable in providing us a baseline to assess 371 
risks, from which we developed the project, the security characteristics of the build, and this guide. 372 

In conducting the risk assessment, this document considers threats and risks grouped under 373 
Confidentiality, Integrity, and Availability, commonly referred to as the CIA triad [12]. 374 

3.4.1 Establishing the Risk Context 375 

As we examine risk, we begin by considering the risk context. The ecosystem itself is complex and 376 
presumes different teams of people, varying processes, and different technologies involved in the 377 
acquisition, interpretation, and maintenance of medical imaging information. This section presents the 378 
risk context of the Securing PACS Project, which is established around five scenarios that represent 379 
typical processes found in a medical imaging ecosystem [13]. The risk context, which in this practice 380 
guide is bounded within the medical imaging ecosystem logical boundary, defines where risk assessment 381 
is performed. Risk context of the PACS environment encompasses the physical and logical components 382 
of the medical imaging ecosystem that interconnect with PACS as well as the various stakeholders within 383 
the ecosystem. For the NCCoE PACS lab environment, risk context includes the components listed below 384 
and the system actors of the PACS, which include both human and system actors, as described in Section 385 
3.4.2. 386 

Figure 3-1 depicts the notional high-level architecture that bounds the PACS and medical imaging 387 
ecosystem [13]. This depiction provides a starting point in understanding the components addressed in 388 
this project. Notwithstanding, this project takes a holistic approach in framing the risk context, beyond 389 
some of the technology components. This project leverages concepts described in NIST SP 800-160 [5] in 390 
defining context for the PACS ecosystem, understanding risk based on context, and selecting 391 
appropriate controls when designing the control environment needed to mitigate that contextual risk. 392 
NIST SP 800-160, Systems Security Engineering [5], identifies concepts of examining system life cycle and 393 
components, performing holistic analysis on both technical and nontechnical processes, to deliver 394 
“trustworthy” systems. Trustworthiness describes a solution whose objective is to provide “adequate 395 
security” related to concerns that may be held by a given stakeholder. “Adequate security” is achieved 396 
through considering a system life-cycle process, and it frames the risk context based on processes and 397 
interactions with the system and its components [5]. 398 
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Figure 3-1 Notional High-Level Architecture 399 

 400 

The system for this project is broadly identified as the PACS, though practically, it incorporates a set of 401 
processes and other systems that make up a medical imaging ecosystem [13]. For purposes of this 402 
project, and in accordance with NIST SP 800-160 [5], we consider the individual components as “systems 403 
of interest,” noted below: 404 

 workstations used to interact with the medical imaging ecosystem 405 

• viewer workstations residing within the HDO perimeter 406 

• viewer workstations residing external to the HDO perimeter, used by remote care 407 
specialists 408 

• workstations used by clinical staff to access peripheral systems, such as Order Entry 409 
systems, RIS, HIS, or EHR 410 

 modalities, or medical imaging devices that acquire medical images and forward those to PACS, 411 
based on orders typically received from the EHR or HIS and following workflows typically defined 412 
by the RIS 413 

 clinical systems that interface with modalities and the PACS environment, supporting medical 414 
imaging processes such as scheduling, annotations, or reporting 415 

 interfaces for the PACS that may operate as servers, such as HL7, DICOM, or web 416 

 PACS and VNA application servers 417 
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In addition to the technology components described above and in the PACS Project Description, we 418 
consider other elements, such as stakeholders (system actors) as well as specific business process flows 419 
in which those stakeholders may participate. The processes align with profiles established by IHE [4], 420 
which this project leveraged to determine process and data flows. The four selected profiles translate to 421 
scenarios described below. Based on the PACS Project Description document, the scenarios of note are 422 
as follows: Sample Radiology Practice Workflows; Access to Aggregations and Collections of Different 423 
Types of Images; Accessing, Auditing, and Monitoring; Image Object Change Management; and Remote 424 
Access [13]. 425 

This practice guide does not examine pervasive risks an HDO may face but rather focuses on those risks 426 
specific to the medical imaging ecosystem. While this guide considers specific elements that may be 427 
required for safe and secure hosting of PACS, the intent of the guide is not to serve as an omnibus guide 428 
for all facets potentially required to operate a secure HDO infrastructure. This guide addresses measures 429 
that would enhance the security posture for the overall PACS and medical imaging ecosystem, but there 430 
may be elements that HDOs should address beyond the recommendations offered in safeguarding PACS 431 
and the overall medical imaging ecosystem. 432 

3.4.2 System Actors 433 

This project considers several roles that interact with the PACS and medical imaging system ecosystem. 434 
This project looks at both authorized human and system actors. Human actor roles consist of: 435 

 medical imaging technologists 436 

 clinicians 437 

 clinical systems IT administration 438 

 HTM professionals 439 

 IT staff 440 

System actors that interact with the PACS and VNA consist of: 441 

 modalities 442 

 radiology and hospital information systems (RIS and HIS) 443 

 EHRs 444 

Patients are excluded from the system actor list. The actions considered are limited to those focused on 445 
medical images, which include creation of the image, annotation, storage of the image and annotations, 446 
interpretation, and changes to those images. When we consider radiology information systems and EHR 447 
systems, actions are limited to order entry/scheduling of procedures and to pointing to images for 448 
reading/viewing. Process flows are noted in the scenarios below, which describe use case profiles 449 
defined by IHE, a body that this project has identified as authoritative in defining standard imaging 450 
workflow processes [4]. 451 
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3.4.3 Use Case Scenarios 452 

This project assesses risk for the five scenarios [13] described below. Consideration of threats, 453 
vulnerabilities, likelihoods, and impacts on medical imaging operations under these scenarios has 454 
contributed to the risks documented in Section 3.4.6.  455 

These scenarios frame the processes within which we consider introduction of threats. In addition to the 456 
scenario, this document investigates those vulnerabilities, threats, and risks that may be evident based 457 
on a holistic view of the architecture, as described in Section 3.4.4, Section 3.4.5, and Section 3.4.6. 458 
Notwithstanding, several threats are excluded though are relevant for consideration. While this 459 
document investigates addressing modality interfaces, it does not examine specific modalities or the 460 
risks potentially associated with them. Modality devices themselves are medical devices that may 461 
include vulnerabilities or opportunity for systems or data compromise, loss of data integrity, or 462 
disruption of service, and HDOs should perform independent risk assessments in addressing those risks. 463 

3.4.3.1 Sample Radiology Practice Workflows 464 

Scenario One, shown in Figure 3-2, starts with registration of a patient who requires that an imaging 465 
procedure be performed [13]. For the purposes of this project, the assumption is that the patient is 466 
registered into the EHR, has appropriate identifiers to be admitted as a patient, and is viable to receive 467 
procedures. The scenario follows the process flow that begins at scheduling the procedure, having the 468 
image acquired, and allowing the care team to analyze and diagnose. The assumption is that all modality 469 
devices and clinical staff are on premises, within the boundaries of the HDO. Patient information is 470 
conveyed using the Health Level 7 (HL7) [14] protocol (e.g., patient registration and order entry 471 
messages). Medical imaging devices would interact with the PACS/VNA by using DICOM [2], [3]. 472 
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Figure 3-2 Scenario One: Sample Radiology Practice Workflows 473 

 474 

The scenario’s processes are as follows: 475 

 Patient Registration: A new patient provides information that is entered into an HIS. An HIS may 476 
also be referred to as a clinical information system (CIS). The function of this process flow is to 477 
establish a patient identity within a hospital where one may not previously exist and then allow 478 
patient administration to be performed. 479 

 Order Entry: Once a patient identity has been established, a clinician can order a medical 480 
imaging procedure for the patient by using some form of computerized physician order entry 481 
(CPOE) system. 482 

 Order Scheduling: Following a submitted order, a medical imaging procedure involving an 483 
appropriate medical imaging modality may be scheduled through a RIS. 484 

 Image Acquisition: After an order has been created and scheduling has been performed, the 485 
imaging procedure is performed through the appropriate modality. Acquisition results in 486 
creation of a medical image. 487 

 Image Post-Processing: When the medical image has been created, imaging technologists will 488 
examine the image and may record initial annotations. The image and annotations are then 489 
pushed to the PACS. 490 

 Image Analysis and Reporting: An imaging clinician may use a viewer workstation to examine 491 
the image, analyze, interpret, and diagnose, with subsequent notes pushed to the PACS for 492 
reporting. 493 

Stakeholders: medical imaging technologists, clinicians (medical imaging specialists), and medical 494 
imaging devices (modalities) 495 
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Systems of Interest: order entry, RIS, medical imaging devices, viewer workstations, PACS 496 

Protocols used: DICOM, web (e.g., https), HL7, HIP 497 

3.4.3.2 Image Data Access Across the Enterprise 498 

Scenario Two, as shown in Figure 3-3, examines multiple departments that use disparate imaging 499 
devices for acquisition and may involve multiple PACS [13]. The assumption is that different 500 
departments have separate clinical staff and different medical imaging goals and may use different 501 
means to centralize their medical images. This scenario simulates a hospital, in that radiology is not the 502 
only department that uses medical imaging, nor does the radiology department mandate use of its PACS 503 
to centralize medical images across a hospital. Aggregation and centralized management remain the 504 
goal, but other components are introduced into the ecosystem to enable this functionality. While 505 
images are to be stored centrally, access to images is not permitted for all clinical staff. 506 

Figure 3-3 Scenario Two: Image Data Access Across the Enterprise 507 

 508 

In demonstrating that different groups and technologies are involved, this project uses a convention on 509 
showing variables as “_a” or “_b.” This allows us to show the separation between two components that 510 
may be similar in function but are separate, i.e. “component_a” versus “component_b.” 511 

Stakeholders: medical imaging staff_a, medical imaging staff_b, healthcare technology management 512 
professionals, PACS_a, PACS_b, VNA 513 

Systems of Interest: image viewer_a, image viewer_b, PACS_a, PACS_b, VNA 514 
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3.4.3.3 Accessing, Monitoring, and Auditing 515 

Scenario Three, as shown in Figure 3-4, examines the infrastructure required for access control, which 516 
includes identity management and authentication for actors who interact with the PACS and VNA 517 
environments, as well as logging, auditing, and monitoring actions with the stored information [13]. The 518 
scenario considers those actions where individuals or devices retrieve and view information (Read 519 
actions) and introduce new information (Write actions), as well as when individuals or devices modify 520 
stored information (Change actions). 521 

Figure 3-4 Scenario Three: Accessing, Monitoring, and Auditing 522 

 523 

Identities would be established for users (humans who interact with the system), as well as for devices 524 
and systems. Assumptions in this scenario are that individuals have been appropriately identity-proofed 525 
and are provisioned accounts with which they may access and use viewer applications. Given that 526 
identities and accounts would be provisioned for both human and machine actors, interaction with the 527 
system will perform authentication wherein, as actors present credentials to perform actions, challenges 528 
must be satisfied. Authentication may involve exchange of passwords, passcodes, biometrics, or use of 529 
cryptographic keys to validate the actor. Actions, including presentation of credentials, will be recorded 530 
in a log file. 531 

This scenario examines clinical use system interaction and does not address privileged user access. 532 
Controls to manage privileged access are discussed in Section 4.1.5.1.1, Privileged Access Management. 533 

Stakeholders: medical imaging staff, medical devices, PACS, VNA 534 

Systems of Interest: directory servers, user account systems, digital certificate servers 535 

Protocols: PKI (associated protocols such as Certificate Management Protocol, http, https), domain 536 
name system (DNS), Active Directory 537 
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3.4.3.4 Imaging Object Change Management 538 

Scenario 4, depicted in Figure 3-5, supports the changes that include (1) object rejection due to quality 539 
or patient safety reasons, (2) correction of incorrect modality worklist entry selection, and (3) expiration 540 
of objects due to data retention requirements [13]. It defines how changes are captured and how to 541 
communicate these changes. The scenario considers those actions when an authorized healthcare 542 
professional, upon review of the image, determines that errors or qualitative defects found in an image 543 
may lead to an inappropriate conclusion. 544 

Figure 3-5 Scenario Four: Imaging Object Change Management 545 

 546 

Stakeholders: medical imaging clinicians 547 

Systems of Interest: PACS, VNA 548 

Protocols: HL7, http, https 549 

3.4.3.5 Remote Access 550 

Scenario 5, depicted in Figure 3-6, supports external parties who may need access to the PACS 551 
ecosystem. The scenario provides a pathway for IT vendors to provide remote systems support as well 552 
for third-party clinical participants to interact with the PACS. IT vendors may consist of clinical systems 553 
support staff who may need to help maintain the PACS or VNA systems. Third-party clinical participants 554 
may consist of medical imaging specialists or teleradiology specialists who may need to review medical 555 
images acquired at the HDO. 556 



DRAFT  

 
 

NIST SP 1800-24B: Securing Picture Archiving and Communication System (PACS) 16 

Figure 3-6 Scenario Five: Remote Access 557 

558 
Stakeholders: medical imaging specialists, IT/HTM professionals, teleradiology specialists 559 

Systems of Interest: PACS, VNA 560 

3.4.4 Threats 561 

From NIST SP 800-30 Revision 1, “[a] threat is any circumstance or event with the potential to adversely 562 
impact organizational operations and assets, individuals, other organizations, or the Nation through an 563 
information system via unauthorized access, destruction, disclosure, or modification of information, 564 
and/or denial of service.” [10]  565 

In laymen’s terms, threats are adverse events that may occur. Threat actors may take actions to 566 
leverage vulnerabilities (described in the subsection below). Actions may include compromising 567 
credentials and accessing, removing, or changing data or making systems not available for legitimate 568 
use. The result of threats is risks [10]. Threats considered within this practice guide are enumerated in 569 
Table 3-1 below. 570 

Table 3-1 Threats 571 

C/I/A Threat Event Description Unmitigated 
Likelihood 

C Abuse of credentials 
or insider threat 

Aberrant behavior from an individual who may 
have legitimate access to the system, however, 
may leverage granted privileges for unintended 
purposes. 

High 
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C/I/A Threat Event Description Unmitigated 
Likelihood 

C Credential 
compromise 

Adversary obtains the means to use credentials 
provisioned for others. Credentials may involve 
other users or those used by systems for process 
or data handling. 

High 

C Data exfiltration The removal of data to an unintended 
destination. Exfiltration may represent the 
unauthorized movement of data from one 
system to uncontrolled physical storage media or 
may represent movement to uncontrolled virtual 
destinations such as volatile memory, or to 
unknown storage such as cloud-hosted or virtual 
destinations. 

High 

I Data in-transit 
disruption 

Distortion or alteration of data in transit that 
results in information that may not be 
interpreted as valid information. The attack type 
seeks to distort or alter data in mid 
communication stream. Received data may be 
unintelligible or otherwise unreadable when it 
arrives at the destination. 

Moderate 

I Data alteration Unauthorized changes to the content of the data. 
Data alteration may not be superficially detected 
in that the image may appear legitimate. The 
attack type seeks to make changes when data 
are in an at-rest state. 

Moderate 

I Time 
synchronization 

System components may rely on synchronizing 
internal clocks to ensure network session and 
data integrity. Attacks may seek to alter time 
stamping or ability for systems to synchronize 
with an authoritative time source. 

Moderate 

I Introduction of 
malicious software 

Introduction of foreign, unauthorized code into a 
system. Malicious software deployments may 
affect servers or workstations or both. 
Server components: Unauthorized code may be 
deployed and run on server components. 
Workstations: Unauthorized code may be 
deployed and run on workstations connected to 
PACS ecosystem. 

High 
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C/I/A Threat Event Description Unmitigated 
Likelihood 

I Unintended use of 
service 

Operating systems may consist of services or 
processes used to support a system’s 
functionality; however, they may be used to 
perform unintended functions. 

High 

A Data storage 
disruption 

Physical media or file space disruption evidenced 
by prolonged read/write access times, or 
corrupted data thereby causing unavailability of 
service. 

High 

A Network disruption Network disruption attacks may take the form of 
several different approaches. Below are some 
disruption approaches that this practice guide 
will examine: 
Denial of service (DoS) or packet flooding: the 
introduction of above normal network traffic 
that saturates network infrastructure 
components’ ability to deliver network 
communication appropriately 
Routing: inefficient network traffic flow 
DNS or name resolution: Networked hosts are 
associated with “friendly names” to facilitate 
interaction; however, name resolution to 
internet protocol (IP) addressing may be 
disrupted to make host discovery difficult. 
Similar or soundalike host and domain names 
may be introduced to compound confusion. 
ARP: Address Resolution Protocol (ARP) is a 
localized means by which hosts resolve IP 
addresses to Media Access Control (MAC) 
addresses stored in host tables. Corruption of 
ARP tables may result in network traffic being 
misdirected or in legitimate devices being unable 
to connect to the network. 

High 

 Backup/recovery 
disruption 

Measures that organizations use as a failover or 
recovery from a prolonged outage may be 
compromised, e.g., through introduction of 
malicious software to backup storage media, 
inability to read and restore from backup media, 
or introduction of a supply chain compromise 

High 
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C/I/A Threat Event Description Unmitigated 
Likelihood 

(per above) at a third-party recovery site. High 
availability or replication scenarios may also be 
prone to network disruption. 

A Supply chain 
compromise 

System components may be sourced from 
multiple vendors and may allow introduction of 
malicious software (noted above). 

High 

3.4.5 Vulnerabilities 572 

Table 3-2 lists identified vulnerabilities that aggregate vulnerabilities identified in NIST SP 800-30 573 
Revision 1 [10]. As noted in the document, a vulnerability is a deficiency or weakness that a threat 574 
source may exploit, resulting in a threat event. The document further describes that vulnerabilities may 575 
exist in a broader context, i.e., that they may be found in organizational governance structures, external 576 
relationships, and mission/business processes. The following table enumerates those vulnerabilities, 577 
using a holistic approach, and represents those vulnerabilities that this project identified and for which it 578 
offers guidance. For further description, reference NIST SP 800-30 Revision 1 [10]. 579 

Table 3-2 Vulnerabilities 580 

Vulnerability  
Description 

Vulnerability 
Severity 
(Qualitative) 

Predisposing Condition 

Pervasiveness 
of 
Predisposing 
Condition 
(Qualitative) 

Weak or no system 
use training 

Moderate Workforce may not be aware or may not 
have received training on appropriate use 
or configuration of the system. Users may 
not have sufficient awareness of action 
consequences. 

High 

Weak or no 
security training 

High Workforce may not be aware of 
procedures of how to report anomalies. 
Security teams may not have sufficient 
training on how to investigate or may not 
have procedures to address security 
incidents. 

Moderate 

Deficient supply 
chain security 
controls 

High Organizations may not be aware of third-
party practices or downstream suppliers 
who may implement technology into the 
healthcare organization’s environment. 

High 
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Vulnerability  
Description 

Vulnerability 
Severity 
(Qualitative) 

Predisposing Condition 

Pervasiveness 
of 
Predisposing 
Condition 
(Qualitative) 

Deficient 
separation of 
duties 

High Privileged users may have extended 
responsibility to ensure system 
operations. This may be embodied by 
using “super user” identities that allow 
escalated access to systems, data, and 
logging features. 

High 

Weak or no 
identity 
management  

High Organizations may have deficient identity 
proofing or review processes. 

Moderate 

Weak or no 
authentication 
controls 

Very High This may be evidenced through trivial 
forms of authentication or using 
credentials with no authentication 
requirement. Also found in this category is 
the use of default credentials that tend to 
be generally discoverable. 

Very High 

Permissive 
privilege 

Very High Credentials may be established without 
examining the minimum necessary to 
perform the required function. As such, 
credentials may exist with access to 
perform actions outside the work scope. 
Note that permissive privilege may extend 
to system services whereby services may 
run as “root” or “administrator,” granting 
that credential the ability to perform 
inappropriate actions. 

Very High 

Out-of-date or 
unmanaged 
services 

High Operating systems, other third-party 
software, and the PACS application itself 
include a variety of services, allowing 
appropriate functionality. Over time, 
flaws, in the form of bugs (coding errors) 
or the use of libraries or binaries 
determined to have security weakness, 
may be discovered and subsequently 
addressed, resulting in patches or 
updates. Systems that do not apply those 

Very High 



DRAFT  

 
 

NIST SP 1800-24B: Securing Picture Archiving and Communication System (PACS) 21 

Vulnerability  
Description 

Vulnerability 
Severity 
(Qualitative) 

Predisposing Condition 

Pervasiveness 
of 
Predisposing 
Condition 
(Qualitative) 

patches and updates may operate with 
out-of-date services. 

Deficient 
vulnerability 
management 

Very High Organizations may have deficient 
application and operating system 
vulnerability scanning and monitoring 
practices. Vulnerability scanning here is 
considered in a narrower context where 
we consider that flaws or deficiencies may 
exist in software elements associated with 
the overall medical imaging system. 

Very High 

Deficient data 
protection  

High Unauthorized individuals may be able to 
read, modify, delete, or exfiltrate sensitive 
data. 

High 

Deficient logging 
and monitoring 

High System interactions may not be captured 
or retained sufficiently for review. Logs, 
when tracked, may not be reviewed for 
anomalies on a timely or consistent basis. 

High 

Deficient time 
synchronization 

Moderate Systems may operate on individual 
internal clocks and may track transactions 
independently. 

High 

Permissive network 
boundaries 

High Configuration may permit unauthorized 
network traffic to access sensitive assets. 

Very High 

Lack of network 
segmentation 

Very High Components may operate on the same 
network or have implied trust with other 
components. 

Very High 

Lack of network 
session security 

High Network sessions may not be secured. High 

Deficient certificate 
management 

High Organizations using certificates to 
safeguard network sessions (e.g., secure 
sockets layer [SSL]/Transport Layer 
Security [TLS] certificates) may allow no 
certificate, expired, or inappropriate 
certificates. 

High 
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Vulnerability  
Description 

Vulnerability 
Severity 
(Qualitative) 

Predisposing Condition 

Pervasiveness 
of 
Predisposing 
Condition 
(Qualitative) 

Misconfigured 
network 

High Organizations may have misconfigured 
network routing or switch settings. 

High 

Misconfigured 
storage media  
 

High Medical image storage demands are 
great, and organizations may have 
misconfigured storage arrays. 

Moderate 

Recovery/restore 
procedures not 
tested or not 
performed  

Very High Organizations may not have created or 
tested recovery procedures. 

High 

 

The vulnerabilities in the table above represent types of known vulnerabilities, that is, based on 581 
vulnerabilities experienced in existing systems and networks. 582 

3.4.6 Risk 583 

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments, defines risk as “a measure of the 584 
extent to which an entity is threatened by potential circumstance or event, and is typically a function of: 585 
(i) the adverse impacts that would arise if the circumstance or event occurs; and (ii) the likelihood of 586 
occurrence” [10]. Risk is the adverse impact; that is, risk is the result when a threat (attack) successfully 587 
leverages one or more vulnerabilities. As organizations consider risk, they should note that risk is not 588 
discrete; that is, a successful attack may involve multiple threats or take advantage of a combination of 589 
vulnerabilities. Also, when an organization suffers from an attack campaign, the organization may realize 590 
multiple adverse outcomes. 591 

Ransomware or a DoS attack, for example, could adversely impact an HDO by compromising the 592 
availability of systems and preventing the HDO from treating patients. This practice guide, however, 593 
considers controls and practices that may be appropriate in mitigating or responding to threats affecting 594 
confidentiality, integrity, and availability holistically. 595 

Another risk noted below is that of systemic disruption. Systemic disruption may affect availability and 596 
integrity of systems or data. An attacker may compromise the targeted system’s operations, or the 597 
attacker may use the targeted system as a platform from which to conduct further attacks across an 598 
HDO’s network. Systemic disruption prevents the HDO from treating patients, by either making systems 599 
inoperative or altering patient data when malware is introduced. This practice guide also considers the 600 
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specific case of when targeted systems are compromised and used to attack other components within 601 
the enterprise. 602 

Table 3-3 represents a listing of unmitigated risks applicable to the PACS lab environment, based on the 603 
examples of threat types (Section 3.4.4) and vulnerabilities (Section 3.4.5) presented above. These risks 604 
are offered in terms relating to the healthcare environment, and similar risks can be expected in a 605 
typical healthcare environment. Note that the likelihood of threats and vulnerabilities would be affected 606 
based on implemented effective controls, which would also affect the level of risk determined. 607 

Table 3-3 Risk 608 

C/I/A Risk Description Risk Level 

C Fraudulent use of 
health-related 
information 

Should unauthorized individuals retrieve protected 
health information (PHI) that includes health 
insurance information, those actors may be able to 
submit fraudulent claims and receive 
reimbursement from a payer for services not 
rendered to the patient. 

High 

C Identity theft and 
fraudulent use of PHI 

Individuals may receive exfiltrated data to commit 
identity theft in obtaining healthcare. Fraudulent 
individuals may receive health services leveraging a 
victim patient’s information and, as a result, 
introduce false information into a victim patient’s 
medical history. This may result in a patient safety 
concern, in that treatments performed for the 
fraudulent individual would be captured in the 
victim patient’s history, potentially leading to 
future inaccurate diagnoses when that patient 
seeks legitimate care. 

High 

I Patient misdiagnosed 
based on 
interpretations made 
from unauthorized 
changes to medical 
images  

Patient safety may be affected based on imaging 
data integrity. Should images be altered, care 
providers may render inaccurate diagnoses and 
therefore delay appropriate treatment. 
 

High 

A Patient diagnoses 
disrupted based on 
timeliness disruption, 
leading to patient 
safety concerns 

Patients may have conditions that require timely 
and accurate diagnosis to achieve optimum 
mortality rates. Communications disruptions that 
corrupt or deny data may adversely affect this, so 
that care teams are not able to make a timely 

High 
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C/I/A Risk Description Risk Level 
diagnosis, and patients may have to repeat imaging 
processes. 
 

A Process disruption 
due to malware 

PACS or other systems within the ecosystem may 
succumb to ransomware or other forms of 
malware, rendering those systems and associated 
data unavailable. Ransomware may render full 
system unavailability, while other forms of 
malware may delay processing capability or 
introduce data integrity risk. As a result, the HDO 
may not be able to treat patients appropriately or 
make diagnoses. Delays may result in patient safety 
concerns. 

High 

A Systemic disruption 
due to component 
compromise 

Individual components within the PACS ecosystem 
may be compromised and used as pivot points 
from which other parts of the HDO network may be 
attacked. This may result in delay in patient care. 

High 

 

The project identified the risks above as requirements that needed to be addressed in the lab 609 
environment. Organizations should note that the tables offered here are samples and notionally 610 
representative. Characterizing threats, vulnerabilities, and risk is contextual. HDOs with different 611 
security deficiencies or unique threat situations in their systems and network environments may find 612 
their categorization to be different than what was identified for this project. HDOs need to consider 613 
their unique profile when categorizing vulnerabilities, threats, and risk. Only then can an adequate set of 614 
security controls be determined for their unique environment. This project identified these risk 615 
elements and scored them as such, based on the assessment performed on the lab environment. 616 

3.5 Security Control Map 617 

As the project considered PACS ecosystem risks, the team performed a mapping to the NIST 618 
Cybersecurity Framework [8], establishing an initial set of appropriate control Functions, Categories, and 619 
Subcategories, demonstrating how selected Cybersecurity Framework Subcategories map to controls in 620 
NIST SP 800-53 Revision 4 [15]. The table also lists sector-specific standards and best practices from 621 
other standards bodies (e.g. the International Electrotechnical Commission [IEC], International 622 
Organization for Standardization [ISO]), as well as the Health Information Portability and Accountability 623 
Act (HIPAA) [16], [17], and [18]. The security control map, shown in Table 3-4, identifies a 624 
comprehensive set of controls, including those specifically implemented in the lab build-out, as well as 625 
the pervasive set of controls as described in Appendix C that HDOs should deploy. 626 
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Table 3-4 Security Characteristics and Controls Mapping–NIST Cybersecurity Framework 627 

NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

IDENTIFY 
(ID) 

Asset 
Management 
(ID.AM) 

ID.AM-1: Physical devices and 
systems within the organization 
are inventoried.  

CM-8 
PM-5 N/A 

45 C.F.R. §§ 
164.308(a)(1)(ii)(A) 
164.308(a)(4)(ii)(A) 
164.308(a)(7)(ii)(E) 
164.308(b) 
164.310(d) 
164.310(d)(2)(iii) 

A.8.1.1 
A.8.1.2 

 
ID.AM-2: Software platforms and 
applications within the 
organization are inventoried. 

CM-8 
PM-5 N/A 

45 C.F.R. §§ 
164.308(a)(1)(ii)(A) 
164.308(a)(4)(ii)(A) 
164.308(a)(7)(ii)(E) 
164.308(b) 
164.310(d) 
164.310(d)(2)(iii) 

A.8.1.1 
A.8.1.2 
A.12.5.1 

 
ID.AM-3: Organizational 
communication and data flows 
are mapped. 

AC-4 
CA-3 
CA-9 
PL-8 

SGUD  

45 C.F.R. §§ 
164.308(a)(1)(ii)(A) 
164.308(a)(3)(ii)(A) 
164.308(a)(8) 
164.310(d) 

A.13.2.1 
A.13.2.2 

 ID.AM-4: External information 
systems are catalogued. 

AC-20 
SA-9 RDMP 

45 C.F.R. §§ 
164.308(a)(1)(ii)(A) 
164.308(a)(4)(ii)(A) 
164.308(a)(7)(ii)(E) 
164.308(b) 
164.310(d) 
164.310(d)(2)(iii) 

A.11.2.6 
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NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

 

ID.AM-5: Resources (e.g., 
hardware, devices, data, time, 
personnel, and software) are 
prioritized based on their 
classification, criticality, and 
business value. 

CP-2 
RA-2 
SA-14 
SC-6 

SGUD  45 C.F.R. §§ 
164.308(a)(7)(ii)(E) A.8.2.1 

 

Risk 
Assessment 
(ID.RA) 

ID.RA-1: Asset vulnerabilities are 
identified and documented. 

CA-2 
CA-7 
CA-8 
RA-3 
RA-5 
SA-5 
SA-11 
SI-2 
SI-4 
SI-5 

MLDP 
RDMP 
SGUD 

45 C.F.R. §§ 
164.308(a)(1)(i) 
164.308(a)(1)(ii)(A) 
164.308(a)(1)(ii)(B) 
164.308(a)(7)(ii)(E) 
164.308(a)(8) 
164.310(a)(1) 

A.12.6.1 
A.18.2.3 

 
ID.RA-4: Potential business 
impacts and likelihoods are 
identified. 

RA-2 
RA-3 
SA-14 
PM-9 
PM-11 

DTBK 
SGUD  

45 C.F.R. §§ 
164.308(a)(1)(i) 
164.308(a)(1)(ii)(A) 
164.308(a)(1)(ii)(B) 
164.308(a)(6) 
164.308(a)(7)(ii)(E) 
164.308(a)(8) 

A.16.1.6 
Clause 6.1.2 

 
ID.RA-5: Threats, vulnerabilities, 
likelihoods, and impacts are used 
to determine risk. 

RA-2 
RA-3 
PM-16 

SGUD  

45 C.F.R. §§ 
164.308(a)(1)(ii)(A) 
164.308(a)(1)(ii)(B) 
164.308(a)(1)(ii)(D) 
164.308(a)(7)(ii)(D) 
164.308(a)(7)(ii)(E) 
164.316(a) 

A.12.6.1 
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NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

 ID.RA-6: Risk responses are 
identified and prioritized. 

PM-4 
PM-9 

DTBK  
SGUD  

45 C.F.R. §§ 
164.308(a)(1)(ii)(B) 
164.314(a)(2)(i)(C) 
164.314(b)(2)(iv) 

Clause 6.1.3 

 PROTECT 
(PR) 

Identity 
Management 
and Access 
Control (PR.AC) 

PR.AC-1: Identities and 
credentials are issued, managed, 
verified, revoked, and audited for 
authorized devices, users, and 
processes. 

AC-1 
AC-2 
IA-1 
IA-2 
IA-3 
IA-4 
IA-5 
IA-6 
IA-7 
IA-8 
IA-9 
IA-10 
IA-11 

ALOF 
AUTH 
EMRG 
NAUT 
PAUT 

45 C.F.R. §§ 
164.308(a)(3)(ii)(B) 
164.308(a)(3)(ii)(C) 
164.308(a)(4)(i) 
164.308(a)(4)(ii)(B) 
164.308(a)(4)(ii)(C) 
164.312(a)(2)(i) 

A.9.2.1 
A.9.2.2 
A.9.2.3 
A.9.2.4 
A.9.2.6 
A.9.3.1 
A.9.4.2 
A.9.4.3 

 PR.AC-2: Physical access to assets 
is managed and protected. 

PE-2 
PE-3 
PE-4 
PE-5 
PE-6 
PE-8 

PLOK 
TXCF 
TXIG 

45 C.F.R. §§ 
164.308(a)(1)(ii)(B) 
164.308(a)(7)(i) 
164.308(a)(7)(ii)(A) 
164.310(a)(1) 
164.310(a)(2)(i) 
164.310(a)(2)(ii) 

A.11.1.1 
A.11.1.2 
A.11.1.3 
A.11.1.4 
A.11.1.5 
A.11.1.6 
A.11.2.1 
A.11.2.3 
A.11.2.5 
A.11.2.6 
A.11.2.7 
A.11.2.8 
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NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

 PR.AC-3: Remote access is 
managed. 

AC-1 
AC-17 
AC-19 
AC-20 
SC-15 

ALOF 
AUTH 
CSUP 
EMRG 
NAUT 
PAUT 

45 C.F.R. §§ 
164.308(a)(4)(i) 
164.308(b)(1) 
164.308(b)(3) 
164.310(b) 
164.312(e)(1) 
164.312(e)(2)(ii) 

A.6.2.1 
A.6.2.2 
A.11.2.6 
A.13.1.1 
A.13.2.1 

 

PR.AC-4: Access permissions and 
authorizations are managed, 
incorporating the principles of 
least privilege and separation of 
duties. 

AC-1 
AC-2 
AC-3 
AC-5 
AC-6 
AC-14 
AC-16 
AC-24 

ALOF 
AUTH 
CNFS 
EMRG 
NAUT 
PAUT 

45 C.F.R. §§ 
164.308(a)(3) 
164.308(a)(4) 
164.310(a)(2)(iii) 
164.310(b) 
164.312(a)(1) 
164.312(a)(2)(i) 

A.6.1.2 
A.9.1.2 
A.9.2.3 
A.9.4.1 
A.9.4.4 
A.9.4.5 

 
PR.AC-5: Network integrity is 
protected (e.g., network 
segregation, network 
segmentation). 

AC-4 
AC-10 
SC-7 

MLDP 
NAUT 

45 C.F.R. §§ 
164.308(a)(4)(ii)(B) 
164.310(a)(1) 
164.310(b) 
164.312(a)(1) 
164.312(b) 
164.312(c) 

A.13.1.1 
A.13.1.3 
A.13.2.1 
A.14.1.2 
A.14.1.3 
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NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

 

PR.AC-7: Users, devices, and 
other assets are authenticated 
(e.g., single-factor, multi-factor) 
commensurate with the risk of 
the transaction (e.g., individuals’ 
security and privacy risks and 
other organizational risks). 

AC-7 
AC-8 
AC-9 
AC-11 
AC-12 
AC-14 
IA-1 
IA-2 
IA-3 
IA-4 
IA-5 
IA-8 
IA-9 
IA-10 
IA-11 

ALOF 
AUTH 
CSUP 
EMRG 
NAUT 
PAUT 

 45 C.F.R. § 
164.308(a)(4) 

A.9.2.1 
A.9.2.4 
A.9.3.1 
A.9.4.2 
A.9.4.3 
A.18.1.4 

 

Data Security 
(PR.DS) 

PR.DS-1: Data-at-rest is 
protected. 

MP-8 
SC-12 
SC-28 

IGAU 
MLDP 
NAUT 
SAHD 
STCF 
TXCF 

45 C.F.R. §§ 
164.308(a)(1)(ii)(D) 
164.308(b)(1) 
164.310(d) 
164.312(a)(1) 
164.312(a)(2)(iii) 
164.312(a)(2)(iv) 

A.8.2.3 

 PR.DS-2: Data-in-transit is 
protected. 

SC-8 
SC-11 
SC-12 

IGAU 
NAUT 
STCF 
TXCF 
TXIG 

45 C.F.R. §§ 
164.308(b)(1) 
164.308(b)(2) 
164.312(e)(1) 
164.312(e)(2)(i) 
164.312(e)(2)(ii) 
164.314(b)(2)(i) 

A.8.2.3 
A.13.1.1 
A.13.2.1 
A.13.2.3 
A.14.1.2 
A.14.1.3 
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NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

 PR.DS-5: Protections against data 
leaks are implemented. 

AC-4 
AC-5 
AC-6 
PE-19 
PS-3 
PS-6 
SC-7 
SC-8 
SC-13 
SC-31 
SI-4 

AUTH 
IGAU 
MLDP 
PLOK 
STCF 
TXCF 
TXIG 

45 C.F.R. §§ 
164.308(a)(1)(ii)(D) 
164.308(a)(3) 
164.308(a)(4) 
164.310(b) 
164.310(c) 
164.312(a) 

A.6.1.2 
A.7.1.1 
A.7.1.2 
A.7.3.1 
A.8.2.2 
A.8.2.3 
A.9.1.1 
A.9.1.2 
A.9.2.3 
A.9.4.1 
A.9.4.4 
A.9.4.5 
A.10.1.1 
A.11.1.4 
A.11.1.5 
A.11.2.1 
A.13.1.1 
A.13.1.3 
A.13.2.1 
A.13.2.3 
A.13.2.4 
A.14.1.2 
A.14.1.3 

 
PR.DS-6: Integrity-checking 
mechanisms are used to verify 
software, firmware, and 
information integrity. 

SC-16 
SI-7 

IGAU 
MLDP 

45 C.F.R. §§ 
164.308(a)(1)(ii)(D) 
164.312(b) 
164.312(c)(1) 
164.312(c)(2) 
164.312(e)(2)(i) 

A.12.2.1 
A.12.5.1 
A.14.1.2 
A.14.1.3 
A.14.2.4 
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NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

 

Information 
Protection 
Processes and 
Procedures 
(PR.IP) 

PR.IP-1: A baseline configuration 
of information technology/ 
industrial control systems is 
created and maintained, 
incorporating security principles 
(e.g., concept of least 
functionality). 

CM-2 
CM-3 
CM-4 
CM-5 
CM-6 
CM-7 
CM-9 
SA-10 

CNFS 
CSUP 
DTBK 
NAUT 

45 C.F.R. §§ 
164.308(a)(8) 
164.308(a)(7)(i) 
164.308(a)(7)(ii) 

A.12.1.2 
A.12.5.1 
A.12.6.2 
A.14.2.2 
A.14.2.3 
A.14.2.4 

 PR.IP-3: Configuration change 
control processes are in place. 

CM-3 
CM-4 
SA-10 

CNFS 
CSUP 
DTBK 

45 C.F.R. §§ 
164.308(a)(8) 
164.308(a)(7)(i) 
164.308(a)(7)(ii) 

A.12.1.2 
A.12.5.1 
A.12.6.2 
A.14.2.2 
A.14.2.3 
A.14.2.4 

 
PR.IP-4: Backups of information 
are conducted, maintained, and 
tested. 

CP-4 
CP-6 
CP-9 

DTBK 
PLOK 

164.308(a)(7)(ii)(A) 
164.308(a)(7)(ii)(B) 
164.308(a)(7)(ii)(D) 
164.310(a)(2)(i) 
164.310(d)(2)(iv) 

A.12.3.1 
A.17.1.2 
A.17.1.3 
A.18.1.3 

 PR.IP-6: Data is destroyed 
according to policy. MP-6 DIDT 

45 C.F.R. §§ 
164.310(d)(2)(i) 
164.310(d)(2)(ii) 

A.8.2.3 
A.8.3.1 
A.8.3.2 
A.11.2.7 



DRAFT  

 
 

NIST SP 1800-24B: Securing Picture Archiving and Communication System (PACS)         32 

NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

 

PR.IP-9: Response plans (Incident 
Response and Business 
Continuity) and recovery plans 
(Incident Recovery and Disaster 
Recovery) are in place and 
managed. 

CP-2 
CP-7 
CP-12 
CP-13 
IR-7 
IR-8 
IR-9 
PE-17 

DTBK 
SGUD 

45 C.F.R. §§ 
164.308(a)(6) 
164.308(a)(6)(i) 
164.308(a)(7) 
164.310(a)(2)(i) 
164.312(a)(2)(ii) 

A.16.1.1 
A.17.1.1 
A.17.1.2 
A.17.1.3 

 PR.IP-10: Response and recovery 
plans are tested. 

CP-4 
IR-3 
PM-14 

DTBK 
SGUD 

45 C.F.R. §§ 
164.308(a)(7)(ii)(D) A.17.1.3 

 

Protective 
Technology 
(PR.PT) 

PR.PT-1: Audit/log records are 
determined, documented, 
implemented, and reviewed in 
accordance with policy. 

AU Family AUDT 

45 C.F.R. §§ 
164.308(a)(1)(i) 
164.308(a)(1)(ii)(D) 
164.308(a)(5)(ii)(B) 
164.308(a)(5)(ii)(C) 
164.308(a)(2) 
164.308(a)(3)(ii)(A) 

A.12.4.1 
A.12.4.2 
A.12.4.3 
A.12.4.4 
A.12.7.1  

 
PR.PT-3: The principle of least 
functionality is incorporated by 
configuring systems to provide 
only essential capabilities. 

AC-3 
CM-7 

AUTH 
CNFS 
SAHD 

45 C.F.R. §§ 
164.308(a)(3) 
164.308(a)(4) 
164.310(a)(2)(iii) 
164.310(b) 
164.310(c) 
164.312(a)(1) 

A.9.1.2 
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NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

 PR.PT-4: Communications and 
control networks are protected. 

AC-4 
AC-17 
AC-18 
CP-8 
SC-7 
SC-19 
SC-20 
SC-21 
SC-22 
SC-23 
SC-24 
SC-25 
SC-29 
SC-32 
SC-36 
SC-37 
SC-38 
SC-39 
SC-40 
SC-41 
SC-43 

AUTH 
MLDP 
PAUT 
SAHD 

45 C.F.R. §§ 
164.308(a)(1)(ii)(D) 
164.312(a)(1) 
164.312(b) 
164.312(e) 

A.13.1.1 
A.13.2.1 
A.14.1.3 

DETECT 
(DE) 

Anomalies and 
Events (DE.AE) 

DE.AE-1: A baseline of network 
operations and expected data 
flows for users and systems is 
established and managed. 

AC-4 
CA-3 
CM-2 
SI-4 

CNFS 
CSUP 
MLDP 

45 C.F.R. §§ 
164.308(a)(1)(ii)(D) 
164.312(b) 

A.12.1.1 
A.12.1.2 
A.13.1.1 
A.13.1.2 
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NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

 
DE.AE-2: Detected events are 
analyzed to understand attack 
targets and methods. 

AU-6 
CA-7 
IR-4 
SI-4 

AUDT 
MLDP 

45 C.F.R. §§ 
164.308(a)(1)(i) 
164.308(a)(1)(ii)(D) 
164.308(a)(5)(ii)(B) 
164.308(a)(5)(ii)(C) 
164.308(6)(i) 
164.308(a)(6)(i) 

A.12.4.1 
A.16.1.1 
A.16.1.4 

 
DE.AE-3: Event data are collected 
and correlated from multiple 
sources and sensors. 

AU-6 
CA-7 
IR-4 
IR-5 
IR-8 
SI-4 

AUDT 
MLDP 
SGUD 

45 C.F.R. §§ 
164.308(a)(1)(ii)(D) 
164.308(a)(5)(ii)(B) 
164.308(a)(5)(ii)(C) 
164.308(a)(6)(ii) 
164.308(a)(8) 
164.310(d)(2)(iii) 

A.12.4.1 
A.16.1.7 

 DE.AE-5: Incident alert thresholds 
are established. 

IR-4 
IR-5 
IR-8 

DTBK 
MLDP 
SGUD  

45 C.F.R. §§ 
164.308(a)(1)(i) 
164.308(a)(1)(ii)(D) 
164.308(a)(5)(ii)(B) 
164.308(a)(5)(ii)(C) 
164.308(6)(i) 
164.308(a)(6)(i) 

A.16.1.4 

 
Security 
Continuous 
Monitoring 
(DE.CM) 

DE.CM-1: The network is 
monitored to detect potential 
cybersecurity events. 

AC-2 
AU-12 
CA-7 
CM-3 
SC-5 
SC-7 
SI-4 

AUDT 
CNFS 
CSUP 
MLDP 
NAUT 

45 C.F.R. §§ 
164.308(a)(1)(i) 
164.308(a)(1)(ii)(D) 
164.308(a)(5)(ii)(B) 
164.308(a)(5)(ii)(C) 
164.308(a)(2) 
164.308(a)(3)(ii)(A) 

N/A 
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NIST Cybersecurity Framework v1.1 Sector-Specific Standards & Best Practices 

Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

 
DE.CM-3: Personnel activity is 
monitored to detect potential 
cybersecurity events. 

AC-2 
AU-12 
AU-13 
CA-7 
CM-10 
CM-11 

AUDT 
EMRG 
PAUT 

45 C.F.R. §§ 
164.308(a)(1)(ii)(D) 
164.308(a)(3)(ii)(A) 
164.308(a)(5)(ii)(C) 
164.312(a)(2)(i) 
164.312(b) 
164.312(d) 

A.12.4.1 
A.12.4.3 

 DE.CM-4: Malicious code is 
detected. 

SI-3 
SI-8 

IGAU 
MLDP 

45 C.F.R. §§ 
164.308(a)(1)(ii)(D) 
164.308(a)(5)(ii)(B) 

A.12.2.1 

 
DE.CM-7: Monitoring for 
unauthorized personnel, 
connections, devices, and 
software is performed. 

AU-12 
CA-7 
CM-3 
CM-8 
PE-3 
PE-6 
PE-20 
SI-4 

AUDT 
PAUT 
PLOK 

45 C.F.R. §§ 
164.308(a)(1)(ii)(D) 
164.308(a)(5)(ii)(B) 
164.308(a)(5)(ii)(C) 
164.310(a)(1) 
164.310(a)(2)(ii) 
164.310(a)(2)(iii) 

A.12.4.1 
A.14.2.7 
A.15.2.1 

 DE.CM-8: Vulnerability scans are 
performed. RA-5 MLDP  

PLOK 

45 C.F.R. §§ 
164.308(a)(1)(i) 
164.308(a)(8) 

A.12.6.1 

RESPOND 
(RS) 

Response 
Planning 
(RS.RP) 

RS.RP-1: Response plan is 
executed during or after an 
event. 

CP-2 
CP-10 
IR-4 
IR-8  

DTBK 
MLDP 
SGUD 

45 C.F.R. §§ 
164.308(a)(6)(ii) 
164.308(a)(7)(i) 
164.308(a)(7)(ii)(A) 
164.308(a)(7)(ii)(B) 
164.308(a)(7)(ii)(C) 
164.310(a)(2)(i) 
164.312(a)(2)(ii) 

A.16.1.5 
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Function Category Subcategory 
NIST SP 
800-53 
Revision 4  

IEC TR 80001-
2-2 HIPAA Security Rule ISO/IEC 27001 

RECOVER 
(RC) 

Recovery 
Planning 
(RC.RP) 

RC.RP-1: Recovery plan is 
executed during or after a 
cybersecurity incident.  

CP-10 
IR-4 
IR-8 

DTBK 
MLDP 
SGUD 

45 C.F.R. §§ 
164.308(a)(7) 
164.308(a)(7)(i) 
164.308(a)(7)(ii) 
164.308(a)(7)(ii)(C) 
164.310(a)(2)(i) 
164.312(a)(2)(ii) 

 A.16.1.5 
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3.6 Technologies 628 

Table 3-5 lists all of the products and technologies used in this project and provides a mapping among 629 
the generic application term, the specific product used, and the security control(s) that the product 630 
provides or supports. Refer to for an explanation of the NIST Cybersecurity Framework Subcategory 631 
codes. 632 

Table 3-5 Products and Technologies 633 

Component/ 
Capability 

Product Function NIST 
Cybersecurity 
Framework 
Subcategories 

PACS and 
VNA 

Hyland Acuo Vendor 
Neutral Archive 
Version 6.0.4 

 Provides access to medical images 
and documents 

 Stores and retrieves images in a 
standard format to be accessed by 
various vendor-neutral systems 

PR.AC-1 
PR.AC-4 
PR.DS-2 
PR.IP-4 
PR.PT-1 

Hyland NilRead 
Enterprise Version 
4.3.31.98805 

 Provides medical image viewing and 
manipulation 

PR.AC-1 
PR.DS-2 
PR.PT-1 

Hyland PACSgear 
Version 4.1.0.64 

 Provides ability to capture and share 
medical images 

 Provides ability to scan and share 
medical documents 

PR.AC-1 
PR.DS-2 
PR.PT-1 

Philips Enterprise 
Imaging Domain 
Controller 

 Provides role-based user-access 
control 

PR.AC-1 

Philips Enterprise 
Imaging IntelliSpace 
PACS 

 Provides management of medical 
images through access and 
collaboration 

PR.DS-2 
PR.IP-4 
PR.PT-1 

Philips Enterprise 
Imaging Universal Data 
Manager 

 Provides web-based DICOM 
integration 

 Provides image lifecycle management 

PR.DS-2 
PR.IP-4 
PR.PT-1 

DCM4CHEE  Open source PACS solution 
 Allows the lab to demonstrate data-

in-transit workflow control 

N/A 
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Component/ 
Capability 

Product Function NIST 
Cybersecurity 
Framework 
Subcategories 

 
DVTk Modality 
Emulator 

 Open source utility used to 
demonstrate clinical workflow and 
interaction with medical imaging 
devices 

 Allows the lab to demonstrate data-
in-transit workflow between clinical 
systems and medical devices 

N/A 

DVTk RIS Emulator  Open source utility used to 
demonstrate clinical workflow and 
interaction with medical imaging 
devices 

 Allows the lab to demonstrate data-
in-transit workflow between clinical 
systems and medical devices 

N/A 

Asset 
Management 

Virta Labs BlueFlow 
Version 2.6.4 

 Provides discovery, categorization, 
grouping, tagging, and identification 
of medical devices 

 Provides flexible user-defined risk 
assessment and scoring 

 Provides vulnerability management 
capabilities 

 Provides reporting on risk and 
security properties for groups of 
assets 

 Provides threat feed for known 
medical devices 

ID.AM-1 
ID.AM-2 
ID.AM-4 
ID.AM-5 
ID.RA-1 
ID.RA-5 
PR.IP-1 

Clearwater 
Information Risk 
Management Analysis 

 Provides asset inventory 
management 

 Provides risk assessment and 
compliance 

ID.AM-1 
ID.AM-2 
ID.AM-4 
ID.AM-5 

Tripwire Enterprise 
Version 8.7 

 Provides security configuration 
management 

 Provides file integrity monitoring 
 Provides patch management 

ID.RA-1 
ID.RA-5 
PR.DS-6 
PR.IP-1 
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Component/ 
Capability 

Product Function NIST 
Cybersecurity 
Framework 
Subcategories 
PR.IP-3 
PR.PT-3 

Enterprise 
Domain and 
Identity 
Management 

Active Directory  Provides authentication and 
authorization for users and 
computers in the domain 

 Provides authentication and 
authorization to multiple applications 
within the environment 

PR.AC-1 
PR.AC-4 
PR.AC-7 
PR.PT-3 

DigiCert PKI Platform  Provides SSL/TLS certificates for 
secure communication between 
devices 

 Enables devices to perform data-in-
transit encryption 

 Provides certificate management 

PR.AC-1 
PR.AC-4 
PR.AC-7 
PR.DS-2 

Symantec Validation 
and ID Protection 
Version 9.8.4 Windows 

 Integrates with TDi ConsoleWorks 
using RADIUS 

 Provides multifactor authentication 
for remote access 

PR.AC-1 
PR.AC-3 
PR.AC-7 

Network 
Control and 
Security 

Cisco Firepower 
Management Center 
(FMC) 6.3.0 

 Provides console management for 
Firepower Threat Defense 

 Provides centralized control over 
network and communication 

 Provides network visibility 

PR.AC-5 
PR.PT-4 

Cisco Firepower Threat 
Defense (FTD) 6.3.0 

 Provides intrusion prevention 
 Provides network segmentation 
 Provides policy-based network 

protection 

PR.AC-5 
PR.PT-4 

Tempered Networks 
Identity Defined 
Networking (IDN) 
Conductor and 
HIPswitch Version 2.1 

 Provides network segmentation 
 Provides end-to-end encryption for 

device traffic 

PR.AC-5 
PR.DS-2 
PR.PT-4 
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Component/ 
Capability 

Product Function NIST 
Cybersecurity 
Framework 
Subcategories 

Zingbox IoT Guardian  Provides passive device discovery and 
classification 

 Provides behavioral modeling to 
identify suspicious behavior 

 Provides vulnerability assessment 

ID.AM-3 
ID.RA-1 
ID.RA-5 
DE.AE-1 
DE.AE-2 
DE.AE-3 
DE.AE-5 
DE.CM-1 
DE.CM-7 

Forescout CounterACT 
8 

 Provides passive device discovery and 
profiling 

 Provides network access control 

PR.AC-4 
PR.AC-7 
PR.PT-4 
DE.AE-1 
DE.AE-3 
DE.CM-1 
DE.CM-7 

Symantec Endpoint 
Detection and 
Response (EDR) 
Version 4.1.0 

 Provides centralized management of 
threats across endpoint, network, 
and web traffic 

DE.CM-1 
DE.CM-4 

Cisco Stealthwatch 
Version 7.0.0 

 Provides insight into who and what is 
on the network 

 Provides network analysis through 
machine learning and global threat 
intelligence 

 Provides malware detection for 
encrypted traffic 

ID.AM-3 
DE.AE-1 
DE.AE-2 
DE.AE-3 
DE.AE-5 
DE.CM-1 
DE.CM-3 
DE.CM-7 

Secure 
Remote 
Access 

TDi Technologies 
ConsoleWorks Version 
5.1-0u1 

 Provides remote access for external 
collaborators 

 Provides logging and monitoring of 
remote access activities 

PR.AC-3 
PR.AC-7 
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Component/ 
Capability 

Product Function NIST 
Cybersecurity 
Framework 
Subcategories 

Endpoint 
Protection 
and Security 

Symantec Data Center 
Security: Server 
Advanced (DCS:SA) 
Version 6.7 

 Provides protection for physical and 
virtual servers 

 Provides intrusion detection and 
prevention 

 Provides file integrity monitoring 

PR.DS-6 
PR.IP-3 

Symantec Endpoint 
Protection (SEP 14) 
Version 14.2 

 Provides centralized management of 
assets through agent-based 
protection 

 Provides advanced machine learning 
and behavioral analysis techniques to 
identify known and unknown threats 

 Provides anti-virus (AV) capabilities 

DE.CM-4 
DE.CM-8 

4 Architecture 634 

This practice guide looks at the reference architecture holistically. Food and Drug Administration (FDA) 635 
guidance looks at “medical devices that provide functions related to the management of medical images 636 
after acquisition, including communication, storage, processing and display (generally known as Picture 637 
Archiving and Communications Systems [PACS])” [19]. In addition to the PACS, this project also uses VNA 638 
solutions that meet the FDA’s definition of PACS but have other features that HDOs may use to enhance 639 
their overall image management ecosystem. This guide understands that healthcare systems 640 
interoperate with one another and that the reference architecture needs to accommodate a broad view 641 
of the medical imaging ecosystem. 642 

4.1 Architecture Description 643 

Our project’s architecture looks at components from three primary layers: 644 

 business, where we deployed our core medical imaging components 645 

 security, where we implemented security tools 646 

 infrastructure, which represents our network 647 

Figure 4-1 illustrates the project’s high-level architecture. 648 
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Figure 4-1 High-Level PACS Architecture 649 

 650 

The PACS ecosystem includes components that address data in transit, data at rest, and data processing 651 
and provides applications allowing authorized individuals to review and interact with data stored in their 652 
respective systems. Also included in our architecture are clinical systems, including imaging modalities 653 
and applications such as the RIS that each play business process roles that interact with the PACS and 654 
VNA. Medical imaging generally uses standard protocols, including DICOM. 655 

DICOM is an international standard specific to storing, retrieving, printing, processing, and displaying 656 
medical information. The DICOM standard assures medical image information operability and provides a 657 
common standard, allowing different medical imaging product vendors to integrate their solutions into 658 
the medical imaging ecosystem [2], [3]. 659 

In addition to the DICOM standard, PACS uses the HL7 protocol for clinical documentation and image 660 
reporting. HL7 defines a markup standard for exchange of health information in a structured format by 661 
using a Clinical Document Architecture (CDA) [20]. 662 

This document examines standard technology components in addition to the protocols noted above. 663 
Central to PACS are storage media, the network infrastructure, supporting operating systems, as well as 664 
application servers to support information exchange (e.g., HL7, DICOM, and web servers). 665 
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The architecture described for this project implements several zones consisting of: 666 

Clinical Application Services consist of systems such as the EHR, order entry, health information 667 
systems, and others used by patient care teams in recording information during treatment of patients. 668 

Clinical Workstations are segregated from the standard production network. Clinical workstations are 669 
special-purpose devices used to interact with clinical systems. Those devices may use vendor-specified 670 
operating systems, applications, and configurations that vary from the HDO standard build. 671 
Configuration and patch management may be asynchronous with how the HDO manages its productivity 672 
or standard build systems. 673 

Enterprise Network Services are systems used to ensure enterprise operations are segregated into the 674 
enterprise network services zone. Services consist of email communications, Active Directory, DNS, and 675 
security services such as certificate management. 676 

Modalities: Departments using imaging equipment, generally termed as modalities, would connect 677 
those imaging devices to the modalities zone. These devices are medical devices using operating 678 
systems that are not consistent with an HDO’s baseline. Configuration and patch management are likely 679 
asynchronous with how the HDO manages its productivity or standard build systems. For purposes of 680 
this project, this zone includes emulated modalities. Images themselves are generated using simulation 681 
software. 682 

PACS and VNA Systems: PACS and VNA applications are segregated from clinical applications, general 683 
workstations, and storage media. This zone provides the higher-level application functionality to interact 684 
with aggregated medical images. 685 

Storage: Large scale storage, such as storage area networks (SANs) or network-attached storage (NAS) 686 
devices, would reside in a segregated zone. Data found in this zone may be unstructured, large files and 687 
consist of sensitive, personal, or protected health information. Depicted below is the storage zone, 688 
which also includes cloud storage, delineated as a separate zone. 689 

Vendor Net supports remote connectivity, e.g., remote vendor support. This zone segregates external 690 
network traffic used when vendors may need to perform maintenance on systems or other equipment 691 
while the support engineer is off premises. 692 

4.1.1 PACS Ecosystem Components 693 

The PACS ecosystem includes those components that support the clinical processes associated with 694 
supporting medical imaging acquisition, review, annotation, and storage. Image acquisition worklists are 695 
generated by clinical applications, such as RIS, and applied to associated modalities. Modalities retrieve 696 
worklists from the RIS. This practice guide also includes a mobile device used to scan documents and 697 
images, and this guide treats this device as a modality. Images are stored and managed by PACS and 698 
VNA systems, and images are reviewed and annotated through image viewer applications installed on 699 
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clinical workstations. In building the lab environment, this practice guide emulated some of the 700 
components rather than obtaining full scale solutions. This guide implemented emulated modalities and 701 
an emulated RIS. A smartphone device is used for document scanning. The lab environment includes 702 
two distinct PACS and a VNA. Also, workstations are deployed that include image viewing software that 703 
was provided by the PACS and VNA solutions respectively. Figure 4-2 depicts a high-level view of these 704 
components and how we approached implementing them in the lab environment. 705 

Figure 4-2 PACS Ecosystem Components 706 

 707 

 

In the lab, this project deployed emulated medical imaging modalities as well as an emulated RIS using 708 
an open source tool from DVTk (https://www.dvtk.org). The project deployed two instances of the RIS 709 
Emulator into the clinical application services zone. The DVTk RIS Emulators associate the modalities 710 
with separate PACS and provide worklists for those modalities associated with two respective PACS, 711 
reflective of an HDO that may operate multiple PACS. The project used Philips IntelliSpace PACS and 712 
DCM4CHEE (https://www.dcm4che.org/), an open source PACS, to support this premise. Hyland Acuo 713 
VNA was deployed to model HDOs using this technology. 714 

The modalities were deployed to a modalities network zone. Using emulated modalities allowed the 715 
project team to simulate DICOM image acquisition, interaction with the RIS, and transferring images 716 
from the modality device to the PACS and VNA for storage and management. An iPhone was used to 717 
operate the PACS Scan Mobile app provided by Hyland, connecting to a PACSgear Core Server. The 718 

https://www.dvtk.org/
https://www.dcm4che.org/
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iPhone device was treated as a modality, with the app facilitating document scanning and, through the 719 
PACSgear server, transferring mobile acquired images to the VNA. 720 

4.1.2 Data and Process Flow 721 

For this project, we examined data and process flows as described in Section 3.4.1, Establishing the Risk 722 
Context, that include the following scenarios: 723 

 sample radiology practice flows 724 

 access to aggregations and collections of different types of images 725 

 accessing monitoring and auditing 726 

 image object change management 727 

 remote access 728 

The scenarios identify those processes involved when a medical image is acquired, starting with 729 
scheduling the patient for a procedure, and follows the life cycle through when the patient interacts 730 
with an imaging device to when a medical imaging specialist processes and forwards the annotated 731 
image to a clinician for interpretation and diagnosis. Scenarios also examine processes after direct 732 
patient interaction, such as when images may be accessed for later review or if images need to be 733 
updated. 734 

Figure 4-3 shows a simplified data communication flow in the PACS ecosystem. 735 
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Figure 4-3 PACS Ecosystem Data Communication Flow 736 

 737 

A typical radiology department workflow may begin with patient registration and admissions, followed 738 
by a physician ordering an imaging procedure. The order is entered into a RIS to create a worklist. A 739 
medical imaging technologist attends to a patient and performs the image capture procedure. The 740 
medical imaging technologist may make annotations for a physician’s review. That information is then 741 
forwarded to a PACS or VNA. A physician retrieves the images from the PACS or VNA and uses an image 742 
viewing station to review the images and document findings and diagnoses. On completion, the 743 
physician transfers the information back to the PACS. Results may cross reference with the EHR system. 744 

4.1.3 Security Capabilities 745 

For this project, we build upon the zoned network architecture described in NIST SP 1800-8, Securing 746 
Wireless Infusion Pumps in Healthcare Delivery Organizations [21]. We used the zoning approach as a 747 
baseline upon which we could deploy the medical imaging ecosystem infrastructure. On top of the 748 
baseline, we selected the following security capabilities that were determined to be relevant to securing 749 
our project environment: 750 

 asset and risk management 751 

 enterprise domain and identity management 752 

• access control 753 

o privileged access controls 754 
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o user authentication 755 

o device and system authentication 756 

o data access control 757 

 network control and security 758 

• network segmentation and virtual local area networks (VLANs) 759 

• firewall and control policies 760 

• microsegmentation 761 

• anomalies and events detection (behavioral analytics) 762 

• intrusion detection and prevention systems 763 

 end-point protection and security 764 

• device hardening and configuration 765 

• malware detection 766 

 data security 767 

• data encryption (at-rest) 768 

• data encryption (in-transit) 769 

 secure remote access 770 

While the project takes a holistic approach when evaluating the medical imaging environment, the 771 
controls scope noted in this practice guide are bound to those elements that are inherent or highly 772 
supportive of acquiring, interpreting, or storing medical images. An HDO’s infrastructure is larger in 773 
scope than that used to support the medical imaging environment. An HDO may and should implement 774 
additional pervasive controls to secure the overall environment. This document references pervasive 775 
controls that were not implemented during the project and assumes an organization would implement 776 
appropriate controls to address its broader risk profiles. Refer to Appendix C for details. Figure 4-4 777 
below depicts contextual controls deployed in the project’s test build. 778 
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Figure 4-4 Base Controls on Test Build Components 779 

 780 

4.1.4 Asset and Risk Management 781 

Asset management is a critical control that aligns with the Function known as Identify in the NIST 782 
Cybersecurity Framework [8]. For this project, IT general assets are assumed to be controlled through a 783 
pervasive control such as a governance, risk, and compliance (GRC) solution, e.g., the Clearwater 784 
Information Risk Management Analysis tool, addressing the core infrastructure. Medical imaging devices 785 
may fall outside the scope of IT general assets for many HDOs. As such, this project implements Virta 786 
Labs BlueFlow for asset and inventory management for medical imaging devices. BlueFlow captures 787 
inventory, configuration, and patch management information [16], [22], [23]. 788 

4.1.5 Enterprise Domain and Identity Management 789 

This project looks at identity management controls as including several concepts that encompass 790 
identity proofing, credentialing, and providing a means to authenticate devices and systems. Human 791 
actors (clinical, IT administrative, and general HDO staff), medical devices, and systems may have 792 
identities established within the HDO. An identity is a broader concept than credentials or user 793 
accounts. This project assumes that HDOs perform adequate identity proofing and provisioning. This 794 
involves processes that allow HDOs to verify that an individual is who they claim to be, also ensuring 795 
that the individual has appropriate credentials to interact with clinical systems and medical imaging 796 
information. Regarding provisioning, this project assumes that following identity proofing, the 797 
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organization can create and securely deliver credentials (e.g., user accounts in which the individual can 798 
select and update passwords or challenge responses known only to that individual). 799 

Identities may include multiple user accounts or access mechanisms that may be applied. For example, 800 
an individual may have a job function as an IT administrator. As a member of the HDO workforce, they 801 
may be credentialed to access certain systems such as email or productivity software. They may also 802 
have access to separate privileged accounts to be used when they perform IT administrative duties. 803 
Having separate credentials established based on functionality or role is a common practice in 804 
healthcare and provides a form of separation of duties. 805 

Medical devices and systems may also have identities, where authentication is performed using digital 806 
certificates or other unique identifiers such as host identifiers or MAC addresses. 807 

4.1.5.1 Access Control 808 

Access control is applied contextually, based on the identity type. This project implements access 809 
control for privileged users, clinical users, devices, and systems. Subsections below provide more detail 810 
on the project’s approach. 811 

4.1.5.1.1 Privileged Access Management 812 
Privileged access includes those credentials that have permissions to systems that are greater than 813 
standard users. Privileged access accounts often allow greater visibility of resources stored on systems 814 
and may allow modifying configuration settings or permitting installation of software components. One 815 
measure that this guide implemented was segregating privileged access accounts. These accounts were 816 
unique and distinct from those accounts we created that were able to access information via DICOM 817 
viewer applications. When privileged access was required, access to the environment was routed 818 
through our TDi ConsoleWorks environment, which enforced the project’s multifactor authentication 819 
solution. 820 

For further guidance on privileged account management, HDOs should reference NIST SP 1800-18, 821 
Privileged Account Management for the Financial Services Sector [24]. While the document identifies 822 
solutions for financial services, the underlying technology solution is applicable to healthcare and other 823 
sectors. 824 

4.1.5.1.2 User Authentication 825 
User authentication involves the use of different factors. Factors are characteristics by which a user may 826 
be able to assert their identity. In many cases, users are authenticated using a single factor (e.g., a 827 
username and password combination). One means to strengthen single factor authentication is to use 828 
pass phrases rather than passwords. This approach reduces the possibility that a malicious actor may be 829 
able to brute force attack the credential [25]. 830 

Another consideration that HDOs may consider is to implement multifactor authentication where 831 
appropriate or feasible. Multifactor authentication includes a need to pass two or more factors that 832 
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represent something a user knows, has, or is. Memorized passwords or pass phrases represent factors a 833 
user knows. Including other factors, such as something a user has, which may represent a physical 834 
token; or something a user is, such as biometrics that include fingerprints, retinal, or facial scans, would 835 
provide greater assurance that the user is who they claim to be. Multifactor authentication may not be 836 
implementable in all cases, and HDOs may need to determine their risk tolerance and implementation 837 
practicality when considering enhancing their authentication models [26]. 838 

4.1.5.1.3 Device and System Authentication 839 
For this project, we emulated medical imaging devices and implemented the HIP. Emulated modality 840 
devices authenticated to a HIPswitch, routing modality traffic across a HIP-secured software defined 841 
network. For further information, refer to the discussion on Section 4.1.6.3, Microsegmentation. 842 

For systems authentication, this project used digital certificates. Digital certificates were deployed to the 843 
PACS and VNA servers as well as to a mobile device where we installed software used to scan 844 
documents and images that would be added to our medical imaging store. 845 

4.1.5.1.4 Data Access Control 846 
PACS and VNA solutions often support a “multi-tenant” concept to allow for different departments, 847 
clinics, or hospitals within a larger healthcare system. These applications may implement or integrate 848 
with directory services that allow solutions administrators to provide access based on role or business 849 
function. This project used role-based access control capabilities found in the Philips IntelliSpace and 850 
Hyland Acuo systems. 851 

4.1.6 Network Control and Security 852 

This project continues with concepts established in NIST SP 1800-8, implements network zoning and 853 
segmentation with VLANs, and builds on the concept by implementing several tools to advance 854 
protective and detective capabilities. As examples of these enhancements, this project deploys a next-855 
generation firewall, introduces microsegmentation, and implements behavioral analytics in its network 856 
control and security in its approach. Subsections below provide additional information on these topics. 857 

4.1.6.1 Network Segmentation and VLANs 858 

The PACS ecosystem is made up of a variety of different devices with independent requirements to 859 
ensure proper functionality. While some devices may require network access to remote services, others 860 
may operate effectively with limited connectivity outside their subnet. To meet these needs, we 861 
implemented VLAN to segment the PACS network based on devices of similar needs and functionalities. 862 
This complies with the concept of “network zoning” introduced in NIST SP 1800-8 [21]. With this 863 
approach, we eliminate inherent trust between VLANs. Devices are allowed to communicate with only 864 
trusted devices based on carefully crafted network policies. 865 
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In total, the PACS project implemented the architecture described in Section 4.1 by constructing a 866 
network that was segmented into VLANs. The project implementation was limited to the main 867 
components necessary for the PACS ecosystem. The project segmented the network into the following 868 
VLANs: 869 

 vendor net 870 

 enterprise services 871 

 clinical viewers 872 

 PACS A 873 

 PACS B 874 

 modalities 875 

 clinical applications 876 

 guest services 877 

 databases 878 

 remote storage 879 

 security services 880 

For this project, segmentation is established through virtualization, with separate subnets implemented 881 
for each VLAN listed above. Each VLAN is placed behind a router/firewall that implements policies 882 
defined by VLAN’s purpose. Figure 4-5 below depicts the network architecture. 883 

Figure 4-5 NCCoE Lab Environment Network Architecture 884 

 885 
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4.1.6.2 Firewall and Control Policies 886 

This project uses Cisco’s Firepower Next Generation Firewall (NGFW). The NGFW provides several 887 
features that combine features previously found in separate perimeter security products such as 888 
intrusion prevention systems, application firewalls, proxy servers, and traditional packet inspection. The 889 
NGFW allows integration of other tools to defend the network against malicious activity. 890 

As network and application attacks become more advanced, network controls should be enhanced 891 
beyond stateful traffic filtering. NGFW goes beyond ports, protocols, and IP addresses, providing 892 
standard policy-based protection, while including more advanced tools such as intrusion prevention 893 
systems, application filtering, URL filtering, and geo-location blocking. The PACS ecosystem faces a 894 
variety of threats from different sources, and a comprehensive approach to network security is vital. The 895 
lab implemented network zoning using policy and configuration settings through Firepower. This 896 
allowed the project to implement network zoning and proactive network traffic filtering. 897 

4.1.6.3 Microsegmentation 898 

Microsegmentation uses software defined networking (SDN) to create a virtual overlay network over the 899 
pre-existing network infrastructure. Devices may be grouped based on usage, with developed policies 900 
that establish granular degrees of trust. For our project, the SDN overlay is implemented using HIP over 901 
the existing network infrastructure and offers in-transit network encryption. This project uses 902 
microsegmentation to establish network control for modalities. Modalities represent medical imaging 903 
devices. These end-point devices may contain exploitable vulnerabilities and may not have practical 904 
means to mitigate compromise beyond network protection. While VLAN-defined network zoning may 905 
afford network protection, this guide implements microsegmentation for these medical devices to 906 
reduce VLAN management complexity and provide more robust network segregation for medical 907 
devices. A microsegmentation approach may offer a solution that requires less impact to network 908 
configuration, while limiting adverse interaction with the modalities. 909 

Our project implemented microsegmentation through Tempered Networks’ HIP solution that includes 910 
HIPswitches, implementing HIP, as described in Internet Engineering Task Force Request for Comments 911 
(RFC) 4423 [27]. HIP provides a cryptographically defined host identifier bound to endpoints rather than 912 
IP addresses. Network traffic between HIP-enabled endpoints traverses a series of HIPswitches deployed 913 
in the lab network infrastructure, creating a cloaked network that operates on top of the physical 914 
network. The cloaked network uses advanced encryption standard (AES)-256 encryption to secure data 915 
in transit and uses secure hash algorithm (SHA)-256 to authenticate data packets from HIP-enabled 916 
endpoints [28], [29], [30]. Figure 4-6 below depicts the microsegmentation architecture deployed in the 917 
project’s test build. 918 
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Figure 4-6 Microsegmentation Architecture 919 

 920 

While VLAN segmentation can help reduce unwanted lateral movement within a network, it does not 921 
restrict lateral movement within that zone. For some devices and workloads, it may be necessary to 922 
isolate their operations and allow only a select few interactions with other devices. The project team 923 
determined that microsegmentation would be an appropriate control to protect medical imaging 924 
devices that may operate embedded operating systems or firmware where patch release cycles may be 925 
different from current commercial off the shelf operating systems. Microsegmentation provides this 926 
fine-grained approach to isolation and can be implemented within a pre-existing network. 927 

Within the PACS ecosystem, we identified an area where microsegmentation would improve operational 928 
security. This guide implements microsegmentation through a solution based on HIP. HIP uses 929 
cryptographic host identifiers rather than IP addresses to address and authenticate endpoints and to 930 
create secure tunnels. This guide uses this concept to abstract IP addressing away from the modalities, 931 
using identity-defined perimeters where endpoint devices are authenticated to HIPswitches and allow 932 
secure tunnel communications to other HIPswitches [27]. 933 

For this project’s architecture, it was important to secure this line of communication and ensure these 934 
devices were properly protected from potential threats. To accomplish this, the project established two 935 
identity-defined perimeters on two separate VLANs. The project then placed a modality behind one 936 
perimeter and a PACS behind the other. These perimeters were configured to allow only authorized 937 
traffic between them, meaning the modality was allowed to communicate only with the PACS and vice 938 
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versa. Additionally, all traffic between the two perimeters was encrypted, ensuring the data were secure 939 
in-transit. 940 

4.1.6.4 Anomalies and Events Detection (Behavioral Analytics) 941 

Medical devices often operate within strict requirements and limited resources. This makes certain tasks 942 
like vulnerability assessment difficult to manage, as they often require obtrusive operations such as a 943 
host-installed agent. Network-based behavioral analytics can perform the same assessments, identifying 944 
suspicious operations without affecting medical device function or performance. Behavioral analytics is 945 
an automated feature that collects and analyzes network traffic flow and compares the results to a pre-946 
established baseline to determine whether devices are operating abnormally. 947 

For the PACS architecture, the project identified network flows, primarily among PACS, VNA, and 948 
modalities, where it is important to monitor for abnormal behavior. With a baseline established, the 949 
project can identify when endpoints attempt to conduct network operations outside their normal 950 
profile. With this information, we can verify and remediate the threat. The project implemented the 951 
Zingbox IoT Guardian solution. 952 

4.1.6.5 Intrusion Detection and Prevention Systems 953 

Components managed through an HDO’s IT operations team would implement traditional mechanisms 954 
to perform malware detection, vulnerability scanning, and remediation. This project involved several 955 
workstations (e.g., image viewing devices), as well as servers that may operate traditional operating 956 
systems. Host-based agents are deployed, as appropriate, to permit the IT team to perform regular 957 
vulnerability scanning for those non-modality systems. This project implemented Symantec Endpoint 958 
Protection on image viewing workstations. Also, the project implemented the Cisco Firepower NGFW 959 
that included a network-based intrusion prevention mechanism [31]. 960 

4.1.7 Endpoint Protection and Security 961 

This project addressed endpoint protection and security through device hardening and configuration 962 
controls and by monitoring for malware. Solutions were deployed to server and workstation endpoints. 963 
The project also used a tool to monitor server configurations to assure that only authorized changes 964 
were made, therefore maintaining server configuration integrity. 965 

4.1.7.1 Device Hardening and Configuration 966 

Tripwire Enterprise was deployed on server components (e.g., the Hyland Acuo server and the Philips 967 
IntelliSpace server) to address device hardening and configuration management, as well as 968 
implementing whitelisting. 969 

To protect servers performing critical functions in the HDO, a host intrusion prevention system (HIPS) 970 
was deployed. The HIPS tool was designed to prevent the internals of an operating system from 971 
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performing unintended or malicious activity. This mechanism can provide further protection from 972 
attackers attempting to compromise the system, by preventing installation or execution of malicious 973 
software. This tool provides support for policy-based rules for monitoring file system changes of critical 974 
operating system application and system file directories. This allows the tool to monitor critical settings 975 
of the operating system, such as Windows registry keys. In our environment we used these tools to 976 
ensure new executables were not installed, thus reducing the attack surface of critical systems. 977 

In conjunction with HIPS, critical servers in the reference architecture are protected with a file integrity 978 
monitoring (FIM) system. This system monitors file system changes, looking for suspicious changes. The 979 
FIM system is also used to do policy compliance evaluation to ensure compliance of the critical servers 980 
with the HDO policies. 981 

4.1.7.2 Malware Detection 982 

An endpoint-based malware detection system commonly referred to as antivirus software is used to 983 
prevent, detect, and remove malicious software from systems. This function is critical to protecting the 984 
systems that healthcare professionals use to interact with the PACS, such as the imaging workstations. 985 
The antivirus software implemented in our reference architecture builds upon the traditional role that  986 
antivirus software performs by analyzing software for suspicious behavior, performing firewall functions, 987 
and allowing custom policy-based enforcement. These added functions enhance the ability for HDOs to 988 
respond to the threat of malicious software on healthcare systems. Our project deployed the Symantec 989 
Endpoint Protection solution on workstations hosting our DICOM image viewers. 990 

A network-based malware detection system, commonly referred to as an intrusion detection system 991 
(IDS), is designed to detect malicious activity over the network. In our reference architecture, the IDS is 992 
designed to interface directly with the manager of the endpoint-based malware detection system. This 993 
gives the IDS the ability to use data collected from the endpoint to better detect malicious activity on 994 
the network [31]. 995 

4.1.8 Data Security 996 

This project considered challenges associated with data loss and data alteration. A noted challenge in 997 
looking at the medical imaging ecosystem is the diversity of data types that may be prone to varying 998 
threat types, with compromise resulting in different adverse outcomes. This project examined data 999 
flows between the implemented components and identified a need to secure data in-transit and data at-1000 
rest. 1001 

4.1.8.1 Data Encryption (at-rest and in-transit) 1002 

No specific storage solution was implemented for this project, however, the need for data-at-rest 1003 
protection was identified. This practice guide recommends referring to NIST SP 1800-11, Data Integrity: 1004 
Recovering from Ransomware and Other Destructive Events [32], for measures that address backup and 1005 
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recovery. The PACS and VNA solutions used in this project were implemented on Windows servers, and 1006 
this practice guide recommends implementing secure server message block (SMB) best practices, e.g., as 1007 
provided by Department of Homeland Security Cyber Infrastructure Security Agency (CISA) [33]. 1008 

Examining the communications traffic flow, the project team determined that relevant data are sensitive 1009 
in nature. Medical images and accompanying clinical notes and diagnoses are PHI and have 1010 
requirements that align with confidentiality, integrity, and availability. 1011 

Modalities communicating to the PACS and VNA are authenticated using HIP, which also provides for 1012 
network encryption. HIP employs AES-256 encryption [28], [29], [30] to secure network sessions. By 1013 
deploying HIP, this project sought to defend against network-borne attacks, including man in the middle 1014 
attacks where data may be altered in transit. 1015 

When multiple PACS data are aggregated into the VNA, the project enabled TLS tunneling. TLS uses 1016 
DigiCert TLS certificates to implement AES-256 network encryption [29], [30], [34]  1017 

Image viewers, as well as mobile devices using Hyland’s PACSgear scanning tool, use https/TLS when 1018 
connecting and communicating to the VNA or PACS respectively [34]. 1019 

4.1.9 Remote Access 1020 

Both healthcare and IT systems require access by vendor support technicians for remote configuration, 1021 
maintenance, patching, and updates to software and firmware. In our environment, a remote access 1022 
network segment was designed to provide these external privileged users with privileged access to 1023 
these components that reside within our reference architecture. A virtual private network (VPN) 1024 
solution provides a secure way in which an organization can extend its private network across the 1025 
internet, ensuring that only properly authenticated users can access their organization’s private 1026 
network. The NCCoE VPN in our environment was configured and managed using vendor-recommended 1027 
practices [35]. This project implemented TDi ConsoleWorks as a remote access mechanism into the 1028 
infrastructure. 1029 

To further secure access to remote resources, the team implemented a privileged access management 1030 
(PAM) solution [24]. The PAM solution provides two-factor authentication (2FA), fine grained access 1031 
control, and monitoring of user access to remote resources. 2FA is provided via domain-based username 1032 
and password and an app-based security token available on the user’s mobile device. 2FA was 1033 
implemented in the test build using Symantec Validation and ID Protection (VIP) solution. Symantec VIP 1034 
was integrated into the ConsoleWorks authentication mechanism, allowing the project to enforce 1035 
username password plus onetime passcode to make up the two factors. 1036 

4.2 Final Architecture 1037 

The target architecture, depicted in Figure 4-7, demonstrates control measures such as 1038 
microsegmentation and network segmentation as described by this practice guide. The architecture 1039 
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depicts network zones using VLANs, with the modalities zone implemented using microsegmentation. 1040 
The target architecture also includes using cloud storage for long term archiving and serves to enhance 1041 
resiliency and recoverability should the HDO be subject to an adverse event. 1042 

Figure 4-7 PACS Final Architecture 1043 

 1044 

5 Security Characteristic Analysis 1045 

The purpose of the security characteristic analysis is to understand the extent to which the project 1046 
meets its objective of demonstrating the security capabilities described in the reference architecture in 1047 
Section 4. This evaluation focuses on the security of the reference design itself. In addition, it seeks to 1048 
understand the security benefits and drawbacks of the example solution. 1049 

5.1 Assumptions and Limitations 1050 

The security characteristic analysis has the following limitations: 1051 

 It is neither a comprehensive test of all security components nor a red-team exercise. 1052 

 It cannot identify all weaknesses. 1053 
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 It does not include the lab infrastructure. It is assumed that devices are hardened. Testing these 1054 
devices would reveal only weaknesses in implementation that would not be relevant to those 1055 
adopting this reference architecture. 1056 

5.2 Scenarios and Findings 1057 

One aspect of our security evaluation involved assessing how well the reference design addresses the 1058 
security characteristics it was intended to support. The Cybersecurity Framework Subcategories were 1059 
used to provide structure to the security assessment by consulting the specific sections of each standard 1060 
cited in reference to a Subcategory. The cited sections provide validation points that the example 1061 
solution would be expected to exhibit. Using the Cybersecurity Framework Subcategories as a basis for 1062 
organizing our analysis allowed us to systematically consider how well the reference design supports the 1063 
intended security characteristics. 1064 

5.3 Analysis of the Reference Design’s Support for Cybersecurity 1065 

Framework Subcategories 1066 

Using the NIST Cybersecurity Framework Subcategories to organize our analysis also provided additional 1067 
confidence that the reference design addresses our use case security objectives. The remainder of this 1068 
subsection discusses how the reference design supports each of the identified Cybersecurity Framework 1069 
Subcategories [8]. 1070 

Table 3-5 lists the reference design functions and the security characteristics, along with products that 1071 
we used to instantiate each capability. The focus of the security evaluation is not on these specific 1072 
products but on the Cybersecurity Framework Subcategories. There may be other commercially 1073 
available products that meet the objectives found in the NIST Cybersecurity Framework. These other 1074 
products could be substituted to provided comparable security control within the reference design. 1075 

5.3.1 Asset Management (ID.AM) 1076 

For our project, we considered ID.AM-1, ID.AM-2, ID.AM-4, and ID.AM-5 to address asset management. 1077 

The project implemented ID.AM-1 using Virta Labs BlueFlow to address modality asset management. 1078 
Establishing an asset inventory is a fundamental component in determining appropriate controls for the 1079 
environment. The ID.AM-1 Subcategory specifies, “[p]hysical devices and systems within the 1080 
organization are inventoried,” and ID.AM-2 specifies, “[s]oftware platforms and applications within the 1081 
organization are inventoried.” For purposes of this document, the ID.AM-1 and ID.AM-2 Subcategories 1082 
are grouped together, and these Subcategories identify tools to achieve these objectives. Physical 1083 
devices include workstation, server, and storage components, whereas software assets include those 1084 
applications that run on the physical components. 1085 
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The project emulates HDOs in that HDOs often have separate biomedical engineering teams, distinct 1086 
from central IT operations. The implication is that IT general assets and medical devices may have 1087 
distinct asset tracking mechanisms. BlueFlow captures inventory, configuration, and patch management 1088 
information. 1089 

ID.AM-4 specifies, “[e]xternal information systems are catalogued.” Cloud services would be tracked by 1090 
the Clearwater Information Risk Management Analysis tool as part of the IT asset inventory. 1091 

Medical device asset tracking may be distinct from what is maintained in a general IT asset database. For 1092 
this project, the team maintained simulated medical imaging devices and implemented the Virta Labs 1093 
BlueFlow tool for asset tracking and configuration management. 1094 

ID.AM-5 specifies, “[r]esources (e.g., hardware, devices, data, time, personnel, and software) are 1095 
prioritized based on their classification, criticality, and business value.” To address ID.AM-5, this project 1096 
implemented solutions to identify communication and data flows between IT and biomedical 1097 
engineering assets. The project implemented the Zingbox IoT Guardian and Cisco Stealthwatch solution 1098 
to analyze NetFlow traffic across the laboratory infrastructure. In capturing NetFlow patterns, the 1099 
project provided two primary benefits: 1) a baseline of communication flows between medical imaging 1100 
devices, workstations, and PACS/VNA systems, and 2) an ability to determine when communication 1101 
patterns were anomalous. This latter point is described later in this document. 1102 

5.3.2 Risk Assessment (ID.RA) 1103 

This project selected ID.RA-1 and ID.RA-5 to address the Function known as Risk Assessment. ID.RA-1 1104 
specifies, “[a]sset vulnerabilities are identified and documented,” and ID.RA-5 specifies “[t]hreats, 1105 
vulnerabilities, likelihoods, and impacts are used to determine risk.” The project identified and deployed 1106 
tools to address these control requirements. 1107 

This project used Symantec’s Endpoint Protection solution to address threats to image viewer 1108 
workstations. The project used Tripwire Enterprise for server assets. Virta Labs BlueFlow was applied for 1109 
medical imaging devices. The project also used Zingbox IoT Guardian to perform NetFlow analysis. 1110 
Information from these tools can be used when needed to determine risk profile of the HDO 1111 
environment. 1112 

5.3.3 Identity Management and Access Control (PR.AC) 1113 

To implement identity management and access control, the project team focused on PR.AC-1, PR.AC-4, 1114 
and PR.AC-7 Subcategories. PR.AC-1 specifies, “[i]dentities and credentials are issued, managed, verified, 1115 
revoked, and audited for authorized devices, users and processes.” PR.AC-4 specifies, “[a]ccess 1116 
permissions and authorizations are managed, incorporating the principles of least privilege and 1117 
separation of duties.” PR-AC7 specifies, “[u]sers, devices, and other assets are authenticated 1118 
commensurate with the risk of the transaction.” 1119 
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5.3.3.1 Identity Management 1120 

Human user access to workstations and systems was provisioned by creating accounts in Microsoft 1121 
Active Directory. This project implemented the Symantec VIP. The Symantec VIP tool gave the project 1122 
multifactor authentication capability. Table 5-1 describes how different user types are managed and 1123 
describes some general characteristics of that user type. 1124 

Table 5-1 Identity Management Characteristics 1125 

User Type Identity Tool Characteristics 

Human Users Active Directory Active Directory Human user authentication 
method dependent on interaction 
type 

Medical Imaging 
Devices 

Host Identifier Tempered 
Networks IDN 

Imaging devices abstracted from 
the production network over a 
cloaked network implementing 
HIP. 

System to System Certificate DigiCert Managed 
PKI 

Automated interactions between 
systems authenticated 

 
Medical imaging devices are emulated in this project. They authenticate using HIP, implemented in 1126 
Tempered Networks’ microsegmentation capability. The Tempered Networks solution, IDN, uses the 1127 
HIP, which incorporates a key exchange capability between endpoint devices and gateways, or 1128 
HIPswitches. 1129 

The project included a document scan utility installed on a mobile device. To enable device 1130 
authentication in this case, the project used DigiCert Managed PKI, providing certificate-based 1131 
authentication. 1132 

The project augmented device authorization management by limiting PACS accessibility based on 1133 
workstation zone provisioning. Multifactor authentication was implemented for certain devices through 1134 
Symantec VIP. Network sessions were secured by TLS using DigiCert issued certificates [34]. 1135 

5.3.3.2 Access Control 1136 

To implement PR.AC-4, this project used role-based access control (RBAC) features built into the PACS 1137 
and VNA systems. Philips IntelliSpace and Hyland Acuo VNA implement RBAC, allowing least privilege 1138 
access enforcement. 1139 

This project also took advantage of the network zoning concept and limited access based on firewall 1140 
policies that restrict traffic between different zones. Image viewer workstation network traffic to the 1141 
PACS and VNA for image retrieval and interaction are limited to specified network zones. 1142 
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Administrative functions are restricted and are performed through TDi ConsoleWorks sessions that 1143 
enforce multifactor authentication. 1144 

The project implemented PR.AC-3 using TDi Technologies ConsoleWorks to provide remote access to the 1145 
lab network. The ConsoleWorks environment provided a solution for vendor remote access as well as 1146 
general user remote VPN, including access by third-party medical imaging services that may need access 1147 
to patient images [35]. 1148 

To implement PR.AC-5, the project made significant use of network segmentation through VLANs 1149 
implemented with Cisco Firepower NGFW and through microsegmentation implemented using 1150 
Tempered Networks IDN. IDN implements an SDN that this project uses to secure communications 1151 
between the simulated medical imaging devices and the PACS/VNA environment. 1152 

5.3.4 Data Security (PR.DS) 1153 

For this project, the team identified PR.DS-1, “[d]ata-at-rest is protected;” PR.DS-2, “[d]ata-in-transit is 1154 
protected;” PR.DS-6,“[i]ntegrity checking mechanisms are used to verify software, firmware, and 1155 
information integrity” Subcategories to address data security. 1156 

No specific solution was used for storage. This practice guide recommends HDOs to evaluate NIST SP 1157 
1800-11, Data Integrity: Recovering from Ransomware and Other Destructive Events [32], for general 1158 
guidance for at-rest protection. Further, the PACS and VNA solutions were implemented on a Windows 1159 
server environment, and therefore it is recommended to review and implement SMB Security Best 1160 
Practices [33], as noted by CISA. 1161 

Workstations in this project are protected using Symantec Encryption Platform. 1162 

Data in-transit protection is implemented using TLS and HIP. Image viewing workstations connecting to 1163 
the PACS/VNA environments use TLS encryption to ensure data-in-transit protection [28], [29], [34]. This 1164 
project also implements microsegmentation with Tempered Networks and ensures data-in-transit 1165 
protection by HIP-managed encryption between emulated medical imaging devices and the PACS/VNA 1166 
environment. 1167 

The project uses Tripwire Enterprise and Symantec DCS:SA to provide integrity monitoring of system 1168 
software files. Integrity of system and application software is monitored. 1169 

PR.DS-6 includes a control objective to additionally manage firmware; however, the lab used emulated 1170 
medical imaging devices for its modalities, operating as virtual machines. These emulated devices did 1171 
not include a firmware component. 1172 

5.3.5 Information Protection and Procedures (PR.IP) 1173 

This project selected PR.IP-1, PR.IP-3, and PR.IP-4 to implement the Information Protection and 1174 
Procedures Category. PR.IP-1 specifies, “[a] baseline configuration of information technology/industrial 1175 
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control systems is created and maintained incorporating security principles (e.g. concept of least 1176 
functionality).” PR.IP-3 specifies, “[c]onfiguration change control processes are in place;” and PR.IP-4 1177 
specifies, “[b]ackups of information are conducted, maintained, and tested.” 1178 

Servers supporting the PACS and VNA systems were built using guidance received from Philips and 1179 
Hyland respectively. These configurations were regarded as baseline configurations and determined to 1180 
be based on application functionality requirements. Tripwire Enterprise monitors modifications. 1181 

Virta Labs BlueFlow is used to manage medical imaging device configurations. The medical imaging 1182 
devices deployed in the lab were emulated and do not involve firmware. 1183 

5.3.6 Protective Technology (PR.PT) 1184 

To implement Protective Technology, this project selected PR.PT-1, PR.PT-3, and PR.PT-4. PR.PT-1 1185 
specifies, “[a]udit/log records are determined, documented, implemented, and reviewed in accordance 1186 
with policy.” PR.PT-3 specifies, “[t]he principle of least functionality is incorporated by configuring 1187 
systems to provide only essential capabilities;” and PR.PT-4 specifies, “[c]ommunications and control 1188 
networks are protected.” 1189 

To address PR.PT-1, the Hyland Acuo VNA, Hyland NilRead Enterprise, Hyland PACSgear, Phillips 1190 
Enterprise Imaging IntelliSpace PACS, and Phillips Enterprise Imaging Universal Data Manager 1191 
components provided the capability to create audit log records. 1192 

Another method this project implemented to ensure traffic was regularly reviewed was implementing 1193 
the Zingbox IoT Guardian solution. The tool aggregated NetFlow traffic across the lab environment and 1194 
performed behavioral analytics. HDOs should also consider using a security incident event management 1195 
(SIEM) system that would aggregate logs from different operating systems, applications, and component 1196 
types. SIEM tools often can support scripts that may trigger alerting to incident response teams. 1197 

To address PR.PT-3, this project implemented operating systems that were configured with the 1198 
minimum functionality necessary to support PACS and VNA operations, based on guidance from Hyland 1199 
and Philips respectively. Configuration recommendations from our vendor partners were treated as 1200 
baseline settings. The project then used Tripwire Enterprise to monitor this baseline. 1201 

This project implements PR.PT-4 through constructing network zones with VLANs and use of the 1202 
Tempered Networks microsegmentation solution. VLANs were used to establish a base set of network 1203 
zones, and the Tempered Networks IDN created a means to control network traffic between the 1204 
simulated medical imaging devices and the PACS/VNA leveraging the HIP, which protects data on 1205 
networks via data encryption. 1206 

The project used the Cisco Firepower NGFW to protect the infrastructure from malicious activity. 1207 
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External connections were protected using TLS and internet protocol security (IPsec) tunneling where 1208 
appropriate [34], [35]. 1209 

5.3.7 Anomalies and Events (DE.AE ) and Security Continuous Monitoring (DE.CM) 1210 

This project grouped together the Functions DE.AE Anomalies and Events and DE.CM Security 1211 
Continuous Monitoring. The project then selected DE.AE-1, DE.AE-2, DE.AE-3, DE.AE-5, DE.CM-1, DE.CM-1212 
3, and DE.CM-7 to address these control areas. 1213 

Selected controls for DE.AE Anomalies and Events include DE.AE-1: “[a] baseline of network operations 1214 
and expected data flows for users and systems is established and managed”; DE.AE-2: “[d]etected 1215 
events are analyzed to understand attack targets and methods”; DE.AE-3: “[e]vent data are collected 1216 
and correlated from multiple sources and sensors”; and DE.AE-5: “[i]ncident alert thresholds are 1217 
established.” This project implemented Zingbox IoT Guardian and Cisco Stealthwatch to achieve these 1218 
objectives through implementing behavioral analytics. Zingbox was configured for continuous 1219 
monitoring by directing NetFlow traffic to its cloud-hosted backend where it performed analysis. 1220 
Stealthwatch was configured for monitoring and analysis on premises. 1221 

DE.CM-1 specifies, “[t]he network is monitored to detect potential cybersecurity events”; DE.CM-3: 1222 
“[p]ersonnel activity is monitored to detect potential cybersecurity events”; and DE.CM-7: “[m]onitoring 1223 
for unauthorized personnel, connections, devices, and software is performed.” The project addresses 1224 
DE.CM-1 through the Zingbox and Stealthwatch implementations. The solutions perform network 1225 
monitoring and cybersecurity event detection by analyzing NetFlow traffic. Additional network 1226 
monitoring is performed through the Cisco Firepower Next Generation Firewall deployment. 1227 

DE.CM-4 specifies, “[m]alicious code is detected”; and DE.CM-7 specifies, “[m]onitoring for 1228 
unauthorized personnel, connection, devices, and software is performed.” This project implemented 1229 
Symantec Endpoint Protection to address DE.CM-4 and DE.CM-7. The Cisco Firepower Next Generation 1230 
Firewall was used to implement intrusion prevention. Symantec Endpoint Protection was deployed on 1231 
workstations, including image viewer workstations. 1232 

5.4 Security Analysis Summary 1233 

Our reference design’s implementation of security surrounding the PACS/VNA ecosystem helps reduce 1234 
risk from the PACS/VNA system, even if a vulnerability is identified in a PACS or VNA system, by creating 1235 
a more secure environment for the medical devices. The key feature is the multi-layered security 1236 
capabilities defined in Section 4.1.3. Supporting those security capabilities, our project build follows 1237 
vendor recommended practices to harden devices and systems; monitor traffic; limit access to only 1238 
authorized users, devices, and systems; and ensure the data security across the ecosystem. Any 1239 
organization following this guide must conduct its own analysis of how to employ the elements 1240 
discussed here, in their own environment. It is essential that organizations follow security best practices 1241 
to address potential vulnerabilities and to minimize any risk to the operational network. 1242 
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6 Functional Evaluation 1243 

We conducted a functional evaluation of our example implementation to verify that several common 1244 
provisioning functions used in our laboratory test worked as expected. We also needed to ensure the 1245 
example solution would not alter normal PACS and VNA functions.  1246 

In developing a test plan, this project identified implemented cybersecurity controls and identified a 1247 
method to demonstrate control functionality. Also, this project identified five IHE use case scenarios 1248 
where multiple cybersecurity controls were implemented to augment business process functionality. 1249 
The identified scenarios found in Section 3.4.3 served as the basis of a functional test plan to 1250 
demonstrate overall security control efficacy. 1251 

Section 6.1 describes the format and components of the functional test cases. Each functional test case 1252 
is designed to assess the security capabilities of the example implementation, to perform the functions 1253 
listed in Section 4.1.3. 1254 

6.1 PACS Functional Test Plan 1255 

Each test case consists of multiple fields that collectively identify the goal of the test, the specifics 1256 
required to implement the test, and how to assess the results of the test. Table 6-1 describes each field 1257 
in the test case. 1258 

Table 6-1 Test Case Fields 1259 

Test Case Field Description 
Parent Requirement Identifies the top-level requirement or the series of top-level 

requirements leading to the testable requirement 
Testable Requirement Drives the definition of the remainder of the test case fields and 

specifies the capability to be evaluated 
Associated Cybersecurity 
Framework 
Subcategories 

Lists the NIST Cybersecurity Framework Subcategories addressed by 
the test case 

Description Describes the objective of the test case 
Associated Test Cases In some instances, a test case may be based on the outcome of 

another test case(s). For example, analysis-based test cases 
produce a result that is verifiable through various means (e.g., log 
entries, reports, and alerts). 

Preconditions The starting state of the test case. Preconditions indicate various 
starting state items, such as a specific capability configuration 
required or specific protocol and content. 

Procedure The step-by-step actions required to implement the test case. A 
procedure may consist of a single sequence of steps or multiple 
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Test Case Field Description 
sequences of steps (with delineation) to indicate variations in the 
test procedure. 

Expected Results The expected results for each variation in the test procedure 
Actual Results The observed results 

6.1.1 PACS Functional Evaluation Requirements 1260 

Table 6-2 identifies the PACS functional evaluation requirements addressed in the test plan and 1261 
associated test cases. The evaluations are aligned with the basic architecture design and capability 1262 
requirements from Section 4, Architecture.  1263 

Table 6-2 Functional Evaluation Requirements 1264 

Capability  
Requirement 
(CR) ID 

Parent Requirement Subrequirement  Test Case 

CR-1 Business workflows that 
support image acquisition and 
transfer to archival (e.g., PACS 
and VNA) are performed.  

Simple Radiology Practice 
Workflows 

PACS-1 

CR-2 Asset and Inventory 
Management 

 PACS-2 

CR-3 Enterprise Domain and Identity 
Management–Access Control 

  

CR-3.a  Privileged Access 
Management 

PACS-3 
PACS-10 

CR-3.b  User Authentication PACS-3 
PACS-4 
PACS-5 
PACS-10 

CR-3.c  Device and System 
Authentication 

PACS-3 
PACS-4 
PACS-5 

CR-3.d  Data Access Control PACS-3 
PACS-5 

CR-4 Network Control and Security   
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Capability  
Requirement 
(CR) ID 

Parent Requirement Subrequirement  Test Case 

CR-4.a  Network Segmentation and 
VLANs 

PACS-7 

CR-4.b  Firewall and Control 
Policies 

PACS-7 

CR-4.c  Microsegmentation PACS-4 

CR-4.d  Anomalies and Events 
Detection (Behavioral 
Analytics) 

PACS-8 

CR-4.e  Intrusion Detection and 
Prevention 

PACS-9 

CR-5 Endpoint Protection and 
Security  

  

CR-5.a  Device Hardening and 
Configuration 

PACS-9 

CR-5.b  Malware Detection and 
Prevention 

PACS-9 

CR-6 Data Security   

 
CR-6.a 

 In-Transit Encryption PACS-4 
PACS-5 

CR-7 Remote Access Remote Access PACS-10 

6.1.2 Test Case: PACS-1 1265 

Parent Requirement (CR-1) Business workflows that support image acquisition and 
transfer to archival (e.g., PACS and VNA) are performed. 

Testable Requirement (CR-1) Simple Radiology Practice Workflows 

Description 
Demonstrate that the installed PACS system can be used to acquire 
images from a simulated modality, store those images based on 
department, and view those images by using a DICOM viewer. 

Associated Test Case N/A 

Associated Cybersecurity 
Framework Subcategories 

N/A 
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Preconditions 

 Implement PACS architecture and test that network connections 
are operational. 

 Configure DICOM communication between DVTk RIS Emulator 
and DVTk Modality Emulator. 

 Load patient studies into the RIS. 
 Configure DICOM communication between DVTk Modality 

Emulator and PACS.  
 Configure the DICOM viewer to connect to the PACS archiving 

system.  
 Provision and give proper permissions to user accounts. 

Procedure 

1. Start the DVTk RIS simulator. 
2. Start the Modality Emulator. 
3. Click the Request Worklist button on the Modality to display 

the RIS’ preinstalled patient studies. 
4. Select one of the Patient Names from the given list. 
5. Click the enabled Store Image button to send the images for 

the selected patient to the connected PACS server.  
6. To verify the archived images stored in the Philips PACS server, 

run Explorer as a Manager.  
7. Log in to the client web by using the URL 

https://192.168.140.131/clientweb. (Alternatively, use a thin 
client “Philips IntelliSpace PACS Enterprise” to verify the 
archived images.) 

8. From the Folder List > Exam Lookup press Search button to list 
the patient studies. The image for the patient selected in this 
test should be listed in the exam lookup view table.  

Expected Results 

 The user should be able to display the image by using the Philips 
Client Web or the Philips PACS Enterprise client. 

Note: If you need to repeat the same procedure using the same 
samples, clear the stored image from the Philips PACS. The cleared 
image stored in the Default folder will be moved to the Exceptions 
Lookup folder. Clear the image from the Exceptions Lookup folder 
as well.  

Actual Results 
The implemented PACS environment successfully scheduled images 
by using the RIS, sent and stored the images in the PACS using the 
Modality, and viewed the stored images using a web client. 
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6.1.3 Test Case: PACS-2 1266 

Parent Requirement (CR-2) Asset and Inventory Management 

Testable Requirement (CR-2) Asset and Inventory Management 

Description Demonstrate how to identify and manage medical assets 

Associated Test Case N/A 

Associated Cybersecurity 
Framework Subcategories 

ID.AM-1, ID.AM-2, ID.AM-4, ID.AM-5, ID.RA-1, ID.RA-5, PR.IP-1 

Preconditions 

 PACS network infrastructure is operational. 
 Virta Labs BlueFlow is deployed in the Security Services VLAN. 
 Network groups are created in the BlueFlow interface to allow 

automatic organization of discovered devices. 

Procedure 

1. Open a web browser and navigate to the Virta Labs BlueFlow 
web portal URL and authenticate to the portal. 

2. Navigate to Connectors > Discovery. 
3. Enter a subnet range (192.168.0.0/16) from which BlueFlow 

will discover devices. 
4. Click Run and allow the discovery process to populate a 

network group. 
5. Navigate to Inventory. Under Networks, click on a network 

object and display a list of discovered devices. 
6. Click on a device name and navigate to the Tools tab and click 

on Fingerprint. 
7. Verify the populated information and click Run to perform a 

scan. 
8. Once the scan is complete, navigate back to the device’s 

information page and verify that the fingerprint tool has 
accurately identified information about the device such as 
Operating System and Open TCP Ports. 

9. Manually fill in other information about the device if needed. 

Expected Results 

 Devices are discovered within the specified subnets and appear 
as devices in the network group. 

 The fingerprint tool identifies device Operating System and open 
TCP ports. 

 Device information can be modified manually. 
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Actual Results 

20+ new devices were discovered within the PACS VLANs. These 
new devices were automatically placed into predefined network 
segments, and devices that did not fit into a predefined network 
segment were placed into an Other Assets category. The fingerprint 
tool populated descriptive information for several discovered 
devices while all other necessary information was filled in manually. 

6.1.4 Test Case: PACS-3 1267 

Parent Requirement (CR-3) Enterprise Domain and Identity Management–Access 
Control 

Testable Requirement 
(CR-3.a) Privileged Access Management, (CR-3.b) User 
Authentication, (CR-3.c) Device and System Authentication, (CR-3.d) 
Data Access Control  

Description Demonstrate the capability authentication to PACS application by 
using enterprise Active Directory 

Associated Test Case N/A 

Associated Cybersecurity 
Framework Subcategories 

PR.AC-1, PR.AC-4, PR.AC-7 

Preconditions 

 Domain controller has been deployed and configured in the 
Enterprise Services VLAN. 

 Philips PACS has been configured to incorporate the enterprise 
AD with a display name of AD PACS. 

 Domain groups have been created and assigned proper policies 
and roles. 

 A test user with username pacs-user has been set up in the test 
AD PACS. 

Procedure 

1. Launch the IntelliSpace PACS application on the IntelliSpace 
PACS Enterprise server. 

2. To set the authentication source, select AD PACS from the Log 
on to dropdown list.  

3. Enter the username and password, and then click on the login 
button to login.  

Expected Results  Authentication via AD PACS is successful. 
 Access to patient data is based on group policy settings. 

Actual Results 

A user, pacs-user, who is in the Active Directory, was used to test 
the access setup. After entering the username and the correct 
password to the Philips IntelliSpace PACS Enterprise login page by 
using the AD PACS as the authentication source, the login was 
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successful. The pacs-user account was validated to assure that 
appropriate access control settings were applied. 
 
Pacs-user authentication was further tested, first by entering an 
incorrect password and next by incorrectly spelling the username. 
These attempts failed. 

6.1.5 Test Case: PACS-4 1268 

Parent Requirement 
(CR-4) Network Control and Security 
(CR-6) Data Security 

Testable Requirement (CR-4.c) Microsegmentation, (CR-6.a) In-Transit Encryption 

Description Demonstrate secure transfer of medical images from modalities to 
archive systems by using microsegmentation. 

Associated Test Case PACS-3 

Associated Cybersecurity 
Framework Subcategories 

PR.DS-2, PR.PT-1, PR.PT-3, PR.PT-4 

Preconditions 

 Deploy and configure microsegmentation into the network 
infrastructure. 

 Install, configure, and deploy modalities.  
 Configure network connections between RIS and modalities to 

establish a DICOM connection.  
 Configure network connections between modalities and PACS to 

establish a DICOM connection. 
 Populate RIS with simulated patient studies. 
 Install and configure a network traffic analyzer. 

Procedure 

To schedule Radiology patient studies with the DVTk Modality 
Emulator  
1. Launch the RIS Emulator desktop application and click the Start 

button to open a DICOM connection with the Modality 
Emulator  

2. Using the Modality Emulator, click the Request Worklist button 
to display a list of requested patient studies being sent from the 
RIS. 

3. Select a requested patient study from the list to send to Philips 
PACS server. 
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To store patient studies on the Philips PACS server by using DVTk 
Modality Emulator 
1. Click the Store Images button to send the selected patient 

study to Philips PACS. 
To verify that data are encrypted between the modality and PACS  
1. Start a packet capture with Cisco Firepower between the 

HIPswitches associated with the modality and PACS 
respectively. A new window will appear with attribute text 
boxes. For the Source Host, provide the IP address of the 
modality’s HIPswitch. For the Destination Host, provide the IP 
address of the PACS HIPswitch. 

2. Export the produced packet captures to a packet capture 
(PCAP) file. 

3. Import the PCAP file into Wireshark, and try to read the data 
captured. 

Expected Results 

 RIS establishes a DICOM connection with the modality to 
schedule patient studies. 

 DICOM communications channel established between modalities 
and PACS. 

 Modality Emulator can send patient studies to PACS. 
 In-transit data are encrypted.  

Actual Results 

The RIS, Modality, and PACS succeeded in establishing DICOM 
connections after microsegmentation was implemented. Data being 
transferred from Modality to PACS was encrypted through the 
secured connection.  

6.1.6 Test Case: PACS-5 1269 

Parent Requirement 
(CR-3) Enterprise Domain and Identity Management–Access 
Control 
(CR-6) Data Security 

Testable Requirement 
(CR-3.b) User Authentication, (CR-3.c) Device and System 
Authentication, (CR-3.d) Data Access Control, (CR-6.a) In-Transit 
Encryption 

Description 

Show how clinical departments have access to only their 
department’s medical images, and show that an encrypted 
connection is used when clinical departments are accessing medical 
images. 
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Associated Test Case PACS-3 

Associated Cybersecurity 
Framework Subcategories 

PR.AC-1, PR.AC-4, PR.AC-7, PR.DS-2, PR.PT-1, PR.PT-3, PR.PT-4 

Preconditions 

 Define different clinical departments (e.g., Radiology, 
Cardiology, and Dermatology). 

 Create role-based access control by assigning user accounts to 
clinical departments. 

 Configure and enable TLS connections on PACS and VNA. 
 Patient records for multiple departments are stored on the 

VNA. 

Procedure 

To transfer patient studies from Philips PACS server to the 
Radiology user group on the Hyland VNA server  
1. Log in to the Philips PACS to view stored patient records. 
2. Select a patient study to send to Hyland VNA to be stored in the 

Radiology department. 
3. Export the selected patient study to the Radiology department 

on the Hyland VNA. 
To confirm that Hyland VNA user accounts can access only 
approved departments  
1. Log in to the Hyland VNA by using credentials with access to the 

Radiology department’s patient records. 
2. Verify that the patient study sent in the steps above is shown. 
To evaluate TLS connection from Philips PACS to Hyland VNA 
1. Start a packet capture on Cisco Firepower on the PACS-A 

interface. A new window will appear with attribute text boxes. 
For the Source Host, provide the IP address of the PACS. For the 
Destination Host, provide the IP address of the VNA. 

2. Export the produced packet captures to a PCAP file. 
3. Import the PCAP file into Wireshark, and try to read the data 

captured. 

Expected Results 

 The PACS transfers patient studies to a specific department 
group on an archiving system 

 User accounts on the archiving system are restricted to view 
records to assigned department 

 Data transfers from the PACS to the VNA are encrypted through 
TLS communication 

Actual Results PACS was able to securely transfer patient studies by using TLS 
encryption to the Radiology group on the archiving system. User 
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accounts with access to view Radiology patient studies were able to 
access only studies linked to the Radiology department. 

6.1.7 Test Case: PACS-6 1270 

Parent Requirement 
(CR-3) Enterprise Domain and Identity Management–Access 
Control 
(CR-6) Data Security 

Testable Requirement (CR-3.b) User Authentication, (CR-3.c) Device and System 
Authentication, (CR-6.a) In-Transit Encryption 

Description Show how to securely review archived medical images. 

Associated Test Case PACS-3 

Associated Cybersecurity 
Framework Subcategories 

PR.AC-1, PR.AC-4, PR.AC-7, PR.DS-2, PR.PT-1, PR.PT-3, PR.PT-4  

Preconditions 

 Enable https connections on a web server and outside web 
browser 

 Configure DICOM image web viewer to connect to outside web 
browser 

 Define different clinical departments (e.g., Radiology, 
Cardiology, and Dermatology), and create user accounts to 
correspond to clinicians who may work in those departments 

 Create role-based access-control by assigning user accounts to 
clinical departments 

Procedure 

To authenticate as a Radiology user and securely view patient 
studies for Radiology department on the VNA 
1. Access Hyland NilRead on a web browser by using https 

(https://<ip address of NilRead Viewer>). 
2. Log in to the viewer as a Radiology user. 
3. Click on the patient study record stored from Test Case 4, and 

verify that the viewer is using https when displaying patient 
images. 

To evaluate encrypted data transfers from Hyland VNA to Hyland 
NilRead Viewer  
1. Start a packet capture on Cisco Firepower on the Clinical 

Viewers interface. A new window will appear with attribute text 
boxes. For the Source Host, provide the IP address of the web 
viewer. For the Destination Host, provide the IP address of the 
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client computer accessing the PACS viewer through a web 
browser. 

2. Export the produced packet captures to a PCAP file. 
3. Import the PCAP file into Wireshark, and try to read the data 

captured. 

Expected Results 

 DICOM image web viewer should be accessible and display 
patient images using https. 

 Data sent from an archiving server to the DICOM image web 
viewer should be encrypted. 

Actual Results Web viewer securely connected to the archiving server and 
transmitted patient images to a client computer over https. 

6.1.8 Test Case: PACS-7 1271 

Parent Requirement (CR-4) Network Control and Security 

Testable Requirement (CR-4.a) Network Segmentation and VLANs, (CR-4.b) Firewall, and 
Control Policies  

Description Demonstrate network segmentation and routing between VLANs 
within the PACS architecture by restricting guest network access  

Associated Test Case N/A 

Associated Cybersecurity 
Framework Subcategories 

PR.AC-5, PR.PT-1, PR.PT-3, PR.PT-4 

Preconditions 

 Domain controller is deployed and configured in the Enterprise 
Services VLAN. 

 Windows computer is deployed to the guest network. 
 Cisco Firepower Threat Defense interfaces are configured. 
 Cisco Firepower access control policy, with a default action of 

Block All Traffic, is created and applied to the Cisco Firepower 
Threat Defense Appliance. 

 Cisco Firepower access control policy is configured with the 
following access control rules: 

• Allow DHCP traffic from Guest network to Domain 
Controller. 

• Allow DNS traffic from Guest network to Domain 
Controller. 

• Allow http and https traffic from Guest network to 
wide area network (WAN) interface. 

 DHCP relay is configured on the Guest network interface 
through Firepower Management Center. 
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Procedure 

To test that DHCP services are available for Guest network  
1. Power on Windows computer on the Guest network and log in. 
2. Right-click on Windows Start button and select Network 

Connections. 
3. Right-click on the network interface connected to the Guest 

network and select Properties. 
4. Click on Internet Protocol Version 4 (TCP/IPv4) and click 

Properties and select Obtain an IP address automatically, then 
click OK. 

5. Run the Command Prompt from the Windows Start button.  
6. At the command line type ipconfig /all 
7. Ensure DHCP Enabled is set to Yes. 
8. Ensure IPv4 Address, Subnet Mask, Default Gateway, and 

DHCP Server are populated according to your DHCP settings. 
To test that DNS services are available for Guest network 
1. Right-click on Windows Start button and select Network 

Connections. 
2. Right-click on the network interface connected to the Guest 

network and select Properties. 
3. Click on Internet Protocol Version 4 (TCP/IPv4) and click 

Properties. Select Obtain DNS server address automatically 
and click OK. 

4. Run the Command Prompt from the Windows Start button.  
5. At the command line type ipconfig /all 
6. Ensure DNS Servers is populated according to your DHCP 

settings. 
7. At the command line type nslookup 
8. Verify that the Default Address and Address are populated 

with the correct DNS server. 
9. At the prompt, type a URL (nist.gov) and ensure an IP address 

(129.6.13.49) is returned by the DNS server. 
To test that traffic from Guest network to internal VLANs is blocked 
1. Open a web browser from the Windows computer connected 

to the Guest network. 
2. Type an IP address (192.168.140.131) that corresponds to a 

PACS web server from one of the internal PACS VLANs into the 
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address bar. The web browser should not be able to retrieve 
the web page. 

3. Right-click on Windows Start button and select Command 
Prompt. At the command line, attempt to ping the VNA server 
from one of the internal PACS VLANs by typing ping 
192.168.130.120 

4. Ensure command prompt returns Request timed out and no 
packets are received. 

To test that only web traffic from Guest network to the WAN is 
allowed  
1. Open a web browser from the Windows computer connected 

to the Guest network. 
2. Type a URL (https://www.nist.gov/) into the address bar. 
3. Wait for website to load properly. 
4. Right-click on Windows Start button and select Command 

Prompt. 
5. At the command line, attempt to ping an external web server 

by typing ping nist.gov 
6. Ensure command prompt returns Request timed out and no 

packets are received. 

Expected Results 

 Computers with interfaces connected to Guest network will 
automatically be provisioned an IPv4 address. 

 Computers with interfaces connected to the Guest network will 
automatically be provisioned a DNS server address. 

 All traffic, excluding the exceptions for DNS and DHCP, 
originating from the Guest network and destined for any 
internal PACS VLAN will be blocked. 

 http and https traffic originating from the Guest network and 
destined for the WAN interface will be allowed. 

Actual Results 

Upon booting up for the first time, the Windows computer on the 
Guest network was allocated an IPv4 address within the DHCP 
scope address pool and provisioned a DNS server address and was 
successfully able to resolve the IP address of a provided URL. The 
computer was not able to communicate with other devices in the 
internal PACS VLANs (192.168.140.131 and 192.168.130.120) using 
different network protocols (https and internet control message 
protocol [ICMP]) but was able to communicate with external web 
servers through a web browser using http and https. 

https://www.nist.gov/
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6.1.9 Test Case: PACS-8 1272 

Parent Requirement (CR-4) Network Control and Security 

Testable Requirement (CR-4.d) Anomalies and Events Detection (Behavioral Analytics) 

Description Demonstrate capability to detect abnormal network traffic across 
the PACS architecture. 

Associated Test Case PACS-7 

Associated Cybersecurity 
Framework Subcategories 

DE.AE-1, DE.AE-2, DE.AE-3, DE.AE-5, DE.CM-1, DE.CM-3, and 
DE.CM-7 

Preconditions 

 PACS architecture is implemented and network connections have 
been tested and are operational. 

 Zingbox Inspector is deployed and configured in the Security 
Services VLAN. 

 Virta Labs BlueFlow is deployed and configured in the Security 
Services VLAN. 

Procedure 

1. Open a web browser and navigate to the web portal of Virta 
Labs BlueFlow. 

2. Enter credentials and log in. 
3. Navigate to Connectors > Discovery. 
4. Enter a subnet range (192.168.0.0/16) on which BlueFlow will 

run an IP scan.  
5. Click Run and wait for discovery process to finish. 
6. Open a web browser and navigate to the web portal of Zingbox 

Cloud. 
7. Enter credentials and log in. 
8. Navigate to Alerts > Security Alerts. 
9. Under Alerts, look for an alert named Suspicious internal IP 

scans and an alert type of scanner. 
10. Expand the alert, hover over a subsection, and click on View 

Details. 
11. On the Alert Details page, verify that the client IP that the IP 

scans originated from corresponds to the BlueFlow device. 

Expected Results  Zingbox correctly identifies BlueFlow’s IP scan and creates a 
security alert for suspicious activity.  

Actual Results 
Zingbox identified BlueFlow’s IP scan as suspicious activity and 
created a security alert. Zingbox also created a security alert the 
second time a BlueFlow IP scan was run but stopped creating alerts 
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for subsequent IP scans from the BlueFlow device. While the 
BlueFlow scan was approved and not malicious, this type of 
scanning can be performed by malicious devices attempting to 
discover devices on the network. 

6.1.10  Test Case: PACS-9 1273 

Parent Requirement 
(CR-4) Network Control and Security 
(CR-5) Endpoint Protection and Security 

Testable Requirement 
(CR-4.e) Intrusion Detection and Prevention, (CR-5.a) Device 
Hardening and Configuration, (CR-5.b) Malware Detection and 
Prevention 

Description 
Demonstrate capability to detect threats affecting PACS servers and 
related endpoints. This test also demonstrates an intrusion 
detection capability. 

Associated Test Case N/A 

Associated Cybersecurity 
Framework Subcategories 

DE.CM-1, DE.CM-4, PR.PT-1, PR.PT-3, PR.PT-4 

Preconditions 

 PACS architecture is implemented and network connections 
have been tested and are operational. 

 Symantec Endpoint Protection appliance is deployed and 
configured in the Security Services VLAN. 

 Symantec Endpoint Protection agent is installed on an 
endpoint. 

 The endpoint agent is connected to the Symantec Endpoint 
Protection Manager. 

Procedure 

To verify that the endpoint agent is connected to the SEP 
management server  
1. Log in to the SEP management console 

(https://192.168.190.172:8443/console/apps/sepm), click 
Clients, and select the target group (e.g., PACS). 

2. Click the Client tab in the PACS group to list the client 
information in a table. 

3. The endpoint is listed under the Name column with a Health 
State of online 

4. To verify that the endpoint receives the current policy updates 
5. Navigate to the Client tab in the SEP management console. 
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6. The policy serial number should match the serial number of the 
endpoint found at Help > Troubleshooting in the endpoint 
agent. 

To verify that the proper protections are enforced on the endpoint 
1. Navigate to the Client tab in the SEP management console. 
2. In the PACS group, change the drop-down list selection to 

Protection Technology and review the protection categories 
status (enabled or disabled). 

To add a System Lockdown policy to prevent unwanted applications 
from running  
1. Enable the System Lockdown policy from the parent group of 

PACS. 
2. Select the Blacklist Mode, add a test application (e.g., 

7zFM.exe) to the list, and save the policy.  
3. From the endpoint, click on the Symantec shield icon and click 

Update Policy. 
To verify that the virus and spyware protection policy works  
1. Use a browser on the endpoint to download an antivirus test 

file from the EICAR website (https://www.eicar.org/). 
2. Click the image labeled DOWNLOAD ANTI MALWARE TESTFILE. 
3. Click the eicar.com link under Download area using the secure, 

SSL enabled protocol https. 
4. A Symantec notification will appear, informing you that a risk is 

found. 

Expected Results 
 Files added to the Blacklist are not allowed to be run. 
 Linking to the test virus file will lead to a warning, and the 

threat should be locked. 

Actual Results 

Prior to the lockdown policy enforcement, the 7zFM.exe file and 
7zFM file manager console were able to run on the endpoint. After 
the lockdown policy enforcement, the 7zFM.exe file was not able to 
run, and a warning message appeared stating, “Windows cannot 
access the specified device, path, or file. You may not have the 
appropriate permissions to access the item.”  
 
When accessing the malware test file, the following message 
appeared: “Symantec Endpoint Protection [SID:24461] Diagnostic: 
EICAR Standard Anti-Virus Test File detected, Symantec Service 
Framework.” 

https://www.eicar.org/
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6.1.11  Test Case: PACS-10 1274 

Parent Requirement 
(CR-3) Enterprise Domain and Identity Management–Access 
Control 
(CR-7) Remote Access 

Testable Requirement (CR-3.a) Privileged Access Management, (CR-3.b) User 
Authentication  

Description Demonstrate capability to provide controlled remote access to 
PACS systems using the two-factor authentication. 

Associated Test Case PACS-3 

Associated Cybersecurity 
Framework Subcategories 

PR.AC-3 

Preconditions 

 TDi Technology ConsoleWorks is installed and configured to use 
Active Directory for username and password authentication. 

 Proper access control rules, tags, and profiles are defined to 
allow access to necessary resources. 

 User accounts for remote access are set up and linked to 
profiles set for each remote user who needs to access the PACS 
servers. 

 Symantec VIP Enterprise Gateway is installed and integrated 
with ConsoleWorks by using the RADIUS connection. 

 To supplement standard username/password logins on a 
variety of servers and services, the VIP Access smartphone 
application is installed, and a credential ID has been acquired 
from Symantec for receiving time sensitive tokens. 

 Test user credentials are registered in the VIP manager and 
associated to the account. 

Procedure 

To verify that username/password are not sufficient to log in  
1. Use a web browser to connect to the TDi console 

(https://192.168.1.4:5176) and log in with username/password. 
2. Verify that the login is unsuccessful. 
To verify the two-factor authentication using username/password 
with a VIP token 
1. Use a browser to connect to the TDi console: 

(https://192.168.1.4:5176). 
2. Open the VIP Access smartphone application. It should display a 

security code with a valid time duration. 
3. Log in to the TDi console with username/password followed by 

the VIP security token found in the smartphone application. 
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To verify that the user can access only the granted resources 
1. Select the Graphical menu to open a Graphical View. 
2. Check the list of graphical connections to ensure that only 

allowed connections are visible. 
3. Check each of the graphical connections by clicking on Connect 

and verifying that the console properly connects. 

Expected Results 

 Logging in to the TDi console with a valid username/password 
without a 2FA token should fail with the message “Invalid User 
Credentials.”  

 Logging in to the TDi console with a valid username/password 
with valid 2FA token should be successful. 

 Authenticated user should have access to list of approved 
graphical connections and should be able to connect to these 
servers. 

Actual Results 

Using a pre-created Hyland user as an example, the first attempt to 
log in to the TDi console with only a username and password failed. 
The second attempt to log in, this time with a 2FA token, was 
successful. From the dashboard, the Graphical View menu was 
opened, and only approved graphical connections were visible to 
the Hyland user (e.g., Hyland VNA, Hyland Database). The user was 
able to connect to these remote servers and authenticate with a 
Hyland service account.  

7 Future Build Considerations 1275 

During this project and development of this practice guide, we did not implement several components; 1276 
however, these omitted components should be considered. We did not implement an EHR system, and 1277 
we used simulated medical imaging devices rather than physically deploying them. 1278 

Another topic that this practice guide does not implement is the storage tier. An approach to address 1279 
storage is to examine cloud solutions. Medical images require robust storage media scalability and 1280 
protection, including data encryption, key management, access control, detection when data are 1281 
accessed or transported, and recoverability. As HDOs consider using cloud storage providers, 1282 
organizations need to consider several factors to ensure appropriate information safeguards. Addressing 1283 
cloud storage for healthcare has data security implications that exceed safeguarding medical images. An 1284 
update to this practice guide will better address cyber risks associated with cloud storage solutions.1285 
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Appendix A List of Acronyms 
 

2FA Two-Factor Authentication 

AES Advanced Encryption Standard 

ARP Address Resolution Protocol 

AV Anti-Virus 

CDA Clinical Document Architecture 

CIA Confidentiality, Integrity, and Availability 

CIS Clinical Information System 

CISA Cyber Infrastructure Security Agency 

CPOE Computerized Physician Order Entry 

CT  Computed Tomography 

DICOM Digital Imaging and Communications in Medicine 

DNS Domain Name Service 

DoS  Denial of Service  

EHR Electronic Health Record 

FDA Food and Drug Administration 

FIM File Integrity Monitoring 

FMC Firepower Management Center 

FTD Firepower Threat Defense 

GRC Governance, Risk, and Compliance 

IETF Internet Engineering Task Force 

HDO Healthcare Delivery Organization 

HIP Host Identity Protocol 

HIPPA Health Insurance Portability and Accountability Act 

HIPS Host Intrusion Prevention System 
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HIS Health Information System 

HL7 Health Level 7 

HTM Healthcare Technology Management 
 
 
 
  

http Hypertext Transfer Protocol 

https Hyper Text Transfer Protocol Secure 

IDN Identity Defined Networking 

IEC International Electrotechnical Commission 

IDS Intrusion Detection System 

IHE Integrating Health Enterprise 

IoT  Internet of Things  

IPSec Internet Protocol Security 

IT Information Technology 

MAC Media Access Control 

MRI Magnetic Resonance Imaging 

NCCoE National Cybersecurity Center of Excellence 

NGFW Next Generation Firewall 

NIST National Institute of Standards and Technology 

PACS Picture Archiving and Communication System 

PAM Privileged Access Management 

PCAP Packet Capture 

PET Positron Emission Tomography  

PHI Protected Health Information 

PKI Public Key Infrastructure 

RBAC Role Based Access Control 

RFC Request for Comments 

RIS Radiology Information System 
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RMF Risk Management Framework 

SAN Storage Area Network 

SDN Software Defined Networking 

SHA Secure Hash Algorithm 

SMB Server Message Block 

SP Special Publication 

SSE Systems Security Engineering 

SSL/TLS Secure Socket Layer/Transport Layer Security 

TCP/IP Transmission Control Protocol/Internet Protocol 

URL Uniform Resource Locator 

VIP Validation and ID Protection 

VLAN Virtual Local Area Network 

VNA Vendor Neutral Archive 

VPN Virtual Private Network 
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Appendix C Pervasive Versus Contextual Controls 
This practice guide limits its scope to a defined boundary regarding the scheduling, acquisition, use, and 
storage of medical imaging and associated information for those images. Conceptually, this is bound in a 
medical imaging ecosystem and applies contextual controls to that ecosystem. Healthcare delivery 
organization (HDO) environments, however, feature greater complexity than this practice guide may 
address. That is, the medical imaging ecosystem resides within an enterprise infrastructure that should 
implement a pervasive set of controls. The project assumes that an HDO implements pervasive controls 
that may have material impact on mitigating the HDO’s overall cybersecurity risk profile but are not 
implemented in the lab build. Pervasive controls may be inherited by systems that operate within the 
HDO infrastructure, but coverage may not be absolute. As such, contextual controls may be 
implemented to address gaps or to augment pervasive control capabilities. Pervasive controls tend to be 
organizational in scope, although they may also apply to specific systems and network components 
within the organization. Pervasive controls may be technical or procedural in nature. The pervasive 
control concept is borrowed from auditing frameworks that discuss the use of entity controls that have 
varying degrees of effects that are pervasive or have a widespread effect across an entity or 
organization [36]. 

Understanding the pervasive control concept can be done through an analogy. An individual may live in 
a house or apartment, which exists in a neighborhood. That neighborhood may then be part of a town 
or a city. The town or city may include a number of services, such as police, fire, and rescue. Utilities, 
such as water or electricity, may be provided to the community through the town or city or through a 
third-party rendering service. Pervasive controls are those that, while available to the house or 
apartment, are not implemented by the occupant. The house or apartment may have locks, alarms, or 
fire suppressant devices that the occupant installed or has direct control over. Those controls are 
contextual to the house or apartment. In this analogy, the medical imaging ecosystem is the house that 
resides in an HDO town or city. 

Pervasive control examples within HDOs include governance, risk, and compliance (GRC) systems that 
address a diverse range of functions needed to operate a cybersecurity strategy, including performance 
and management of enterprise risk, tracking information technology (IT) assets, incident response 
processes, IT disaster recovery and business continuity, and data loss prevention (DLP), which would be 
used to prevent data exfiltration by using tools that are outside the picture archiving and 
communication system (PACS) and medical imaging ecosystem. This project implemented contextual 
controls pertinent to the medical imaging ecosystem and assumes implementation of pervasive controls 
across the enterprise. For purposes of this project, pervasive controls that we feel are material but are 
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not implemented in the medical imaging ecosystem context pertinent to the immediate control 
environment of the laboratory’s PACS environment are noted in Table C-1 below. 

Table C-1 Pervasive Security Controls 

Cybersecurity 
Framework 
Subcategory 

Description Potential Implementation 

ID.AM-1, ID.AM-2 ID.AM-1: Physical 
devices and systems 
within the organization 
are inventoried.  
ID.AM-2: Software 
platforms and 
applications within the 
organization are 
inventoried.  

GRC suite that includes an asset 
management module. A potential 
tool that may address may be 
Clearwater Compliance IRM 
Analysis tool. 
The application of such tools 
would address IT general assets 
such as servers, workstations, and 
other components that may 
interact with the PACS 
environment but do not fall 
within the control environment 
established for this project. 
IT general assets may be managed 
by a centralized IT organization 
that is not directly involved in 
supporting or maintaining the 
PACS environment or medical 
imaging devices. 

ID.RA-4 , ID.RA-6 
 

ID.RA-4: Potential 
business impacts and 
likelihoods are 
identified. 
ID-RA6: Risk responses 
are identified and 
periodized. 

These two controls address 
enterprise risk management. 
ID.RA-4 may be addressed 
through implementing business 
impact assessments or enterprise 
risk assessments. 
ID.RA-6 considers the case where 
enterprise risk has been identified 
or where the HDO has 
determined that existing controls 
need to be enhanced or added. 
Those determinations are often 
documented in a Plan of Action 
and Milestones that describes 
tasks needing to be addressed, 
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Cybersecurity 
Framework 
Subcategory 

Description Potential Implementation 

resources required, and milestone 
dates for realization of tasks. 
Typical control implementation to 
address ID.RA-4 and ID.RA-6 
would include a GRC suite with an 
enterprise risk management 
module. 
The Clearwater Compliance IRM 
Analysis tool may be relevant as 
well. 

PR.AC-2   PR.AC-2: Physical 
access to assets is 
managed and 
protected. 

Server assets may be hosted in a 
data center with appropriate 
physical security and 
environmental controls. 

PR.DS-5 PR.DS-5: Protections 
against data leaks are 
implemented. 
 

This control addresses the 
possibility of data exfiltration and 
may consider options wherein 
clinical or other sensitive data are 
migrated outside the HDO 
perimeter by using email or web 
services. 
Typical controls to be deployed at 
the internet border may include  
DLP tools. An example tool may 
be the Symantec DLP solution. 

PR.IP-6 PR.IP-6: Data is 
destroyed according to 
policy. 
 

This control addresses the need 
to destroy data as appropriate 
should that data reach end of life. 
PACS and VNA control 
mechanisms would address 
objects within their purview, but 
HDOs should look at pervasive 
mechanisms to address when 
data may reside on workstations, 
endpoint devices, or removable 
media. In addressing appropriate 
data destruction measures, HDOs 
should consult National Institute 
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Cybersecurity 
Framework 
Subcategory 

Description Potential Implementation 

of Standards and Technology 
Special Publication 800-88 rev. 1, 
Guidelines for Media Sanitation. 

PR.IP-9 
PR.IP-10 

PR.IP-9: Response plans 
(Incident Response and 
Business Continuity) 
and recovery plans 
(Incident Recovery and 
Disaster Recovery) are 
in place and managed.  
PR.IP-10: Response and 
recovery plans are 
tested.  
 
 

These controls pertain to 
enterprise response and recovery 
planning, including disaster 
recovery, and assurance that the 
plans are regularly tested. 
 
Incident response planning may 
be addressed in several different 
ways that include establishing an 
incident response team, capturing 
data regarding reported or 
detected security events, and 
remediation. Inclusive of 
establishing incident response 
procedures, organizations may 
consider developing “play books” 
that could consist of established 
procedures based on determining 
certain threat types that may 
require courses of action different 
from standard incident handling. 
 
Recovery plans, which may 
consist of business continuity 
plans, and disaster recovery plans 
should be established. 
Organizations may consider 
maintaining these plans, including 
establishing “play books,” as 
maintained out of band, e.g., in 
physical format or in mechanisms 
that provide assurance that the 
plans themselves are inaccessible 
in case of a security event. 
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Cybersecurity 
Framework 
Subcategory 

Description Potential Implementation 

Management of such plans may 
be maintained in GRC suites that 
include modules designed to 
house such plans and establish 
regular testing schedules. 

RS.RP-1 Response plan is 
executed during or 
after an event. 

Response plans may be managed 
through a GRC solution. Physical 
copies of response plans should 
be maintained to allow for 
potential system outages. 

RC.RP-1 Recovery plan is 
executed during or 
after a cybersecurity 
incident. 

Recovery plans may be managed 
through a GRC solution. Physical 
copies of recovery plans should 
be maintained to allow for 
potential system outages. 
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Appendix D Aligning Controls Based on Threats 
C/I/A Threat Event National Institute of Standards and Technology 

Cybersecurity Framework Mitigating Control 

C Abuse of credentials or 
insider threat 

PROTECT (PR) 
Access Control 
User Identification and Authentication 
  
DETECT (DE) 
Anomalies and Events Detection 
Security Continuous Monitoring 

C Credential compromise PROTECT (PR) 
Access Control 
User Identification and Authentication 
  
DETECT (DE) 
Anomalies and Events Detection 
Security Continuous Monitoring 

C Data exfiltration PROTECT (PR) 
Data Security and Privacy 
Information Protection Processes and Procedures 
Protective Technology 
 
DETECT (DE) 
Anomalies and Events Detection 
Security Continuous Monitoring 

I Data in-transit disruption PROTECT (PR) 
Data Security and Privacy 
Communications and Network Security 
 
DETECT (DE) 
Anomalies and Events Detection 
Security Continuous Monitoring 

I Data alteration PROTECT (PR) 
Access Control 
Data Security and Privacy 
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C/I/A Threat Event National Institute of Standards and Technology 
Cybersecurity Framework Mitigating Control 
DETECT (DE) 
Anomalies and Events Detection 
Security Continuous Monitoring 

I Time synchronization PROTECT (PR) 
Data Security and Privacy 
Maintenance 
Communications and Network Security 
 
DETECT (DE) 
Anomalies and Events Detection 
Security Continuous Monitoring 

I Introduction of malicious 
software 

PROTECT (PR) 
Protective Technology 
 
DETECT (DE) 
Anomalies and Events Detection 
Security Continuous Monitoring 

I Unintended use of service IDENTIFY (ID) 
ID.AM-2: Software platforms and applications within 
the organization are inventoried. 
 
PROTECT (PR) 
PR.PT-3: The principle of least functionality is 
incorporated by configuring systems to provide only 
essential capabilities. 
 
DETECT (DE) 
Security Continuous Monitoring 
 

A Data storage disruption IDENTIFY (ID) 
ID.BE-5: Resilience requirements to support delivery 
of critical services are established for all operating 
states (e.g., under duress/attack, during recovery, 
during normal operations). 
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C/I/A Threat Event National Institute of Standards and Technology 
Cybersecurity Framework Mitigating Control 
PROTECT (PR) 
Data Security and Privacy 
Information Protection Processes and Procedures 
Communications and Network Security 
PR.PT-5: Mechanisms (e.g., failsafe, load balancing, 
hot swap) are implemented to achieve resilience 
requirements in normal and adverse situations. 

A Network disruption PROTECT (PR) 
Data Security and Privacy 
Communications and Network Security 
 
DETECT (DE) 
Anomalies and Events Detection 
Security Continuous Monitoring 

A Backup/recovery disruption PROTECT (PR) 
Information Protection Processes and Procedures 
 
RECOVER (RC) 
Recovery and Restoration 

A Supply chain compromise IDENTIFY (ID) 
ID.SC-5: Response and recovery planning and testing 
are conducted with suppliers and third-party 
providers. 
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intended to imply that the entities, equipment, products, or materials are necessarily the best available 
for the purpose. 
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FEEDBACK 
You can improve this guide by contributing feedback. As you review and adopt this solution for your 
own organization, we ask you and your colleagues to share your experience and advice with us.  

Comments on this publication may be submitted to: hit_nccoe@nist.gov. 

Public comment period: September 16, 2019 through November 18, 2019 

As a private-public partnership, we are always seeking feedback on our practice guides. We are 
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you 
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All comments are subject to release under the Freedom of Information Act. 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 1 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 2 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 3 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 4 
public-private partnership enables the creation of practical cybersecurity solutions for specific 5 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 6 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 7 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 8 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 9 
solutions using commercially available technology. The NCCoE documents these example solutions in 10 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 11 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 12 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 13 
Maryland. 14 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 15 
https://www.nist.gov. 16 

NIST CYBERSECURITY PRACTICE GUIDES 17 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 18 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 19 
adoption of standards-based approaches to cybersecurity. They show members of the information 20 
security community how to implement example solutions that help them align more easily with relevant 21 
standards and best practices, and provide users with the materials lists, configuration files, and other 22 
information they need to implement a similar approach. 23 

The documents in this series describe example implementations of cybersecurity practices that 24 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 25 
or mandatory practices, nor do they carry statutory authority.  26 

ABSTRACT 27 

Medical imaging plays an important role in diagnosing and treating patients. The system that manages 28 
medical images is known as the picture archiving communication system (PACS) and is nearly ubiquitous 29 
in healthcare environments. PACS is defined by the Food and Drug Administration (FDA) as a Class II 30 
device that “provides one or more capabilities relating to the acceptance, transfer, display, storage, and 31 
digital processing of medical images.” PACS centralizes functions surrounding medical imaging 32 
workflows and serves as an authoritative repository of medical image information.  33 
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PACS fits within a highly complex healthcare delivery organization (HDO) environment that involves 34 
interfacing with a range of interconnected systems. PACS may connect with clinical information systems 35 
and medical devices and may involve engaging with health professionals who may be both internal and 36 
external to the HDO. This complexity may introduce or expose opportunities that allow malicious actors 37 
to compromise the confidentiality, integrity, and availability of the PACS ecosystem. 38 

The NCCoE at NIST analyzed risk factors regarding the PACS ecosystem by using a risk assessment based 39 
on the NIST Risk Management Framework, and the NCCoE leveraged the NIST Cybersecurity Framework 40 
and other relevant standards to identify measures to safeguard the ecosystem. The NCCoE developed an 41 
example implementation that demonstrates how HDOs can use standards-based, commercially available 42 
cybersecurity technologies to better protect the PACS ecosystem. This practice guide will help HDOs 43 
implement current cybersecurity standards and best practices, to reduce their cybersecurity risk while 44 
maintaining the performance and usability of PACS. 45 

KEYWORDS 46 

Access control; auditing; authentication; authorization; behavioral analytics; DICOM; encryption 47 
microsegmentation; multifactor authentication; PACS; picture archiving and communication system; 48 
PAM; privileged account management; vendor neutral archive; VNA. 49 
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1 Introduction 107 

The following volumes of this guide show information technology (IT) professionals and security 108 
engineers how we implemented this example solution. We cover all of the products employed in this 109 
reference design. We do not recreate the product manufacturers’ documentation, which is presumed to 110 
be widely available. Rather, these volumes show how we incorporated the products together in our 111 
environment. 112 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 113 
for these products that are out of scope for this reference design. 114 

1.1 Practice Guide Structure 115 

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a 116 
standards-based reference design and provides users with the information they need to replicate all or 117 
parts of the example implementation that was built in the National Cybersecurity Center of Excellence 118 
(NCCoE) lab. This reference design is modular and can be deployed in whole or in part. 119 

This guide contains three volumes: 120 

NIST SP 1800-24A: Executive Summary 121 

NIST SP 1800-24B: Approach, Architecture, and Security Characteristics – what we built and why 122 

NIST SP 1800-24C: How-To Guides – instructions for building the example solution (you are here) 123 

Depending on your role in your organization, you might use this guide in different ways: 124 

Business decision makers, including chief security and technology officers, will be interested in the 125 
Executive Summary, NIST SP 1800-24A, which describes the following topics: 126 

challenges that enterprises face in securing the picture archiving and communication system (PACS) 127 

example solution built at the NCCoE 128 

benefits of adopting the example solution 129 

Technology or security program managers who are concerned with how to identify, understand, assess, 130 
and mitigate risk will be interested in NIST SP 1800-24B, which describes what we did and why. The 131 
following sections will be of particular interest: 132 

Section 3.4, Risk Assessment, describes the risk analysis we performed. 133 

Section 3.5, Security Control Map, maps the security characteristics of this example solution to 134 
cybersecurity standards and best practices. 135 
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You might share the Executive Summary, NIST SP 1800-24A, with your leadership team members to help 136 
them understand the importance of adopting standards-based, commercially available technologies that 137 
can help secure the PACS ecosystem. 138 

IT professionals who want to implement an approach like this will find this whole practice guide useful. 139 
You can use this How-To portion of the guide, NIST SP 1800-24C, to replicate all or parts of the build 140 
created in our lab. This How-To portion of the guide provides specific product installation, configuration, 141 
and integration instructions for implementing the example solution. We do not recreate the product 142 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 143 
incorporated the products together in our environment to create an example solution. 144 

This guide assumes that IT professionals have experience implementing security products within the 145 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 146 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 147 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 148 
parts of PACS security solution. Your organization’s security experts should identify the products that 149 
will best integrate with your existing tools and IT system infrastructure. We hope that you will seek 150 
products that are congruent with applicable standards and best practices. Section 3.6, Technologies, lists 151 
the products that we used and maps them to the cybersecurity controls provided by this reference 152 
solution. 153 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 154 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 155 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 156 
hit_nccoe@nist.gov. 157 

Acronyms used in figures can be found in Appendix A. 158 

1.2 Build Overview 159 

The NCCoE built a hybrid virtual-physical laboratory environment to explore methods to effectively 160 
demonstrate the capabilities in securing the PACS ecosystem. While the project implemented PACS and 161 
vendor neutral archive (VNA) solutions, as well as implemented security controls, the environment 162 
leverages modality emulation to simulate medical image acquisition. The project also implemented an 163 
emulated radiology information system (RIS), used to generate modality work lists and therefore 164 
support common medical imaging workflows. The project then applied security controls to the lab 165 
environment. Refer to NIST SP 1800-24B, Approach, Architecture, and Security Characteristics, for an 166 
explanation of why we used each technology. 167 

mailto:hit_nccoe@nist.gov
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1.3 Typographic Conventions 168 

The following table presents typographic conventions used in this volume. 169 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

https://www.nccoe.nist.gov/
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1.4 Logical Architecture Summary 170 

Figure 1-1 depicts a reference network architecture, introduced in NIST SP 1800-24B, Section 4.2, Final 171 
Architecture, which performs groupings that would translate to network segments or zones. The 172 
rationale behind segmentation and zoning is to limit trust between areas of the network. In considering 173 
a hospital infrastructure, the NCCoE identified devices and usage and grouped them by usage. The 174 
grouping facilitated identification of network zones. Once zones are defined, infrastructure components 175 
may be configured so that those zones do not inherently have network access to other zones within the 176 
hospital network infrastructure. Segmenting the network in this fashion limits the overall attack surface 177 
posed to the PACS environment and considers the network infrastructure configuration as part of an 178 
overall defense-in-depth strategy.  179 

Figure 1-1 PACS Final Architecture 180 

 

2 Product Installation Guides 181 

This section of the practice guide contains detailed instructions for installing and configuring the 182 
products that the NCCoE used to build an instance of the example solution. 183 

The project implemented security capabilities across the laboratory infrastructure, to safeguard the 184 
emulated modalities, emulated RIS, viewer workstations, and PACS and VNA systems. Security control 185 
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products that align with capabilities were implemented for the environment. Products that align with 186 
the security capabilities are enumerated in NIST 1800-24B, Section 3.6, Technologies, Table 3-5. 187 

2.1 Picture Archiving and Communication System (PACS) 188 

This project implemented two separate PACS: Philips IntelliSpace solution and an open source PACS 189 
(DCM4CHEE). These PACS systems are used to emulate the case where healthcare delivery organizations 190 
(HDOs) may have different PACS vendors installed in their environment.  191 

2.1.1 Philips IntelliSpace PACS 192 

The project implements the Philips IntelliSpace PACS solution as a central component to the lab build. 193 
IntelliSpace includes several common features, such as the ability to integrate digital imaging and 194 
communication in medicine (DICOM) and non-DICOM images and provides the project team the ability 195 
to emulate common medical imaging workflow processes. The project deploys an IntelliSpace instance 196 
to receive images from an open source modality emulator tool, which allows the project to simulate 197 
working HDO environments. The project integrates IntelliSpace with the Hyland VNA solution also 198 
installed in the lab. 199 

System Requirements 200 

Philips IntelliSpace system consists of several components installed on different VMware virtual 201 
machines (VMs). Base configuration requirements to construct the IntelliSpace VMs are depicted in 202 
Table 2-1. 203 

Table 2-1 Base VM Configuration Requirements 204 

VM Name  Description  Central 
Processing 
Unit (CPU) 

Memory Storage Operating 
System 

Software 

DC1 Domain 
Controller 

4 8 gigabytes 
(GB) of 
random 
access 
memory 
(RAM) 

200 GB Microsoft 
Windows 
Server 
2012 

Microsoft 
Structured Query 
Language (SQL) 
2012, Internet 
Information 
Services (IIS) 7 

IntelliSpace 
Server 

Infrastructure, 
Integration, 
Rhapsody 
Health Level 7 
(HL7), DICOM 
processor, 
SQL Database 

4 8 GB RAM 200 GB Microsoft 
Windows 
Server 
2012 

Microsoft SQL 
2012, IIS 7 
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VM Name  Description  Central 
Processing 
Unit (CPU) 

Memory Storage Operating 
System 

Software 

(DB), 
Anywhere 
Viewer (web 
client) 

UDM  Universal Data 
Manager 
(UDM), WEB 
DICOM 
services 
Image 
Lifecycle 
Management 
Image pre 
fetching from 
VNA 

4 8 GB RAM 200 GB Microsoft 
Windows 
Server 
2012 

Microsoft SQL 
2012, IIS 7 

 

IntelliSpace PACS Client Installation 205 

The project team collaborated with a team of Philips Healthcare deployment engineers to install the 206 
environment. Based on the base VM configuration requirements, the NCCoE team created the VMs by 207 
using the open virtualization format (OVF) files provided by Philips Healthcare. Philips engineers 208 
deployed the applications on the VMs and created instances for DC1, IntelliSpace server, and UDM, as 209 
noted in Table 2-1. VM instances were deployed on respective servers. 210 

IntelliSpace PACS is a web-based distributed system. Clinicians, referring physicians, nurses, or 211 
bioengineers use web-based client application on workstations to view, analyze, and qualify medical 212 
images. Once the server components were installed, the web-based client installation was performed 213 
using the following procedures: 214 

1. Open Internet Explorer from a workstation and assign the IntelliSpace server with the internet 215 
protocol (IP) address 192.168.140.131. Enter the IntelliSpace server (IP) address in the address bar 216 
by using the following URL: https://192.168.140.131/clientweb/installers. 217 

2. Select InstelliSpacePACSEnterpriseSetup.exe under the Standalone Installers bullet list of available 218 
IntelliSpace PACS Installers screen to start the installation. 219 
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 220 

3. An option to choose setup language appears. Select the English (United States) from the pull-down 221 
and click OK. 222 

 223 

4. After the setup language has been set, the InstallShield Wizard begins the installation process. 224 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 8 

 225 

5. Use the default setting for the Custom Setup and click on the Next > button that appears at the 226 
bottom of this window. 227 

 228 

6. On the Client Configuration Info window, enter 192.168.140.131 as the Server IP address, and click 229 
Install. 230 
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 231 

7. When installation is finished, the InstallShield Wizard provides a message indicating successful 232 
installation. Click Finish. 233 

 234 

8. Once the installation is done, the installer places an IntelliSpace PACS Enterprise icon on the 235 
desktop. Type Tester in the User Name field and the corresponding password in the Password 236 
field, then click OK to log in. 237 
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 238 

9. When the program launches, the default page launches the Patient Lookup screen. 239 

 240 

10. To view an exam, navigate to Exam Lookup, which lists a summary of a patient’s exams. Double-241 
click an exam in the list. If the exam has an image, it will be displayed. An example is shown below. 242 
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 243 

IntelliSpace PACS Client Configuration 244 

Deployment and configuration were accomplished by Philips Deployment Engineers using PowerCLI and 245 
scripts. Other basic configurations can be implemented through the administration web page provided 246 
by the IntelliSpace PACS by using the URL https://192.168.140.131/PACSAdministration.  247 

1. Enter the admin as the User Name, enter the proper Password, select AD PACS from the Logon to 248 
drop-down list, select Password from the Logon Mode, then click OK. 249 

 250 
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2. On the admin home page, add a new user by navigating to Security, found on the far-left column of 251 
the Common Tasks screen. Click on Users and then click on Add a New User. 252 

 253 

3. To add a new user, navigate to SECURITY, found on the far-left column of the Common Tasks 254 
screen, and click on Users. 255 

a. Enter the User ID. 256 

b. Enter the user’s First Name. 257 

c. Enter the user’s Middle Name (optional). 258 

d. Enter the user’s Last Name. 259 

e. Enter the user’s Email Address (optional). 260 

f. Assign an IntelliSpace PACS AdminTool Password for the user (required). Enter the password 261 
again to confirm it. 262 

Configure Sources for User Authentication 263 

IntelliSpace supports either a locally hosted or an external authentication source. An authentication 264 
source provides a directory structure that authenticates and manages user and group accounts. The 265 
internal authentication source, called iSite, implements a local database of users and groups. 266 
IntelliSpace also supports a lightweight directory access protocol (LDAP) server connected to a Microsoft 267 
active directory (AD). The External User Authentication is used as the configuration source. The 268 
following steps describe how to create an LDAP authentication source: 269 

1. From the navigation bar, select the Security button and then click Authorities. 270 
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 271 

2. Click New to open the External Authentication Source wizard. 272 

 273 

3. On the External Authentication source page, set the following values and then click Next. 274 

 Set Authority Name to AD.PACS.HCLAB 275 

 Set the Display Name to AD PACS 276 

 Select HostName for Name Resolution 277 

 Check the box next to Enabled 278 
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 Check the box next to Show in Login Screen 279 

 280 

4. In the Advanced Directory Configuration, set DNS Host Name as ad.pacs.hclab and Port as 389. 281 

 282 

5. Navigate to the Edit External Authentication Source screen. In this project, the Directory Type is 283 
ActiveDirectory and the Supported Credentials is Password. Click Save to save the settings. 284 
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 285 

6. The interface provides a test feature to allow engineers to determine connectivity with the external 286 
authentication source. From the navigation bar, select the Security > Authorities. Click on the 287 
name of the External Authentication Source, and click Test. 288 

 289 

Configure Connection to Modality Emulator 290 

The open source DVTk Modality Emulator was used as a modality for testing the communication 291 
between IntelliSpace PACS and a modality. The installation of the DVTk Modality Emulator can be found 292 
in Section 2.4.1. Below are the configuration steps: 293 
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1. From the DVTk Modality application, click the Configure Emulator tab to set up a proper System 294 
Name, e.g., Modality; an application entity title (AE Title), e.g., DVTK_MODALITY; and a 295 
communication Listening Port, e.g., 104 for the emulator itself. 296 

 297 

2. From the DVTk Modality application, click the Remote Systems tab to configure the remote 298 
systems, including RIS System, MPPS Manager, and PACS/Workstation Systems. Information for 299 
each system’s IP address as well as the port number are needed. Particularly, the AE Title for the 300 
Philips IntelliSpace PACS is required for the AE Title field. These are the input values: 301 

RIS System 302 

 IP Address: 192.168.160.201 303 

 Remote Port: 105 304 

 AE Title: DVTK_RIS 305 

MPPS Manager 306 

 IP Address: 192.168.160.201 307 

 Remote Port: 108 308 

 AE Title: DVTK_MPPS 309 

PACS/Workstation Systems–Storage Config 310 

 IP Address: 192.168.140.131 311 
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 Remote Port: 104 312 

 AE Title: STENTOR_SCP 313 

PACS/Workstation Systems–Storage Commit Config 314 

 IP Address: 192.168.140.131 315 

 Remote Port: 104 316 

 AE Title: STENTOR_SCU 317 

 318 

3. To configure the Philips IntelliSpace PACS AE Title and communication port, log on to the iSite 319 
Administration web site using the URL https://192.168.140.131/ iSiteWeb. Select Configure > 320 
DICOM > General, set the following values, and then click Save to save the settings. 321 

 Normal AE Title: STENTOR_SCP 322 

 High-Priority AE Title: STENTOR_HI 323 

 Port: 104 324 

 Secure Port: 2762 325 
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 326 

4. To test the connectivity, go to the DVTk Emulator application, then go to the Modality Emulator 327 
home page as shown below. Click the Ping PACS/Workstation and DICOM Echo buttons to verify 328 
the success of the pings. You should receive Ping Successful and DICOM Echo Successful messages. 329 

 330 

Configure IntelliSpace PACS to Communicate with Hyland VNA  331 

Refer to Section 2.2.2 for detailed installation guidance for Hyland VNA. 332 

1. Obtain the Hyland VNA AE Title and port information for communication. Log in to the iSite 333 
Administration page by using the URL https://192.168.140.131/iSiteWeb 334 
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2. From the Configure drop-down list, select DICOM to open the DICOM configuration page. 335 

3. Fill in the known Hyland AE Title (e.g., RADIOLOGY), IP Address (e.g., 192.168.130.120), Port (e.g., 336 
114), and other necessary information.  337 

 338 

4. Log in to the IntelliSpace PACS Administration page using 339 
https://192.168.140.131/PACSAdministration. 340 

5. Click the Configuration button on the left panel to configure the Auto Export Rule. 341 

6. Click the New button to create a new rule named ForwardHylandVNA. 342 

 343 

7. Set the Trip Type as New Data Arrival. 344 
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8. Set the Receiving AE Title as Stentor_SCP, which is the AE Title for Philips IntelliSpace PACS. 345 

9. Choose Hyland VNA (RADIOLOGY) from the Selected Destination box. 346 

  347 

2.1.2 DCM4CHEE 348 

DCM4CHEE is a collection of open source applications that communicate with each other using DICOM 349 
and HL7 standards for clinical-image management and archiving. In this study, DCM4CHEE has JBoss and 350 
a web-based graphical user interface (GUI) application built in. JBoss is used to configure DCM4CHEE to 351 
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communicate with DVTk’s Modality Emulator to store images in a PostgreSQL database. The JBoss web 352 
interface allows an administrator to configure DCM4CHEE to listen for connection requests from specific 353 
application entities like DVTk’s Modality Emulator. DCM4CHEE also has web-based GUI that displays 354 
patient records sent from the Modality Emulator and stored in the PostgreSQL database.  355 

A 32-bit version of Java JDK6 [1], JBoss v4.2.3 [2], and PostgreSQL database v 9.4.23 [3], [4] were 356 
installed as the prerequisites for the DCM4CHEE. Refer to each installation guide for the installation 357 
procedures. 358 

System Requirements 359 

CPU: 4 360 

Memory: 512 megabyte (MB) RAM 361 

Storage: 200 MB 362 

Operating System: Microsoft Windows Server 2016 Datacenter 363 

Network Adapter: Virtual Local Area Network (VLAN) 1402 364 

DCM4CHEE Installation 365 

The installation guide can be found at [5].  366 

1. Go to https://www.dcm4che.org to download the software. 367 

2. In the left-hand side of the page, click the Wiki link under Community. 368 

3. Click the here link under Download Latest Version nest to dcm4chee DICOM Archive 2 (includes 369 
dcm4che toolkit 1.4) [6] link on the right-hand side of the screen. 370 

4. On the new web page, click 2.17.1 to download that version of DCM4CHEE. 371 

DCM4CHEE Audit Report Repository Installation 372 

Download the file relevant to PostgreSQL from the SourceForge site [7]. Once downloaded, go to the 373 
dcm4chee-2.17.1-psql\bin directory by using a command prompt, and execute this command: 374 
Install_arr.bat <path to the audit report file>. 375 

Test the DCM4CHEE Installation 376 

1. Go to dcm4chee-2.17.1-psql\bin directory by using a command prompt and run this command: 377 
Run.bat. 378 

2. Successful run will produce this output: 379 

https://www.dcm4che.org/
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 380 

DCM4CHEE Configuration Using the JMX Console 381 

1. Access the JMX Console GUI by navigating to http://localhost:8080/jmx-console/ and providing the 382 
following credentials: 383 

 Username: admin 384 

 Password: ***** 385 

2. Click the link group=ONLINE_STORAGE,service=FileSystemMgt under the dcmrchee.archive 386 
heading. 387 

 388 

3. Click the Invoke button under the addRWFileSystem() section to instantiate where archived data 389 
should be stored. If no specific file path is provided as a parameter, the default location is 390 
dcm4chee-2.7.1-psql\server\default\archive. 391 

 392 

4. Change the default AE Title: 393 
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 The default AE Title is DCM4CHEE. 394 

 Change the title by clicking the service=AE link under dcm4chee.archive heading. 395 

 396 

5. Under the updateAETitle section, provide the default AETitle and new AETitle as parameters, and 397 
click the Invoke button on the bottom left-hand side of the table. 398 

 399 

6. You can also change the port number that DCM4CHEE uses. Default port numbers are 104 and 400 
11112. Port 11112 was used for communicating with DVTk Modality Emulator. 401 

 402 

DVTk Modality to DCM4CHEE Configuration  403 

1. Open a web browser to access http://localhost:8080/dcm4chee-web3/ and provide the following 404 
credentials: 405 

 Username: admin 406 

 Password: ***** 407 

 408 
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2. Click the Application Entities tab in the ribbon on the top of the screen. 409 

 410 

3. Click the New AET button in the left-hand side of the AEs page and provide the following 411 
information:  412 

 Title: PACS 413 

 Type: - 414 

 Hostname: 192.168.141.206 415 

 Port: 11112 416 

 User Id: Admin 417 

 Password: ***** 418 

4. Click the Save button at the bottom center of the screen. 419 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 25 

  420 

View Stored Data 421 

1. Click the Folder tab located on the top ribbon of the page on the left-hand side of the screen. 422 

2. Click the Search button on the right-hand side of the screen above the buttons Delete, Move, and 423 
Export. 424 

3. No parameters are needed if you want to see all documents stored. 425 

 426 
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DCM4CHEE to DVTk Modality Configuration 427 

1. In the Modality Emulator, click the Configure Remote Systems tab at the top of the window. 428 
2. Navigate to the PACS/Workstation Systems section and input the information with the following 429 

values: 430 

RIS System 431 

 IP Address: 192.168.160.201 432 

 Remote Port: 105 433 

 AE Title: RIS 434 

MPPS Manager 435 

 IP Address: 192.168.160.201 436 

 Remote Port: 106 437 

 AE Title: MPPS 438 

PACS/Workstation Systems–Storage Config 439 

 IP Address: 192.168.141.206 440 

 Remote Port: 11112 441 

 AE Title: PACS 442 

PACS/Workstation Systems–Storage Commit Config 443 

 IP Address: 192.168.141.206 444 

 Remote Port: 11112 445 

 AE Title: PACS 446 
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 447 

Oviyam Installation 448 

Once downloaded from the SourceForge [8] and unzipped, copy the oviyam.war file to the following 449 
directory: dcm4chee-2.7.1\server\default\deploy. Check if you successfully installed the software by 450 
visiting http://dcm4chee_ip:8080/oviyam2 and accessing a log in screen. 451 

Oviyam Configuration 452 

1. Using a browser, navigate to http://dcm4chee_ip:8080/oviyam2 and provide the following 453 
credentials: 454 

 Username: admin 455 

 Password: ***** 456 

 457 
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2. Navigate to the top right corner of the screen, click admin, and then click Settings. 458 

 459 

3. Under the Server tab, click Add. 460 

 461 

4. Fill in the PACS server parameters and click the Save button located to the far right of the 462 
parameters. 463 

 Description: PACS 464 

 AE Title: DCM4CHEE 465 

 Host Name: localhost 466 

 Port: 11112 467 

 Retrieve Type: WADO 468 

 WADO Context: wado 469 

 WADO Port: 8080 470 

 Image Type: JPEG 471 

 472 

5. Return to http://dcm4chee_ip:8080/oviyam2 to see query parameters now available. 473 

6. Click the Search button under the parameters on the right-hand side of the screen. 474 
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 475 

7. Double-click on a patient record. 476 

 477 

8. View images related to that patient record. 478 

 479 

2.2 VNA 480 

Hyland Acuo VNA features several different systems and applications, which include: 481 

Acuo VNA: core application server with services used to store, track, and retrieve digital assets stored in 482 
an archive 483 

PACSgear Core Server: image processing and routing server, and back-end services 484 

PACS Scan Mobile/Web: mobile device image acquisition and file-import application  485 

NilRead: enterprise image-viewing application 486 
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The diagram depicted in Figure 2-1 shows the connectivity between the Hyland Acuo VNA systems and 487 
applications. 488 

Figure 2-1 Hyland Systems and Applications Connectivity 489 

 490 

Installation procedures for the above Hyland products are described in the sections that follow. 491 

2.2.1 Hyland Database Server 492 

Hyland Database Server supports operations for other Hyland products, including Hyland Acuo VNA and 493 
Hyland NilRead. The installation and configuration procedures can be found below: 494 

System Requirements 495 

CPU: 4 496 

Memory: 12 GB RAM 497 

Storage: 498 

 Hard Drive (HD)1: 80 GB (Operating System Install) 499 

 HD 2: 20 GB (DB Drives) 500 

 HD 3: 10 GB (Tx Logs) 501 

Operating System: Microsoft Windows Server 2016 502 

Network Adapter: VLAN 1801 503 

Hyland Database Server Installation 504 
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Install the SQL Server 2017 according to the instructions detailed in Install SQL Server from the 505 
Installation Wizard (Setup) [9]. 506 

Hyland Database Configuration 507 

1. The installation creates default service accounts for each service. The project maintained use of 508 
these default service accounts. User and privileged log in accounts were created for the Hyland 509 
application suite and linked to unique Microsoft domain users. The project created the 510 
PACS\AcuoServiceUser and PACS\Administrator accounts. 511 

2. The project implemented Windows Authentication Mode for the SQL Server. 512 

3. Application database instances were created as needed automatically when product applications 513 
were installed. 514 

4. This project implemented the following database instances through the SQL Server Management 515 
Studio: AcuoMed, HUBDB, NILDB, and PGCORE. 516 

5. The project also implemented instances for OPHTHALMOLOGY, RADIOLOGY, and WOUND_CARE. 517 

2.2.2 Hyland Acuo VNA 518 

Hyland Acuo VNA provides access to medical images and documents through interactions with a variety 519 
of different PACS, modalities, and image viewers. Acuo VNA also supports various standards, including 520 
HL7 and DICOM. The installation and configuration procedures can be found below. 521 

System Requirements 522 

CPU: 6 523 

Memory: 12 GB RAM 524 

Storage: 525 

 HD 1: 80 GB (OS Install) 526 

 HD 2: 80 GB (Dilib Cache Drive) 527 

 HD 3: 500 GB (Image Cache Drive) 528 

Operating System: Microsoft Windows Server 2016 529 

Network Adapter: VLAN 1301 530 

Hyland Acuo VNA Installation 531 

1. In the NCCoE test environment, the Hyland Acuo VNA was installed on a VM preconfigured with the 532 
OS and network requirements provided by Hyland. The project leveraged engineers supplied by 533 
Hyland to perform the installation.  534 
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2. Upon completion of the installation, three Windows services were created: AcuoMed, AcuoAudit, 535 
and AcuoStore. AcuoMed is associated with a DICOM database containing the patient, study, and 536 
series record information that describes the images physically present on the Acuo VNA archive 537 
system. The AcuoStore also has its own database for storing information related to the bulk storage 538 
of digital images and related data, including information about the shares and about the applications 539 
that use those shares.  540 

3. The installation created a web application for the AcuoAdmin Portal, where a Secure Sockets Layer 541 
(SSL) certificate signed by DigiCert was created and assigned to the application for hypertext transfer 542 
protocol secure (HTTPS) enforcement. 543 

Hyland Acuo VNA Configuration 544 

Hyland engineers performed configurations using the Microsoft MMC console and the AcuoAdmin 545 
Portal (https://192.168.130.120:8099/vnaweb/#1/home). The screenshots of the console management 546 
for these administration approaches are shown below: 547 

 548 

To verify successful completion of the VNA installation, the Hyland engineers launched the Acuo 549 
Administrator Portal application from the VNA server (local host). The Acuo Administrator Portal screen 550 
sample is shown below. 551 
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 552 

2.2.3 PACSgear Core Server 553 

PACSgear Core Server is a capture and connectivity suite used to process DICOM and non-DICOM 554 
medical data, including patient demographics, images, videos, and HL7 messages. PACSgear Core Server 555 
can be accessed from a web browser to handle user accounts, security, and client connectivity 556 
configuration. Installation and configuration procedures are described below. 557 

System Requirements 558 

CPU: 4 559 

Memory: 8 GB RAM 560 

Storage: 561 

 HD 1: 80 GB (OS Install) 562 

 HD 2: 170 GB (Application) 563 

Operating System: Microsoft Windows Server 2016 564 

Network Adapter: VLAN 1501 565 

PACSgear Core Server Installation 566 

The installation of Hyland PACSgear Core Server was performed by Hyland engineers as listed below: 567 
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1. The installation of Hyland PACSgear Core Server was performed by Hyland engineers per their 568 
technical guidelines. 569 

2. The installation created a web application for the PACSgear Core Portal, where an SSL certificate 570 
signed by DigiCert was created and assigned to the application for HTTPS enforcement. 571 

PACSgear Core Server Configuration 572 

Configuration of the PACSgear Core Server was performed by the Hyland engineers. The basic 573 
configuration involves managing connection settings to external devices, lookup data sources, and event 574 
trace; managing departments for multi tenancy architecture; managing user access; and many more 575 
features. Each organization will configure the PACSgear based on its specific needs. 576 

During the database configuration, the Hyland engineers created instances for representative 577 
departments (e.g., ophthalmology, radiology, and departments that may see patients who need wound 578 
treatment). 579 

Add New Departments: To add the ophthalmology department, complete the following steps: 580 

1. The Hyland engineers logged on to the PACSgear Admin portal by using https:// hyland-581 
pgcore.pacs.hclab/PGAPPS/Admin. 582 

 583 

2. On the Settings menu, select Departments. 584 
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 585 

3. After selecting Departments from the Settings pull-down, the screen advances to a Departments 586 
screen. The Departments screen lists sample hospital departments created during the installation. 587 
The project then added a new department by clicking the + Add button. 588 

 589 

4. After clicking the + Add button, the Add/Edit Department screen opened and allowed the 590 
engineers to enter corresponding information. 591 
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 592 

5. In the Name text box, the engineers entered Ophthalmology to create a department that ties with 593 
the Ophthalmology database instance created during database configuration. Engineers also added 594 
the AE title as Ophthalmology and selected a CT Scan for the modality. 595 

 596 

6. On the Destinations and Lookup Sources tabs, the engineers set up the destination and lookup 597 
sources for each department. 598 

7. On the Client tab, the engineers set up the client access permissions to this department’s 599 
resources. 600 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 37 

 601 

8. On the Series tab, click Add, type a description, click Save. 602 

9. Verify that the department has been added to the list, based on what is displayed. 603 

 604 

Add LDAP/Active Directory Server: - to use an LDAP/Active Directory server, configure these 605 
parameters: 606 

1. Create an LDAP_User account in Active Directory before proceeding. 607 

2. Using a browser, log on to the PACSgear Admin portal by using https://hyland-608 
pgcore.pacs.hclab/PGAPPS/Admin. 609 

3. On the Settings menu, select Users. 610 

https://hyland-pgcore.pacs.hclab/PGAPPS/Admin
https://hyland-pgcore.pacs.hclab/PGAPPS/Admin
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 611 

4. On the Users screen, navigate to Restrict access permissions to: and click on the LDAP Users 612 
button. Enter 192.168.120.100 to populate the Server text box, and then enter pacs.hclab for 613 
Domain. 614 

 615 

5. Click the Test button located under the Domain entry box. 616 

6. Enter the LDAP_User credentials to verify connectivity to the AD. 617 
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 618 

7. A message box appears indicating the test is successful. Click OK. 619 

 620 

PACS Scan Mobile Configuration—Install and configure the PACS Scan application to an Apple iPhone by 621 
applying these steps: 622 

1. On the iPhone, navigate to the App Store. Search for PACS Scan Mobile, from Perceptive Software. 623 
Perceptive Software is a Hyland business unit. Select the GET button to install the software, and 624 
then select the OPEN button. Select Allow to permit the software to send notifications. 625 

2. On a workstation, log in to PACSgear Core Server by using the administrator credentials; a 626 
dashboard will display and provide a Provision Device QR code. 627 

 628 

3. On the mobile device PACS Scan App, tap the QR code icon that appears under the Log In button. 629 
This will turn on the built-in camera on the iPhone. 630 
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 631 

4. Point the camera at the QR code on the PC screen until a message box appears indicating Setting 632 
Updated Your settings have been updated. This setting configures the mobile PACS Scan app to 633 
the address of its PACSgear Core Server instance. 634 

5. From a workstation, acquire the trusted root certificate from DigiCert. Further information for 635 
using DigiCert is described in Section 2.6.2.  636 

6. Download the root certificate to the workstation local drive and attach the certificate as an email 637 
attachment sent to the installer. 638 

7. The installer opens the email from the iPhone and double-clicks on the attachment to install the 639 
certificate to the device. 640 

8. To verify the certificate installation, go to Settings > General > Profiles & Device Management to 641 
list all the certificates profiles. 642 

9. Find the certificate you installed and click to display the detail. Below is an example: 643 
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 644 

10. To verify the PACS Scan Mobile App functionality, from the iPhone, double-click the PACS Scan 645 
App. The log in page will display. Use an account and password that has been associated with a 646 
clinical department to log in. Successful log in displays a patient information input page, as shown 647 
below: 648 

 649 
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2.2.4 Hyland NilRead 650 

Hyland NilRead provides image access and viewing from various devices including clinical viewing 651 
stations, tablets, and mobile devices. NilRead also provides image manipulation, interpretation, and 652 
collaboration across departments. The installation and configuration procedures are found below. 653 

System Requirements 654 

CPU: 6 655 

Memory: 12 GB RAM 656 

Storage: 657 

 HD 1: 80 GB (OS Install) 658 

 HD 2: 200 GB (Web Application) 659 

 HD 3: 100 GB (Image Cache) 660 

Operating System: Microsoft Windows Server 2016 661 

Network Adapter: VLAN 1301 662 

Hyland NilRead Installation 663 

1. The installation of Hyland NilRead was performed by Hyland engineers based on Hyland’s proprietary 664 
installation package and installation guides. NilRead has three services: the Hub Front End service, 665 
Nil Back End service, and Nil Front End service. The Hub Front End service is used to provide 666 
management service for multi-tenant configuration. The operation context is defined by the Nil 667 
database content and includes user accounts, data life-cycle rules, hanging protocols, DICOM 668 
connectivity setup, and cached DICOM data index. 669 

2. The installation created two web applications for the NilHub and NilRead Viewer, where SSL 670 
certificates signed by DigiCert were created and assigned to the applications for HTTPS enforcement. 671 

Hyland NilRead Configuration 672 

NilHub configuration is done from the NilHub web application. Launch a web browser from the NilHub 673 
server, and authenticate as admin, using the URL https://localhost:8080/, as follows: 674 
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 675 

1. To add a new site from the NilHub home page, click on the Sites tab in the top left-hand side of the 676 
screen. 677 

 678 

2. Click on the + icon on the right-hand side of the screen, to create a new Site for WOUND_CARE 679 
department, and provide the information below, and then click Save. 680 
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 Name: WOUND_CARE 681 

 Details: Wound Care Department 682 

 Code: 974 683 

 AE Title: WOUND_CARE 684 

 VNA Partition: WOUND_CARE 685 

 Database Name: WOUND_CARE 686 

 Email: none@hyland.com 687 

 688 

3. Log back in to NilHub specifying the WOUND_CARE Site in the top section of the log in screen. 689 

 690 

4. Click the Settings tab. Navigate to the User Management section and click on Accounts. 691 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 45 

 692 

5. Click Add on the bottom left-hand side of the screen and provide this information: 693 

 User Name: pacs\ptester 694 

 Last Name: Tester 695 

 First Name: Pacs 696 

 Role: User 697 

 E-Mail: ptester@hyland.pacs.com 698 

 Password: ***** 699 

6. Identify Member Groups the user needs access to and click the Add button. 700 

7. Specify the Granted Privileges the user needs to have and click the Grant button. 701 

8. Click the Save button on the bottom left-hand side of the screen. 702 
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 703 

Hyland engineers repeated the above steps to have multiple Sites that accessed different VNA 704 
partitions/tenants, such as Radiology with access to all VNA tenants and Ophthalmology with access to 705 
only the Ophthalmology VNA partition/tenant. 706 

2.3 Secure DICOM Communication Between PACS and VNA 707 

Hyland Acuo VNA and Philips IntelliSpace PACS support DICOM Transport Layer Security (TLS). DICOM 708 
TLS provides a means to secure data in transit. This project implements DICOM TLS between the Acuo 709 
VNA and IntelliSpace PACS via mutual authentication as part of the TLS handshake protocol [10]. 710 

2.3.1 Public Key Infrastructure (PKI) Certificate Creation 711 

Server/client digital certificates are created for the Hyland Acuo VNA and Philips IntelliSpace server. This 712 
project uses DigiCert for certificate creation and management. The procedures that follow assume 713 
familiarity with DigiCert. Refer to Section 2.6.2 for further detail. 714 
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2.3.1.1 Create PKI Certificate for Hyland Acuo VNA 715 

1. Use DigiCert Certificate Utility for Windows to generate a certificate signing request (CSR) for 716 
Hyland Acuo VNA. Information needed for requesting the certificate for Hyland Acuo VAN is shown 717 
below: 718 

 Common Name: Hyland-VNA.pacs.hclab 719 

 Subject Alternative Name: Hyland-VNA.pacs.hclab 720 

 Organization: NIST 721 

 Department: NCCoE 722 

 City: Rockville 723 

 State: Maryland 724 

 Country: USA 725 

 Key Size: 2048 726 

2. Submit the created CSR to DigiCert portal for certificate signing.  727 

3. Download and save the signed certificate along with its root Certificate Authority (CA) certificate in 728 
the .pem file format. 729 

4. Import the saved certificate to DigiCert Certificate Utility for Windows, and then export the 730 
certificate with its private key in the .pfx format. 731 

5. The certificate is ready for installation. 732 

2.3.1.2 Create PKI Certificate for Philips IntelliSpace PACS 733 

1. Use DigiCert Certificate Utility for Windows to generate a CSR for PACS server. Information 734 
needed for requesting the certificate is shown below: 735 

 Common Name: nccoess1.stnccoe.isyntax.net 736 

 Subject Alternative Name: nccoess1.stnccoe.isyntax.net 737 

 Organization: NIST 738 

 Department: NCCoE 739 

 City: Rockville 740 

 State: Maryland 741 

 Country: USA 742 

 Key Size: 2048 743 
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2. Submit the created CSR to DigiCert portal for certificate signing. 744 

3. Download and save the signed certificate along with its root CA certificate in the .pem  745 

4. Import the saved certificate to DigiCert Certificate Utility for Windows, and then export the 746 
certificate with its private key in the .pfx format. 747 

5. The certificate is ready for installation. 748 

2.3.2 PKI Certification Installation 749 

After creating the signed certificates for Acuo and IntelliSpace respectively, the certificates must be 750 
installed to the servers. The steps that follow describe how to install those certificates. Certificates must 751 
be applied per server instance and assume access to both. 752 

2.3.2.1 Install PKI Certificate for Hyland Acuo VNA 753 

Install the certificate on Hyland Acuo VNA server using the procedures below: 754 

1. From the Acuo server, click on Start > Run > mmc. 755 

2. Select File > Add/Remove Snap-in… 756 

 757 

3. Select Certificates and click Add. 758 

 Choose Computer Account 759 

 Choose Local Computer 760 

4. Click Finish, then click OK. 761 
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 762 

5. Once the snap-in has been added, navigate to Certificates (local computer)/Personal/Certificates. 763 

 764 

6. Right click and select All Tasks/Import. 765 

 Browse to the exported .pfx certificate. 766 

 Select the file and click Open. 767 
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 768 

7. Add the appropriate permissions to the newly generated certificate private key. 769 

 Navigate to Certificates > Personal > Certificates. 770 

 Right click on the certificate, select All Tasks > Manage Private Keys… 771 

 Add the AcuoServiceUser and grant full control permissions. Click OK. 772 

This procedure also installs the signing CA Root certificate (DigiCert Test Root CA SHA2) and its 773 
Intermediate Root certificate (DigiCert Test Intermediate Root CA SHA2) into the server computer. 774 

2.3.2.2 Install PKI Certificate for Philips IntelliSpace PACS 775 

Install the certificate on the PACS server using the procedures that follow: 776 

1. From the IntelliSpace server, click on Start > Run > mmc. 777 

2. Select File > Add/Remove Snap-in… 778 

 779 
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3. Select Certificates and click Add. 780 

 Choose Computer Account. 781 

 Choose Local Computer. 782 

 Click Finish; click OK. 783 

 784 

4. Once the snap-in has been added, navigate to Certificates (local computer)/Personal/Certificates. 785 

 786 
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5. Right click and select All Tasks/Import. 787 

 Browse to the exported .pfx certificate. 788 

 Select the file and click Open. 789 

 790 

This procedure also installs the signing CA Root certificate (DigiCert Test Root CA SHA2) and its 791 
Intermediate Root certificate (DigiCert Test Intermediate Root CA SHA2) into the server computer. 792 

2.3.3 TLS Secure DICOM Configuration 793 

With the signed certificates installed to the Acuo VNA and IntelliSpace PACS servers, proceed to 794 
configuring DICOM TLS. The set of procedures that follows describe TLS configuration that must be 795 
performed on both Acuo VNA and IntelliSpace PACS. This will enable DICOM TLS communications 796 
between these two endpoints, and secure data-in-transit communications bi-directionally between the 797 
VNA and PACS. 798 

2.3.3.1 TLS Configuration for Hyland Acuo VNA 799 

For receiving TLS DICOM message from IntelliSpace PACS, configure a new service-class provider (SCP) in 800 
Acuo VNA using Microsoft Windows Console. Configuration is done from the Acuo VNA server. 801 

1. Open Microsoft MMC to access the AcuoMed Image Manager (local): 802 

2. From the Console > AcuoMed Image Manager (local) > DICOM Configuration, right click Any Ip 803 
Address > New Scp … to create a new SCP for TLS encryption. 804 
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 805 

3. On the Connectivity tab of the SCP Properties page, provide the information below and click Add, 806 
Apply, and then Finish: 807 

 Port: 1443 808 

 Check the TLS checkbox 809 

 Client Certificate CN: nccoess1.stnccoe.issyntax.net 810 

 Server Certificate CN: HYLAND-VNA.pacs.hclab 811 

 Cipher Suite: TLS_RSA_WITH_AES_128_CBC_SHA 812 

 Check the Authenticate Client Certificate checkbox 813 
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 814 

4. To add the Called AE to the Scp, right click the created Scp [Listening Port:1443] and select New > 815 
Called AE …. to open the AE Properties form. 816 

 817 

5. Fill in the Called AE Name: e.g., RADIOLOGY and Default Route Name: e.g., RADIOLOGY. After 818 
populating the information, click Add. 819 
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 820 

For sending TLS DICOM message to IntelliSpace PACS, configure an External DICOM Device from the 821 
Acuo VNA by using Microsoft Windows Console. 822 

1. Open Microsoft MMC to access the Image Manager Server: 823 

2. Navigate to Image Manager Server > Router Configuration > External DICOM Devices, right click 824 
on External DICOM Devices and click New. 825 

 826 
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3. On the Main tab of the External DICOM Devices Properties page, provide the information below 827 
and click Apply, and then click Finish: 828 

 SCP Destination Name: PHILIPS 829 

 Called AE Name: STENTOR_SCP 830 

 IP Address: 192.168.140.131 831 

 SCP Listening Port: 2762 832 

 Enable TLS by clicking the TLS checkbox next to the listening port number. 833 

 Called AE Name: ACUO 834 

 Implementation UID: 1.2.840.114158.1.1.3 835 

 Client Certificate CN: HYLAND-VNA.pacs.hclab 836 

 Server Certificate CN: nccoess1.stnccoe.isyntax.net 837 

 Cipher Suite: TLS_RSA_WITH_AES_128_CBC_SHA 838 

 839 

4. Restart the AcuoMed service. 840 
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2.3.3.2 TLS Configuration for Philips IntelliSpace PACS 841 

Next, configure TLS on the IntelliSpace PACS server. The steps below would be taken to enable this 842 
feature on the PACS: 843 

1. Access the Philips iSite Administration web site https://192.168.140.131/iSiteWeb using 844 
administrator credentials. 845 

 846 

2. Click Configuration > DICOM, to navigate to DICOM configuration screen. 847 

 848 

3. On the top menu, click iExport to open the iExport screen. Provide the information below, and click 849 
Save: 850 

 AE Title: RADIOLOGY 851 

 Description: Hyland VNA 852 

 IP Address: 192.168.130.120 853 
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 Port: 1443 854 

 Use Secure Connection: checked 855 

 856 

4. Click Configuration > Advanced Security, perform these selections: 857 

 TLS 1.0 or higher: Selected 858 

 Enable Secure Web Services Communication 859 

 Enable Image Access in Secure Mode 860 

 Default Client Certificate: CN= nccoess1.stnccoe.isyntax.net 861 

 Default Server Certificate: CN=HYLAND-VNA.pacs.hclab 862 

 Click Save to save the settings 863 
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 864 

5. On the iSite Administration screen, click Next and click Next again to open the page that follows: 865 

a. Enable Validate Client Certificate for DICOM. 866 

b. Enable Validate Server Certificate for DICOM. 867 

c. Click Save to save the settings. 868 

 

 869 
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6. Restart the iSite Monitor Service. 870 

2.3.4 PACS and VNA TLS Integration Tests 871 

After implementing the above PKI-certification installation and TLS enabling configuration, both the 872 
Acuo VNA and IntelliSpace PACS servers are ready to perform the TLS secure DICOM communication 873 
tests. The secure DICOM communication tests were conducted for bi-direction data exchanges between 874 
Acuo VNA and IntelliSpace PACS to confirm: 875 

DICOM communication is still functional. 876 

DICOM communication is encrypted. 877 

The test proves the DICOM communication was successful, with the accurate data exchange between 878 
Acuo VNA and IntelliSpace PACS. 879 

The network flow and dataflows monitoring tool indicates that the mutual authentication between Acuo 880 
VNA and IntelliSpace PACS are established. Encrypted application data were exchanged. 881 

2.4 Modalities 882 

2.4.1 DVTk Modality Emulator 883 

DVTk Modality is a modality emulator that can be used to emulate all the DICOM functions of a modality 884 
system. It can simulate a real modality to test and verify communication with all the DICOM services. It 885 
uses DICOM files as input for Queries, modality performed procedure step (MPPS), and Storage actions. 886 
Consequently, this project chose to use the DVTk Modality as an emulator to test the connectivity, 887 
communication, workflow, and interaction between PACS and modality in the lab. 888 

System Requirements 889 

Operating System: Microsoft Window 7 (with Microsoft .NET 4.0 Framework) 890 

Network Adapter: VLAN 1402 891 

DVTk Modality Installation 892 

1. Download the installation software from the DVTK site [11]. 893 

2. Click the Modality Installation file (e.g., DVTk-Modality-Emulator-5.0.0.msi) to start the installation 894 
process. 895 
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 896 

3. Follow the wizard instruction to continue the installation until it reaches successful completion. 897 

 898 

4. Close the installation window. 899 

5. The DVTk Modality Emulator can be launched from the PC Start menu. The Modality Emulator 900 
interface is shown below. 901 
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 902 

DVTk Modality Configuration 903 

Configuration of the DVTk Modality involves the configuration of the communications with different 904 
external systems, including the RIS, which is the Worklist provider or a worklist broker connected to the 905 
RIS; the MPPS manager that handles the MPPS messages for status reporting; and the PACS and its 906 
database where the images will be stored. The information needed for these external systems should 907 
include the correct IP-Address, Port number, and Application Entity Title (AETitle). Input the information 908 
with these values: 909 

RIS System 910 

 IP Address: 192.168.160.201 911 

 Remote Port: 105 912 

 AE Title: RIS 913 

MPPS Manager 914 

 IP Address: localhost 915 

 Remote Port: 105 916 

 AE Title: RIS 917 

PACS/Workstation Systems–Storage Config 918 

 IP Address: localhost 919 
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 Remote Port: 106 920 

 AE Title: MPPS 921 

PACS/Workstation Systems–Storage Commit Config 922 

 IP Address: localhost 923 

 Remote Port: 107 924 

 AE Title: PACS 925 

Store Commit Config 926 

 IP Address: localhost 927 

 Remote Port: 107 928 

 AE Title: PACS 929 

 930 

The configuration of the modality itself is also needed to indicate its AE Title (e.g., DVTK_MODALITY), 931 
Local IP Address (e.g., 172.31.138.126), and Listen Port (e.g., 104) to be paired for association negation 932 
with other remote systems. The screenshot that follows indicates the options for the Modality Emulator 933 
configuration: 934 
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 935 

Several tabs exist for configuring the behavior of the emulator. They can be configured as needed or use 936 
the default settings. Once the configuration is done, the emulator front GUI interface provides some test 937 
buttons for verifying the connectivity, including RIS and PACS server Internet Control Message Protocol 938 
(ICMP) pings and DICOM echo: 939 

 940 
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2.4.2 DVTk RIS Emulator 941 

DVTk, the Health Validation Toolkit, is an open-source software. The DVTk RIS Emulator is an application 942 
that handles Modality Worklist and Modality Performance Procedure Step requests from remote 943 
applications and then responds with the emulated results using the DICOM files specified by the users. 944 

System Requirements 945 

Operating System: Microsoft Windows 7 (Microsoft .NET framework 2.0) 946 

DVTk RIS Emulator Installation 947 

1. Download the DVTk RIS Software installer RIS Emulator .msi file from http://www.dvtk.org. 948 

2. Start the installation procedure by double-clicking the .msi installation file. 949 

3. Follow the wizard screen instruction to continue the installation until the end of successful 950 
installation is displayed. 951 

4. Close the installation window and start to RIS Emulator. The User Interface of the RIS Emulator 952 
tool that follows is shown with the tabs that follow for selecting the modes: 953 

5. Worklist 954 

 MPPS 955 

 Edit DCM Files 956 

 Activity Logging 957 

 Validation results 958 

http://www.dvtk.org/
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 959 

DVTk RIS Emulator Configuration 960 

1. Worklist Configuration 961 

 Local AT title: AE title of the RIS Emulator 962 

 Local Port: The port of the RIS Emulator for incoming association 963 

 Remote AE title: AE title for the service class user paired with the RIS emulator 964 

 View Information Model: Information model used for sending the emulator response, default 965 
value is taken 966 

 Select Data Directory for sending WLM responses: Location for storing the emulated responses 967 
to the Worklist requests. A default setting can be used which is C:\Progam Files\DVTk\RIS 968 
Emulator\Data\Worklist\ 969 

2. The RIS Emulator also supports other parameter configuration such as MPPS and Store Files 970 
functionality. These can be done as needed. 971 

3. Configuration of the RIS Emulator and the Modality storage emulator should be done accordingly, so 972 
they can communicate with each other. 973 
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2.5 Asset & Risk Management 974 

2.5.1 Virta Labs BlueFlow 975 

Virta Labs BlueFlow is a medical asset management software that allows for the discovery and 976 
management of medical devices on the network. For this project, we used BlueFlow to create an 977 
organized inventory of the medical devices in the PACS architecture. 978 

System Requirements 979 

CPU: 2 980 

Memory: 8 GB RAM 981 

Storage: 100 GB (Thin Provision) 982 

Operating System: CENTOS 7 983 

Network Adapter: VLAN 1201 984 

Virta Labs BlueFlow Installation 985 

1. Run rpm -ihv blueflow-2.6.0-1.x86_64.rpm in the CentOS 7 terminal. 986 

 Wait for the package install process to complete. 987 

 Depending on your environment, you may need to install some dependencies before 988 
the BlueFlow package can be successfully installed. 989 

 990 

2. Run sysyemctl status blueflow.service in the CentOS 7 terminal. 991 

3. Ensure blueflow.service is active. 992 
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 993 

4. Visit https://localhost to verify BlueFlow web service is operating as expected, with a BlueFlow 994 
Login page. 995 

 996 

Virta Labs BlueFlow Network Groups Configuration 997 

1. Log in to the BlueFlow web console. 998 
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 999 

2. Navigate to the Inventory tab. 1000 

3. Under the Networks section, click on the gear icon. 1001 

 1002 

4. Enter Security Service as a Name for the new network group. 1003 

5. Enter 192.168.190.0/24 as a CIDR for the new network group. 1004 

6. Click create. 1005 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 70 

 1006 

7. Verify that the new network group (Security Services) has been created. 1007 

8. Click on the name of the new network group. 1008 

 1009 

9. Assets will be listed on this page if they match the network group’s criteria. 1010 
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10. If there are no assets currently listed, you can manually add them by navigating to Inventory > Add 1011 
Inventory or by running an IP discovery scan (detailed in the next section). 1012 

 1013 

Running an IP Discovery Scan in Virta Labs BlueFlow 1014 

1. Log in to the BlueFlow web console. 1015 

 1016 
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2. Navigate to Connectors > Discovery. 1017 

 1018 

3. Under Discovery, click the gear icon. 1019 

 1020 
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4. Check the box next to allow_create_asset. 1021 

5. Click Save. 1022 

 1023 

6. Enter an IP (e.g., 192.168.190.0/24), host name or CIDR that you would like to scan. 1024 

7. Click Run. 1025 

8. Wait for the discovery scan to finish. 1026 

 1027 
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9. Click on the row of the completed scan to view more details. 1028 

Note: From this page, you can view the output of the scan, including how many devices were 1029 
discovered within the provided network range. 1030 

 1031 

2.5.2 Tripwire Enterprise 1032 

Tripwire Enterprise is a security configuration management software that monitors file integrity through 1033 
software-based agents. For this project, we used Tripwire Enterprise to monitor file changes on PACS 1034 
servers and the VNA database. 1035 

System Requirements 1036 

CPU: 1 1037 

Memory: 4 GB RAM 1038 

Storage: 120 GB (Thin Provision) 1039 

Operating System: Microsoft Windows Server 2016 1040 

Network Adapter: VLAN 1201 1041 
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Tripwire Enterprise Console Installation 1042 

1. In the tripwire install folder under java, double-click on the jre-8u202-windows-x64 application file. 1043 

 1044 

2. Click on Run. 1045 

 1046 

3. Click on Install >. 1047 

 1048 

4. Click OK. 1049 
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 1050 

5. Wait for the install process to complete. 1051 

 1052 

6. Click Close. 1053 

 1054 

7. With Java installed, double-click on the Tripwire install application, install-server-windows-amd64. 1055 
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 1056 

8. Select the version of Java, Oracle/Sun 1.8.0 64-bit, that was previously installed. 1057 

9. Click OK. 1058 

 1059 

10. Click Next >. 1060 

 1061 

11. Check I accept the agreement. 1062 
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12. Click Next >. 1063 

 1064 

13. Specify an installation directory, C:\Program Files\Tripwire\TE, for the Tripwire installation. 1065 

14. Click Next >. 1066 

 1067 

15. Verify the host name for the machine on which you’re installing Tripwire (e.g., WIN-1068 
RUQDO7KL8A7). 1069 

16. Click Next >. 1070 
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 1071 

17. Specify the HTTPS Web Services port as 6000, HTTP EMS Integration Port as 8080, and Tripwire 1072 
Enterprise RMI Port as 9898. 1073 

18. Click Next >. 1074 

 1075 

19. Create a password for Tripwire Enterprise services. 1076 

20. Click Next >. 1077 
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 1078 

21. Verify planned installation settings are correct. 1079 

22. Click Next >. 1080 

 1081 

23. Check Install Real-time Monitoring. 1082 

24. Specify Real-time Port as 1169 for monitoring. 1083 

25. Click Next >. 1084 
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 1085 

26. Click Next >. 1086 

 1087 

27. Wait for Tripwire Enterprise installation to complete. 1088 
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 1089 

28. Click Finish. 1090 

 1091 

29. Open SQL Server Configuration Manger. 1092 

30. Under SQL Server Network Configuration > Protocols for SQL Server ensure the TCP/IP protocol is 1093 
set to Enabled. 1094 
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 1095 

31. Open SQL Server Management Studio. 1096 

 1097 

32. In the Object Explorer expand the selection for your database, right click on Databases and select 1098 
New Database… 1099 

 1100 

33. On the left, under Select a page, select General. 1101 

34. Enter a Database name as TE_DB. 1102 

35. Under Database files, for the data file, set Initial Size to at least 2,000. 1103 
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36. Click the button under Autogrowth. 1104 

 1105 

37. Check Enable Autogrowth, set File Growth to at least 20 MB, and set Maximum File Size to 1106 
Unlimited. 1107 

38. Click OK. 1108 

 1109 
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39. Under Database files, for the log file, set Initial Size to at least 500. 1110 

40. Click the button under Autogrowth. 1111 

41. Check Enable Autogrowth, set File Growth to at least 20 MB, and set Maximum File Size to 1112 
Unlimited. 1113 

42. Click OK. 1114 

 1115 

43. On the left, under select a page, select Options. 1116 

44. Set Collation to Latin1_General_CS_AI. 1117 

45. Set Recovery model to Simple. 1118 

46. Under Other Options > Miscellaneous set ANSI NULL Default to True. 1119 

47. Click OK. 1120 
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 1121 

48. In the Object Explorer, right click on your database and select New Query. 1122 

 1123 

49. Type out the following query: 1124 

ALTER DATABASE [TE_DB] SET READ_COMMITTED_SNAPSHOT ON 1125 
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50. Click Execute in the toolbar above the SQL Query window. 1126 

51. Under the SQL Query window, in the Messages window, verify the command was completed 1127 
successfully. 1128 

 1129 

52. Clear the SQL Query window, and then type out the following query. 1130 

SELECT name, is_read_committed_snapshot_on FROM sys.databases WHERE 1131 
name='<db_name>' 1132 

53. Click Execute in the toolbar above the SQL Query window. 1133 

54. Under the SQL Query window, in the Messages window, verify the value for 1134 
is_read_committed_snapshot_on is set to 1. 1135 
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 1136 

55. In the Object Explorer, expand the selection for your database, expand the Security section, right 1137 
click on Logins, and select New Login… 1138 

 1139 

56. On the left, under Select a page, select General. 1140 

57. Create a Login name. 1141 
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58. Select SQL Server authentication. 1142 

59. Create a password. 1143 

60. For Default database, select the database previously created. 1144 

61. For Default language, select English. 1145 

 1146 

62. On the left, under Select a page, select User Mapping. 1147 

63. Under the Users mapped to this login window, perform these actions for the row containing the 1148 
previously created database: 1149 

 Check the box in the Map column. 1150 

 In the Default Schema column, type the name of the new user being created. 1151 

64. Click OK. 1152 
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 1153 

65. In the Object Explorer, expand the selection for your database, expand the Databases section, right 1154 
click on the database created previously, and select Properties. 1155 

 1156 
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66. On the left, under select a page, select Permissions. 1157 

67. Under Permissions for user, check the box in the Grant column for the following permissions: 1158 

 Connect 1159 

 Create Function 1160 

 Create Procedure 1161 

 Create Table 1162 

 Create View 1163 

 Delete 1164 

 Insert 1165 

 Select 1166 

 Update 1167 

68. Click OK. 1168 

 1169 
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69. Open Internet Explorer and navigate to the webpage of the server on which Tripwire Enterprise 1170 
was installed. 1171 

70. Enter the services password created during the install process. 1172 

71. Click Login. 1173 

 1174 

72. Under Database Configuration Settings, provide the information that follows: 1175 

 Remote Database Type: Microsoft SQL Server 1176 

 Authentication Type: SQL Server 1177 

 Login Name: te_admin 1178 

 Password: ********* 1179 

 Database Host: WIN-RUQDO7KL8A7 1180 

 Database Name: TE_DB 1181 

 Instance Name: SCSP (Note: this may not be necessary, depending on how your SQL Server 1182 
Database is configured) 1183 

 SSL: Request 1184 
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 1185 

73. Click Test Database Login and verify the connection is successful. 1186 

74. Click Save Configuration and Restart Console. 1187 
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 1188 

75. Wait for Tripwire Enterprise to restart and redirect you to the log in page. 1189 

 1190 

76. Enter the services password created during the install process. 1191 

77. Click Login. 1192 
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 1193 

78. Under Create Administrator Password, create a password for the Tripwire Enterprise administrator 1194 
account. 1195 

79. Click Confirm and Continue. 1196 

 1197 

80. Enter the username and password for the Tripwire Enterprise administrator account. 1198 

81. Click Sign In. 1199 
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 1200 

82. Click Configure Tripwire Enterprise to begin the configuration process. 1201 

 1202 

Tripwire Enterprise Agent Installation 1203 

1. Run te_agent.msi. 1204 

2. Click Next >. 1205 

 1206 
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3. Check I accept the terms in the license agreement. 1207 

4. Click Next >. 1208 

 1209 

5. Specify an install directory for the Tripwire Enterprise Agent. 1210 

6. Click Next >. 1211 

 1212 

7. Enter the TE Server (e.g., WIN-RUQDO7KL8A7) of the server where Tripwire Enterprise is installed. 1213 

8. Enter 9898 as the Services Port established during the installation process of Tripwire Enterprise. 1214 

9. Check Start Agent, after installation. 1215 
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10. Check Install Real-Time Monitoring and specify a Monitoring Port. 1216 

11. Uncheck Enable FIPS. 1217 

12. Click Next >. 1218 

 1219 

13. Specify a Proxy Host and Proxy Port if necessary. 1220 

14. Click Next >. 1221 

 1222 

15. Enter the Services Password created during the installation process for Tripwire Enterprise. 1223 
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16. Click Next >. 1224 

 1225 

17. Click Install. 1226 

 1227 

18. Wait for the installation process to complete. 1228 
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 1229 

19. Click Finish. 1230 

 1231 

2.6 Enterprise Domain Identity Management 1232 

2.6.1 Domain Controller with AD, DNS, & DHCP 1233 

Within the PACS architecture, we established a Windows Server 2012 R2 Domain Controller to manage 1234 
AD, DNS, and Dynamic Host Configuration Protocol (DHCP) services for the enterprise. The following 1235 
section details how the services were installed. 1236 

System Requirements 1237 
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CPU: 1 1238 

Memory: 4 GB Ram 1239 

Storage: 120 GB (Thin Provision) 1240 

Operating System: Microsoft Windows Server 2012 R2 1241 

Network Adapter: VLAN 1201 1242 

Enterprise Domain Services Installation 1243 

Install the Domain Controller, AD, and DNS appliances according to the instructions detailed in Building 1244 
Your First Domain Controller on 2012 R2 [12]. 1245 

DNS Server Forward Lookup Zone Configuration 1246 

1. Open Server Manager. 1247 

 1248 

2. In the top right, click on Tools > DNS. 1249 

3. DNS forward lookup zone should have already been created during the DNS setup process 1250 
performed previously. If not, follow these instructions: 1251 
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 1252 

 Right click on your server’s name, and select Configure a DNS Server… 1253 

 1254 

 Click Next >. 1255 
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 1256 

 Click Next >. 1257 

 1258 

 Click Next >. 1259 
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 1260 

 Enter PACS.TEST as the Zone name, that was established previously during setup. 1261 

 Click Next >. 1262 

 1263 

 Select Allow only secure dynamic updates. 1264 

 Click Next >. 1265 
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 1266 

 Add Forwarders (8.8.8.8 and 8.8.4.4 are Google’s DNS servers). 1267 

 Click Next >. 1268 

 1269 

 Click Finish. 1270 
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 1271 

DNS Server Reverse Lookup Zone Configuration 1272 

1. Open Server Manager. 1273 

 1274 

2. In the top right, click on Tools > DNS. 1275 
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 1276 

3. Right click on Reverse Lookup Zones folder and select New Zone… 1277 

 1278 

4. Click Next >. 1279 
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 1280 

5. Click Next >. 1281 

 1282 

6. Click Next >. 1283 
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 1284 

7. Choose Internet Protocol version 4 (IPv4), IPv4 reverse Lookup Zone option and click Next >. 1285 

 1286 

8. Establish which IP addresses should be included in reverse lookup (the example above 1287 
encompasses all devices in the 192.168.120.0/24 subnet), then click Next >. 1288 
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 1289 

9. Choose Allow only secure dynamic updates (recommended for Active Directory) option and then 1290 
click Next >. 1291 

 1292 

10. Click Finish. 1293 
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 1294 

DHCP Server Installation 1295 

Install the DHCP server according to the instructions detailed in Installing and Configuring DHCP Role on 1296 
Windows Server 2012 [13]. 1297 

DHCP Server Configuration 1298 

1. Open Server Manager. 1299 

 1300 

2. In the top right, click on Tools > DHCP. 1301 
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 1302 

3. If you see a green checkmark on the IPv4 server, the DHCP server is up and running. 1303 

 1304 

DHCP Scopes Configuration 1305 

Performed on Windows Server 2012 R2. 1306 

1. Open Server Manager. 1307 
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 1308 

2. In the top right, click on Tools > DHCP. 1309 

 1310 

3. Right click on IPv4 and select New Scope… 1311 
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 1312 

4. Click Next >. 1313 

 1314 

5. Provide a Name as Radiology Devices and a Description as Collection of hospitals Radiology 1315 
equipment in the New Scope Wizard. 1316 

6. Click Next >. 1317 
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 1318 

7. Establish the IP range (192.168.120.200 – 192.168.120.254) from which the DHCP server should 1319 
hand out IPs for devices in this scope. 1320 

8. Click Next >. 1321 

 1322 

9. Click Next >. 1323 
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 1324 

10. Configure preferred Lease Duration (e.g., 8 days), and click Next >.  1325 

 1326 

11. Choose Yes, I want to configure these options now, and then click Next >. 1327 
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 1328 

12. Enter the subnet’s Default Gateway as 192.168.120.1. 1329 

13. Click Add. 1330 

 1331 

14. Click Next >. 1332 
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 1333 

15. Ensure IP address in bottom-right box is the IP address (192.168.120.101) for the DNS server 1334 
configured earlier. 1335 

16. Click Next >. 1336 

 1337 

17. Click Next >. 1338 
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 1339 

18. Choose Yes, I want to activate this scope now option and then click Next >. 1340 

 1341 

19. Click Finish. 1342 
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 1343 

20. Scope should appear under IPv4 dropdown. Ensure Scope Options are correctly established with 1344 
these values: 1345 

 003 Router: 192.168.120.1 1346 

 006 DNS Servers: 192.168.120.101 1347 

 015 DNS Domain Name: PACS.TEST 1348 

 1349 

2.6.2 DigiCert PKI 1350 

DigiCert is a cloud-based platform designed to provide a full line of SSL certificates, tools, and platforms, 1351 
for optimal certificate life-cycle management. To use the service, an account must be established with 1352 
DigiCert. Once an account is established, access to a DigiCert dashboard is enabled. From the dashboard, 1353 
DigiCert provides a set of certificate management tools to issue PKI certificates for network 1354 
authentication and encryption for data-at-rest or data-in-transit as needed. 1355 
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The instructions below describe the process used to obtain an SSL certificate on behalf of medical 1356 
devices using the DigiCert certificate signing services. 1357 

Create CSR 1358 

A CSR is represented as a block Base64 encoded PKCS#10 binary format text that will be sent to a CA for 1359 
digital signature when applying for an SSL Certificate. The CSR identifies the applicant’s distinguished 1360 
common name (domain name), organization name, locality, and country. It also contains the applicant’s 1361 
private key and the public key pair. The CSR is usually generated from the device where the certificate 1362 
will be installed, but it can also be generated using tools and utilities on behalf the device to generate a 1363 
CSR. Below is an instruction on how to use the Certificate Utility for Windows (DigiCertUtil.exe) provided 1364 
by DigiCert to generate CSRs for a medical device or a server. 1365 

Download and save the DigiCertUtil.exe from the DigiCert site [14].  1366 

1. Double-click DigiCertUtil.exe to run the utility. 1367 

2. Click the Create CSR link to open a CSR request window. 1368 

3. On the Create CSR window, fill in the key information (some of the information is optional). 1369 

 Certificate Type: Select SSL 1370 

 Common Name: HYLAND-VNA.pacs.hclab 1371 

 Subject Alternative Names: HYLAND-VNA.pacs.hclab 1372 

 Organization: NIST-NCCoE 1373 

 Department: HCLAB 1374 

 City: Rockville 1375 

 State: Maryland 1376 

 Country: USA 1377 

 Key Size: 2048 1378 

4. Click Generate to create a CSR. This will also generate a corresponding private key in the Windows 1379 
computer from which the CSR is requested. The Certificate Enrollment Request is stored under 1380 
Console Root\Certificates(Local Computer)\Certificate Enrollment Requests\Certificates. 1381 
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 1382 

5. A sample CSR is shown in the figure below: 1383 

 1384 

6. Select and copy the certificate contents to the clipboard or save it to an ascii text file. The text 1385 
contents will be used to paste into the DigiCert order form. 1386 
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7. Issue Signed Certificates. With a created applicant CSR, request a signed certificate using DigiCert 1387 
CertCentral portal, using these steps: 1388 

a. Log in to a DigiCert Dashboard (https://www.digicert.com/account/login.php) with your 1389 
account username and password. In the portal, select CERTIFICATES>Requests, then 1390 
navigate to Request a Certificate, select Private SSL to open a certificate request form. 1391 

b. Paste the CSR information to the area called Add Your CSR, including the -----BEGIN NEW 1392 
CERTIFICATE REQUEST----- and -----END NEW CERTIFICATE REQUEST----- tags. Once the 1393 
pasting is done, some of the fields will be populated automatically. 1394 

c. After filling in all the required information, scroll down to the bottom of the page, and select 1395 
the I Agree to the Certificate Services Agreement Above checkbox. Next, click the Submit 1396 
Certificate Request button at the bottom of the form to submit the certificate for signing 1397 
approval. 1398 

https://www.digicert.com/account/login.php
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 1399 

8. The certificate is listed under Orders. Once the order status changes to Issued, the certificate is 1400 
ready for download. 1401 
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 1402 

9. Click a specific order number to display the certificate details with a list of actions that can be 1403 
performed. Click Download Certificate As to download certificates with signed CA and Root CA 1404 
certificates. A variety of certificate formats can be downloaded, such as .crt, .p7b, .pem, etc. 1405 

10. Save the downloaded certificate in a location where it can be used for further processing if needed. 1406 

Import and Export the Signed Certification 1407 

After downloading the SSL Certificate from DigiCert, you can use the DigiCert Certificate Utility for 1408 
Windows to install it. With the DigiCert Utility tool, you can further manipulate the certificates to 1409 
combine with the private key and export the signed certificate to the certificate requesting device 1410 
server. 1411 

1. From the DigiCert Certificate Utility for Windows, click the Import button to load the downloaded 1412 
signed Certificate file to the utility. The downloaded file was saved in Step 10 of Section 2.6.2. Click 1413 
the Next button to import. 1414 

2. From the DigiCert Certificate Utility for Windows, click SSL to list all the imported files. 1415 

3. To export the certificate, select the certificate you want to export as a combined certificate file and 1416 
key file in a .pfx file, or separated as a certificate file and key file, and then click Export Certificate. 1417 
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 1418 

4. Click the Next > button and then follow the wizard instructions to save the certificate file and 1419 
private key file to a desired location in the device. 1420 

 1421 
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2.7 Network Control & Security 1422 

2.7.1 Cisco Firepower 1423 

Cisco Firepower, consisting of Cisco Firepower Management Center and Cisco Firepower Threat 1424 
Defense, is a network management solution that provides firewall, intrusion prevention, and other 1425 
networking services. For this project, Firepower was used to provide network segmentation and both 1426 
internal and external routing. Access control and intrusion prevention policies were also implemented. 1427 

Cisco Firepower Management Center Appliance Information 1428 

CPU: 8 1429 

RAM: 16 GB 1430 

Storage: 250 GB (Thin Provision) 1431 

Network Adapter 1: VLAN 1201 1432 

Operating System: Cisco Fire Linux 1433 

Cisco Firepower Management Center Virtual Installation Guide 1434 

Install the Cisco Firepower Management Center Virtual appliance according to the instructions detailed 1435 
in Cisco Firepower Management Center Virtual for VMware Deployment Quick Start Guide [15].  1436 

Cisco Firepower Threat Defense Appliance Information 1437 

CPU: 8 1438 

RAM: 16 GB 1439 

Storage: 48.5 GB (Thin Provision) 1440 

Network Adapter 1: VLAN 1201 1441 

Network Adapter 2: VLAN 1201 1442 

Network Adapter 3: VLAN 1099 1443 

Network Adapter 4: VLAN 1099 1444 

Network Adapter 5: Trunk Port 1445 

Network Adapter 6: Trunk Port 1446 

Network Adapter 7: VLAN 1101 1447 

Network Adapter 8: VLAN 1101 1448 

Network Adapter 9: VLAN 1701 1449 

Operating System: Cisco Fire Linux 1450 
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Cisco Firepower Threat Defense Virtual Installation Guide 1451 

Install the Cisco Firepower Threat Defense Virtual appliance, according to the instructions detailed at 1452 
Cisco Firepower Threat Defense Virtual for VMware Getting Started Guide [16]. 1453 

Adding Firepower Threat Defense (FTD) Appliance to Firepower Management Center (FMC) 1454 

1. Log in to the FMC Console. 1455 

2. Navigate to Devices > Device Management. 1456 

3. Click the Add drop-down button and select Add Device. 1457 

 1458 

4. Enter 192.168.120.141 as the IP address of the FTD appliance. 1459 

5. Enter FTD-PACS as a display name to identify the FTD appliance. 1460 

6. Enter the manager key created when configuring the manager on the FTD appliance. 1461 

7. Click the Access Control Policy drop-down and select Create New Policy. 1462 

 Create a name for the policy. 1463 

 Select Block All Traffic. 1464 

 Click Save. 1465 

8. Under Smart Licensing, check the boxes next to Malware, Threat, and URL. 1466 

9. Under Advanced check the box next to Transfer Packets. 1467 

10. Click Register. 1468 
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 1469 

11. The FTD appliance will be added to the FMC’s device list. 1470 

 1471 

FTD Interfaces for PACS Architecture Configuration 1472 

Each physical interface connected to the Cisco FTD will appear in the FMC device management section 1473 
under the interface tab. In order to configure the eight subnets needed for the PACS architecture while 1474 
also allowing for management, diagnostic, and Wide Area Network (WAN) traffic, we dedicated two 1475 
interfaces set up as a redundant pair for all internal subnet traffic. To accomplish this, a sub-interface 1476 
was created for each of the eight PACS subnets (Enterprise Services, Imaging Modalities, Security 1477 
Services, etc.), and established redundant interfaces for WAN traffic and traffic on VLAN 1101. The 1478 
following guidance describes how the redundant interfaces and sub-interfaces were created. 1479 
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1. Log in to the FMC Console. 1480 

2. Navigate to Devices > Device Management. 1481 

3. Find your FTD device and click the edit icon. 1482 

4. Navigate to Add Interfaces > Redundant Interface. 1483 

 1484 

5. Enter Internal-Network as the name for the redundant interface. 1485 

6. Create and/or add a security zone to the redundant interface. 1486 

7. Assign a Redundant ID (e.g., Internal-Network) to the redundant interface. 1487 

8. Select a primary interface and secondary interface for the redundant pair. 1488 
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 1489 

9. Navigate to the IPv4 tab. 1490 

10. Assign an IP address and netmask (e.g., 192.168.100.101/24) to the interface. 1491 

11. Click OK. 1492 

 1493 
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12. Navigate to Add Interfaces > Sub Interface. 1494 

 1495 

13. Enter VNA as the name for the sub interface. 1496 

14. Create and/or add a security zone, VNA, to the sub interface. 1497 

15. Select an interface under which the sub interface will operate. 1498 

 Note: For our build, we placed each sub-interface under Redundant 2, the redundant interface for 1499 
GigabitEthernet0/2 and GigabitEthernet0/3. These two physical interfaces were the destination for 1500 
each VLAN’s traffic. 1501 

16. Assign 1403 as the Sub Interface ID to the sub interface. 1502 

17. Assign 1403 as the VLAN ID to the sub interface. 1503 
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 1504 

18. Navigate to the IPv4 tab. 1505 

19. Assign an IP address and netmask (e.g., 192.168.142.1/24) to the sub interface. 1506 

20. Click OK. 1507 

 1508 
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21. Click Save. 1509 

22. Click Deploy and wait for deployment to FTD to complete. 1510 

23. Refresh the page and confirm that the redundant interface and sub-interface are running (shown 1511 
with a green dot on the interface’s icon). 1512 

 1513 

DHCP Relay Through Cisco Firepower Management Center Configuration 1514 

1. Log in to the FMC Console. 1515 

2. Navigate to Devices > Device Management. 1516 

3. Find your FTD device and click the edit icon. 1517 
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 1518 

4. Navigate to the DHCP tab. 1519 

 1520 

5. Navigate to the DHCP Relay Agent section. 1521 
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 1522 

6. Under DHCP Relay Agent, click Add. 1523 

 1524 

7. Assign an FTD interface as LAN. 1525 
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8. Check the box next to Enable IPv4 Relay. 1526 

9. Check the box next to Set Route. 1527 

10. Click OK. 1528 

 1529 

11. Ensure the new relay, LAN, is shown in the DHCP Relay Agent list. 1530 

 1531 

12. Under DHCP Servers, click Add. 1532 
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 1533 

13. Click the green + button to create a new object for the DHCP server. 1534 

 1535 

14. Enter Test-DHCP-Server as a name for the DHCP server. 1536 

15. Enter 192.168.100.170 as an IP address for the DHCP server. 1537 

16. Click Save. 1538 
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 1539 

17. Select the newly created DHCP server. 1540 

18. Select an FTD interface through which the DHCP server can be connected. 1541 

19. Click OK. 1542 

 1543 

20. Ensure the new server is shown in the DHCP Server list. 1544 
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21. Click Save. 1545 

22. Deploy the new configuration settings to the FTD appliance. 1546 

 1547 

Network Address Translation (NAT) Rules Configuration 1548 

1. Navigate to Devices > NAT. 1549 

 1550 

2. Click New Policy > Threat Defense NAT. 1551 

 1552 

3. Give the new policy a Name as PACS NAT. 1553 

4. Assign the FTD appliance to the new NAT policy. 1554 

5. Click Save. 1555 
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 1556 

6. Click on the NAT policy’s edit icon. 1557 

7. Click Add Rule. 1558 

8. Set NAT Rule to Auto NAT Rule. 1559 

9. Set Type to Dynamic. 1560 

10. Under Interface Objects set Source Interface Object to one of the FTD appliance’s LAN interfaces. 1561 

11. Set Destination Interface Object to the FTD appliance’s WAN interface. 1562 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 142 

 1563 

12. Under Translation, set Original Source to the network that corresponds with the source interface 1564 
object established in the previous step. 1565 

13. Set Translated Source to Destination Interface IP. 1566 

14. Click OK. 1567 
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 1568 

15. Ensure the new NAT Rule has been created. 1569 

16. Repeat these steps if needed for each LAN interface attached to FTD appliance. 1570 

17. Click Save. 1571 

18. Deploy changes to FTD appliance. 1572 
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 1573 

Access Control Policy Through Firepower Management Center Configuration 1574 

Firepower Management Center allows configuration of access control policies that can then be applied 1575 
to individual FTD appliances. The purpose of the access-control policy is to create rules that specify how 1576 
traffic is managed within the network. Each access-control policy contains multiple rules followed by a 1577 
default action established when the policy is created. For the PACS architecture, one access-control 1578 
policy was established to manage the traffic on each FTD interface. The steps below describe how the 1579 
policy and rules were created, as well as how to utilize an intrusion policy with the access-control policy. 1580 
There is additional information on Cisco Firepower access control list and intrusion prevention 1581 
configuration [17]. 1582 

1. Navigate to Policies > Access Control > Access Control. 1583 

 1584 
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2. Click New Policy. 1585 

3. Enter PACS Global Policy as the name for the access control policy. 1586 

4. For Select Base Policy select None. 1587 

5. For Default Action select Block all traffic. 1588 

6. Add the FTD appliance to the policy. 1589 

7. Click Save. 1590 

 1591 

8. Click the access-control policy’s edit icon. 1592 

Note: The policy in the screenshots that follow contain categories created during the process of 1593 
building out the PACS architecture. These categories are not pre-configured. 1594 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 146 

 1595 

Creating a category: 1596 

1. Click Add Category. 1597 

2. Enter PACS as the name for the category. 1598 

3. Insert the category into the Mandatory section. 1599 

4. Click OK. 1600 

 1601 

Create a rule that allows application traffic between security zones 1602 
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1. Click Add Rule. 1603 

2. Enter PACS-VNA as the name for the rule. 1604 

3. Insert the rule into the category created in the previous step. 1605 

4. Set Action to Allow. 1606 

Note: Because we set the default action to block all traffic when creating the policy, all of the rules 1607 
we created were set to Allow. 1608 

5. Add security zone(s) to the Source Zone, and also add security zone(s) to the Destination Zone. 1609 

Note: The two primary methods for adding source and destination networks to an access control 1610 
rule are through security zones or networks. Security zones are objects that can contain multiple 1611 
FTD interfaces. Networks can be different types of network objects, including network segments 1612 
(192.168.1.0/24) or individual devices (192.168.1.1). 1613 

 1614 

6. Under Applications, add the application(s) you would like to allow between the specified zones. 1615 

Note: This can also be accomplished by specifying the port you would like to allow under the Ports 1616 
tab. By specifying a specific port, this will open the port to all traffic regardless the type of traffic 1617 
(e.g., DICOM) being sent. 1618 

7. Click Add. 1619 
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 1620 

8. Verify that the rule has been created. 1621 

 1622 

Create a rule that allows traffic on a specific port between networks 1623 

1. Click Add Rule. 1624 
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2. Enter PACS-Internet as the name for the rule. 1625 

3. Insert the rule into the category created previously. 1626 

4. Set Action to Allow. 1627 

5. Under Networks, add a source network(s) and destination network(s). 1628 

 1629 

6. Under Ports, add a port(s) to the Selected Destination Ports. 1630 

Note: Select from a group of pre-created ports or add your own port by filling out the protocol and 1631 
port boxes, then click Add under the selected destination ports. 1632 
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 1633 

7. Under URLs, add URL categories that will be allowed (or leave this section blank). 1634 

Note: The URL categories are generated by Cisco Firepower and updated regularly. Within each 1635 
URL category, you can specify the reputation level the URL must meet in order for the rule to 1636 
match. 1637 

 1638 

8. Under Inspection, add an intrusion policy or leave this section blank. 1639 
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Note: Intrusion policies are created separately from the access-control policy. Once created, an 1640 
intrusion policy can be applied to a specific access-control rule or an entire access-control policy. 1641 
See the link posted [17] at the beginning of this section for more information on how to create and 1642 
use intrusion policies in Cisco Firepower. 1643 

 1644 

9. Under Logging, select Log at End of Connection, or leave this section blank. 1645 

Note: If logging is enabled, select Event Viewer. 1646 

10. Click Add. 1647 

 1648 
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11. Verify that the access control rules have been created and placed in the proper category. 1649 

12. Click Save. 1650 

13. Deploy changes to the FTD appliance. 1651 

 1652 

2.7.2 Cisco Stealthwatch 1653 

Cisco Stealthwatch provides network visibility and analysis through the use of network telemetry. It 1654 
provides threat detection and remediation as well as network segmentation using machine learning and 1655 
behavioral modeling. This project integrates Cisco Stealthwatch with Cisco Firepower to allow Cisco FTD 1656 
to send NetFlow directly to Stealthwatch for analysis. 1657 

Cisco Stealthwatch Management Console Appliance Information 1658 

CPU: 3 1659 

RAM: 16 GB 1660 

Storage: 60 GB (Thin Provision) 1661 

Network Adapter 1: VLAN 1901 1662 

Operating System: Linux 1663 

Cisco Stealthwatch Management Console Virtual Edition Installation Guide 1664 

Install the Cisco Stealthwatch Management Console appliance according to the instructions detailed in 1665 
the Cisco installation guide [18]. 1666 
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Cisco Stealthwatch UDP Director Appliance Information 1667 

CPU: 1 1668 

RAM: 4 GB 1669 

Storage: 60 GB (Thin Provision) 1670 

Network Adapter 1: VLAN 1901 1671 

Network Adapter 2: VLAN 1901 1672 

Operating System: Linux 1673 

Cisco Stealthwatch UDP Director Virtual Edition Installation Guide 1674 

Install the Cisco Stealthwatch UDP Director appliance according to the instructions provided at the Cisco 1675 
installation guide [18]. 1676 

Cisco Stealthwatch Flow Collector Appliance Information 1677 

CPU: 2 1678 

RAM: 16 GB 1679 

Storage: 60 GB (Thin Provision) 1680 

Network Adapter 1: VLAN 1901 1681 

Operating System: Linux 1682 

Cisco Stealthwatch Flow Collector Virtual Edition Installation Guide 1683 

Install the Cisco Stealthwatch Flow Collector appliance according to the instructions provided at the 1684 
Cisco installation guide [18]. 1685 

Configure NetFlow Parameters for Cisco Firepower 1686 

1. Log in to the Cisco Firepower Management Console. 1687 
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 1688 

2. Navigate to Objects. 1689 
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 1690 

3. Navigate to FlexConfig > Text Object. 1691 

 1692 
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4. Under the Name column, find netflow_Destination. 1693 

 1694 

5. Click the edit icon for netflow_Destination. 1695 

6. Set Variable Type to Multiple. 1696 

7. Set Count to 3. 1697 

8. For Row 1, enter Security-Service to set the name of the Cisco FTD interface to which the Cisco 1698 
Stealthwatch UDP appliance is connected. 1699 

9. For Row 2, enter 192.168.190.120 to set the IP address of the Cisco Stealthwatch UDP appliance. 1700 

10. For Row 3, enter 2055 to set a port from which the Cisco Stealthwatch UDP appliance will receive 1701 
NetFlow traffic. 1702 

11. Click Save. 1703 
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 1704 

12. Under the Name column, find netflow_Parameters. 1705 

 1706 
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13. Click the edit icon for netflow_Parameters. 1707 

14. Set Variable Type to Multiple. 1708 

15. Set Count to 3. 1709 

16. For Row 1, enter 1 as a number for minutes between flow update events. 1710 

17. For Row 2, enter 0 as a number for seconds to delay flow create. 1711 

18. For Row 3, enter 30 as a number for minutes for template timeout rate. 1712 

19. Click Save. 1713 

 1714 

20. Navigate to Devices > FlexConfig. 1715 

 1716 

21. Click New Policy. 1717 
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22. Enter a Name (e.g., Netflow) for the policy. 1718 

23. Under Selected Devices, add the Cisco FTD. 1719 

24. Click Save. 1720 

 1721 

25. Click the edit icon for the new policy. 1722 

 1723 

26. Under Available FlexConfig, find Netflow_Set_Parameters, and add it to Selected Append 1724 
FlexConfigs. 1725 
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 1726 

27. Click the magnifier icon for Netflow_Set_Parameters. 1727 

28. Under Variables > Default Value, verify the minutes between flow data events, seconds to delay 1728 
flow create, and minutes for template timeout rate that were set for netflow_Parameters. 1729 

29. Click Close. 1730 

 1731 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 161 

30. Under Available FlexConfig, find Netflow_Add_Destination, and add it to Selected Append 1732 
FlexConfigs. 1733 

31. Click the magnifier icon for Netflow_Add_Destination. 1734 

32. Under Variables > Default Value, verify the Cisco FTD interface name, IP address of the Cisco 1735 
Stealthwatch, and the NetFlow traffic port. 1736 

33. Click Close. 1737 

 1738 

34. Click Save. 1739 

35. Deploy changes to the Cisco FTD. 1740 

Forwarding Rules for Cisco Stealthwatch UDP Configuration 1741 

1. Log in to the web dashboard of the Cisco Stealthwatch Management Console. 1742 
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 1743 

2. Navigate to Settings > Central Management. 1744 

 1745 

3. Click on the ellipsis for the Cisco Stealthwatch UDP appliance and select Edit Forwarding Rules. 1746 
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 1747 

4. Click on the ellipsis for the Cisco Stealthwatch UDP appliance, select Configure Forwarding Rules. 1748 

 1749 

5. Under Forwarding Rules, select Add New Rule. 1750 
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 1751 

6. Enter a description (e.g., Firepower FTD) for the rule. 1752 

7. For source IP address and source port, enter the IP address, and port (e.g., 192.168.190.1:2055) of 1753 
the Cisco FTD interface sending the NetFlow traffic. 1754 

Note: These parameters were established in Cisco FTD, found in the previous section, for the 1755 
netflow_Destination object. 1756 

8. For destination IP address, enter the IP address (e.g., 192.168.190.122) of the Cisco Stealthwatch 1757 
Flow Collector. 1758 

9. For destination port, enter the port (e.g., 2055) of the Cisco Stealthwatch Flow Collector. 1759 

Note: This port was configured during the setup of the Flow Collector. 1760 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 165 

 1761 

10. On the Cisco Stealthwatch Management Console dashboard, view the Flow Collection Trend graph 1762 
to verify that the Cisco Stealthwatch Flow Collector is receiving packets from the Cisco 1763 
Stealthwatch UDP. 1764 

 1765 

2.7.3 Tempered Networks Identity Defined Networking (IDN) 1766 

Tempered Networks IDN provides cryptographically defined host identifiers using the HIP protocol 1767 
rather than using IP addressing. Network traffic traverses an overlay network using HIP switches that 1768 
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effectively cloak that traffic from the production network. A notional architecture is depicted in Figure 1769 
2-2 below. 1770 

Figure 2-2 Architecture of Networks IDN 1771 

 1772 

Tempered Networks Conductor is the orchestration engine and intelligence behind an IDN. As shown in 1773 
the above figure, the Conductor is responsible for creating and executing security policies and overlays. 1774 
It is also responsible for issuing unique Cryptographic IDs (CIDs) to the IDN endpoints that enforce 1775 
explicit trust relationships through device-based whitelisting. 1776 

HIPswitches are typically deployed in front of devices or hosts that cannot protect themselves, like 1777 
medical devices such as modalities and other legacy systems and machines, or when customers are 1778 
unable to install the proper endpoint-protection applications. 1779 

Installation involves the deployments of the Tempered Networks Conductor and HIPswitches. A 1780 
Conductor open virtual appliance or application (OVA) file and a HIPswitches OVA file were provided by 1781 
Tempered Networks. 1782 

2.7.3.1 Conductor Installation 1783 

System Requirements 1784 

CPU: 4 1785 

Memory: 4 GB RAM 1786 

Storage: 120 GB 1787 

Operating System: Linux Red Hat 1788 
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Network Adapter: VLAN 1201 1789 

Tempered Networks Conductor Installation 1790 

1. Log in to the vSphere Client. 1791 

2. Select File > Deploy OVF Template. 1792 

3. Respond to the prompts with information specific to your deployment, including the ova package 1793 
location, name and location, storage, networking and provisioning, etc. 1794 

4. Click Power On After Deployment, and click Finish. 1795 

5. Once the installation is done, power on the Conductor server and log in with username macinfo 1796 
and the corresponding password to set up the necessary Mac address and IP address. 1797 

2.7.3.2 HIPswitch Installation 1798 

System Requirements 1799 

CPU: 4 1800 

Memory: 1 GB RAM 1801 

Storage: 1 GB 1802 

Operating System: Linux Red Hat 1803 

Network Adapter: VLAN 1201 1804 

HIPswitch Installation 1805 

1. Log in to the vSphere Client. 1806 

2. Select File > Deploy OVF Template. 1807 

3. Respond to the prompts with information specific to your deployment, including the ova package 1808 
location, name and location, storage, networking and provisioning, etc. 1809 

4. Click Power On After Deployment, and click Finish. 1810 

5. After the installation, use the username mapconfig and the corresponding password to connection 1811 
the HIPswitch the conductor. 1812 

6. Use the username underlayaddress and its corresponding password to setup the IP address, 1813 
netmask, gateway, and DNS for the HIPswitch. 1814 

7. Repeat the above installation procedures to install additional HIPswitches. 1815 

Tempered Networks Conductor and HIPswitch Configuration 1816 
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The configuration for the Conductor and HIPswitches is done through the browser connected to the 1817 
Conductor https://ConductorIP. Below is the log in page. 1818 

1. Enter the username and password to open the Dashboard. 1819 

 1820 

2. Click Settings tab. 1821 

 1822 

3. From this page, you can set up license and perform the system setup. Click the Setup button to 1823 
enter the system setup. 1824 
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 1825 

4. Enter the proper network parameters for the Conductor, including the IP address (e.g., 1826 
192.168.120.180), Netmask (e.g., 255.255.255.0), Default gateway (e.g., 192.168.120.1), and DNS 1827 
(e.g., 8.8.8.8, 4.4.8.8), then click Configure. 1828 

 1829 
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5. An Overlay is configured to support the microsegmentation. Click the Overlay tab to open the 1830 
following page, and you can add a new overlay by clicking the + New Overlay Network…. The page 1831 
below shows a configured overlay called PACS Systems. 1832 

 1833 

6. Two HIPswitches were installed to test for this project. These two HIPswitches are Model 1834 
HIPswtich-300v, and they are named HIPswitch Internal and HIPswitch Radiology. Both were 1835 
configured to participate in the PACS Systems overlay network. 1836 

 1837 

7. Two special VLANs were created for each of these two HIPswitches under PACS Systems overlay: 1838 

 VLAN 1302 for HIPswitch Internal 1101 1839 

 VLAN 1303 for HIPswitch Radiology 1501 1840 

8. Devices to be protected under the HIP network will be connected to these two HIPswitches 1841 
through the VLANs: 1842 

 PACS Servers are connected to VLAN 1302 under the HIPswitch Internal 1101 1843 

 Medical imaging devices are connected to VLAN 1303 under the HIPswitch Radiology 1501 1844 
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After creating a secure layer in the Conductor and adding those medical imaging devices and PACS 1845 
servers to that layer, the medical imaging device and PACS server can be set up as trusted, by selecting 1846 
the Enable button on the overlay page. Once they are trusted, communication between those medical 1847 
imaging devices and PACS servers will be established. All the communication will be encrypted. 1848 

The microsegmentation is achieved by using the HIPswitch. Other VMs will not be able to communicate 1849 
with these two devices unless they are configured to do so. 1850 

2.7.4 Zingbox IoT Guardian 1851 

Zingbox IoT Guardian consists of two separate components that work together to monitor and analyze 1852 
network traffic. The first component is a cloud-based platform called Zingbox Cloud, which aggregates 1853 
and analyzes data to provide insights into the devices on the local network. The second component is 1854 
Zingbox Inspector, a local appliance that receives network flows from devices on the local network and 1855 
sends specific metadata to Zingbox Cloud for further analysis. 1856 

Zingbox Cloud Setup 1857 

1. Visit https://zingbox.com and register for an account. 1858 

2. Log in to the Zingbox console and navigate to Administration > My Inspectors > Download 1859 
Inspector. 1860 

3. Download either the .ova or the .iso file, depending on your environment’s requirements. 1861 

System Requirements 1862 

CPU: 4 1863 

Memory: 8 GB RAM 1864 

Storage: 256 GB (Thin Provision) 1865 

Operating System: CentOS 7 1866 

Network Adapter 1: VLAN 1101 1867 

Network Adapter 2: Trunk Port 1868 

Zingbox Inspector Installation 1869 

1. Create a new virtual machine, and under configuration select Typical. 1870 

2. Click Next >. 1871 

https://zingbox.com/
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 1872 

3. Create a Name for the virtual machine and assign it an Inventory Location. 1873 

4. Click Next >. 1874 

 1875 
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5. Select a destination storage for the VM. 1876 

6. Click Next >. 1877 

 1878 

7. Check Linux and set version to CentOS 4/5/6/7 (64-bit). 1879 

8. Click Next >. 1880 
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 1881 

9. Connect 2 NICs to the virtual machine and assign them to a network. 1882 

10. Check Connect at Power On for both NICs. 1883 

11. Click Next >. 1884 

 1885 
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12. Set a Virtual disk size and Provisioning method. 1886 

13. Click Next >. 1887 

 1888 

14. Verify virtual machine settings are correct. 1889 

15. Check Edit the virtual machine settings before completion. 1890 

16. Click Continue. 1891 
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 1892 

17. Set memory to 8 GB. 1893 

18. Set CPUs to 4. 1894 

19. Under New CD/DVD (adding), set these parameters: 1895 

 Check Connect at power on. 1896 

 Select Datastore ISO File, then browse for the ZingOS.iso file in your datastore. 1897 

20. Click Finish. 1898 
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 1899 

21. Connect to the inspector console and follow the on-screen prompts to finish the configuration. 1900 

22. In a web browser, enter the URL of your Zingbox Cloud instance. 1901 

23. Enter your Zingbox Cloud credentials. 1902 

24. Click Login. 1903 

25. On the home page, navigate to Administration > My Inspectors. 1904 

26. Verify that the host name of the Zingbox Inspector set up previously is visible and connected 1905 
(shown by the green cloud icon). 1906 
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 1907 

2.7.5 Forescout CounterACT 8 1908 

Forescout CounterACT is a network access control tool that can perform device discovery and 1909 
classification, risk assessment, and control automation through passive and active techniques. For this 1910 
project, the intended use of Forescout is to manage device compliance and perform necessary 1911 
remediation when devices fall out of compliance. 1912 

System Requirements 1913 

CPU: 2 1914 

Memory: 8 GB RAM 1915 

Storage: 80 GB (Thin Provision) 1916 

Operating System: Linux Kernel 3.10 1917 

Network Adapter 1: VLAN 1201 1918 

Network Adapter 2: Trunk Port 1919 

Forescout Appliance Installation 1920 

1. To begin installation, obtain the Forescout ISO. Load the Forescout ISO into the VM’s CD/DVD drive. 1921 
Make sure the CD/DVD drive is set to Connect at Power On. 1922 

2. Boot up the VM and begin the installation process. 1923 

3. Select Install CounterACT. 1924 

4. Press Enter to reboot. 1925 

5. Select option 1 to configure CounterACT. 1926 
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6. Select option 1 for standard installation. 1927 

7. Press enter to proceed. 1928 

8. Select option 1 for CounterACT Appliance. 1929 

9. Select option 1 for Per Appliance Licensing Mode. 1930 

10. Enter appliance description. 1931 

11. Give appliance a password. 1932 

12. Enter forescoutCA and apply this as the appliance host name. 1933 

13. Assign the appliance an IP address 192.168.120.160. 1934 

14. Assign appliance a network mask 255.255.255.0. 1935 

15. Enter 192.168.120.1 as the appliance’s gateway. 1936 

16. Enter domain name pacs.hclab. 1937 

17. Enter DNS server address 192.168.120.100. 1938 

18. Review configuration and run test. 1939 

19. Once the test passes, select done. 1940 

Forescout CounterACT Console Installation 1941 

1. Run Install_Management.exe. 1942 

2. Click Next >. 1943 

 1944 

3. Verify Installation Directory as C:\Users\Administrator\ForeScout CounterACT 8.0.1; click Next >. 1945 
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 1946 

4. When the Ready to Install screen appears, click Next > to begin the installation process. 1947 

 1948 

5. An Installing screen will appear that provides a status bar indicating degree of installation 1949 
completion. Click the Next> button to allow the installation to proceed. 1950 
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 1951 

6. As the installation nears completion, a screen indicating Completing the ForeScout 8.0.1 Setup 1952 
Wizard appears. Check Create Desktop shortcut; click Finish. 1953 

 1954 

7. Launch Forescout CounterACT Console and enter the information that follows, then click Login: 1955 

a. Enter 192.168.120.160 in the IP/Name text box. 1956 

b. Select Password as the Login Method.  1957 

c. Enter Administrator in the User Name text box. 1958 

d. Enter the password in the Password box. 1959 
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 1960 

Forescout CounterACT Configuration 1961 

To use the full function offered by the Forescout CounterACT, proper network configuration is required, 1962 
which may include the monitor and response interface assignments at the data center, the network 1963 
VLAN and segmentation information, IP address range that the CounterACT appliance will protect, user 1964 
Directory account information, domain credentials, core switch IP address, and vendor and SNMP 1965 
parameters. 1966 

After completing the installation, log in to the CounterACT Console using the steps below: 1967 

1. Select the CounterACT icon from the server on which you installed the CounterACT Console. A log 1968 
on page appears, as depicted below. 1969 

 1970 
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2. Provide the following information and select Login to open the Console: 1971 

a. Enter the IP address 192.168.120.160 in the IP/Name field. 1972 

b. In the User Name field, enter admin. 1973 

c. In the Password field, enter the admin password which is defined during the installation. 1974 

 1975 

The console manager can be used to view, track, and analyze network activities detected by the 1976 
appliance. It can also be used to define the threat protection, firewall, and other polices. 1977 

The figure below shows the sample asset inventory page. (Further network configuration will be needed 1978 
for complete inventory information.) 1979 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 184 

 1980 

The figure below shows the sample Policy Manager page. Further network configuration and policy 1981 
definition will be needed for complete policy information. 1982 

 1983 
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2.7.6 Symantec Endpoint Detection and Response (EDR) 1984 

Symantec Endpoint Detection and Response performs behavioral analytics on endpoint events from 1985 
Symantec Endpoint Protection, to identify potentially malicious behavior. It can sandbox impacted 1986 
endpoints, prioritize risks, and provide tailored remediation guides. 1987 

System Requirements 1988 

CPU: 12 1989 

Memory: 5 GB RAM 1990 

Storage: 500 GB (thin provisioned) 1991 

Operating System: CentOS 7 1992 

Network Adapter 1: VLAN 1901 1993 

Network Adapter 2: SPAN_PACS 1994 

Symantec EDR Installation 1995 

1. Launch the virtual appliance after deployment of the vendor-provided SEDR-4.0.0-483-VE.ova file. 1996 

2. Enter default username admin and default password. You will be required to change the default 1997 
password by entering a new password. 1998 

3. After changing the default password, the bootstrap will automatically launch. Enter the following 1999 
options during the bootstrap: 2000 

 IPv4 address []: 192.168.190.17 2001 

 IPv4 netmask []: 255.255.255.0 2002 

 Gateway []: 192.168.190.1 2003 

 Name server (IPv4) []: 192.168.120.100 2004 

 Configure another nameserver? [y/n]: n 2005 

 Configure IPv4 static routes? [y/n]: n 2006 

 What do you want to call this device?: EDR 2007 

 Set NTP server []: X.X.X.X 2008 

4. After verifying the correct details, enter Y to save changes. The appliance will restart. 2009 

 2010 

 2011 
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 2012 

5. Open a web browser and travel to the virtual appliance at https://192.168.190.170. Enter the 2013 
username setup and password *****. 2014 

6. Follow the prompts to create the initial admin account. 2015 
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 2016 

7. Select the Settings menu, and then select the Global sub-menu. 2017 

8. Ensure Enable Symantec Endpoint Protection Correlation is checked. 2018 

9. Select Add SEPM Database and enter the following options. 2019 

 2020 

10. Provide the information that follows, and click Save: 2021 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 188 

 DB Type: Embedded DB 2022 

 Entry Name: SEPM 2023 

 Address: 192.168.190.172 2024 

 Port: 8081 2025 

 Connection Password: enter your connection password 2026 

 Enabled: Checked 2027 

 2028 

11. After completing the integration with SEPM, select the Settings menu, then select the Appliances 2029 
sub-menu. 2030 

12. Select Edit Default Appliance. 2031 

13. Select Add Internal Network to create and add a Subnet, Netmask, and Description for each 2032 
internal network listed below. Make sure to save after entering the network details. 2033 
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 2034 

 Subnet: 192.168.100.0 Netmask: 255.255.255.0 Description: VLAN 1101 2035 

 Subnet: 192.168.120.0 Netmask: 255.255.255.0 Description: VLAN 1201 2036 

 Subnet: 192.168.130.0 Netmask: 255.255.255.0 Description: VLAN 1301 2037 

 Subnet: 192.168.140.0 Netmask: 255.255.255.0 Description: VLAN 1401 2038 

 Subnet: 192.168.141.0 Netmask: 255.255.255.0 Description: VLAN1402 2039 

 Subnet: 192.168.150.0 Netmask: 255.255.255.0 Description: VLAN 1501 2040 

 Subnet: 192.168.160.0 Netmask: 255.255.255.0 Description: VLAN 1601 2041 

 Subnet: 192.168.180.0 Netmask: 255.255.255.0 Description: VLAN 1801 2042 

 Subnet: 192.168.190.0 Netmask: 255.255.255.0 Description: VLAN 1901 2043 

 2044 

14. Select Settings and then Global. 2045 
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15. Uncheck Enable ECC 2.0 under Endpoint Communication Channel, SEP Policies and Endpoint 2046 
Activity Recorder. 2047 

 2048 

16. Select Settings and then Appliances. 2049 

 2050 
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17. Select EDR from the appliances list. 2051 

18. Turn Scanning on under the Network Interface Settings. 2052 

Symantec EDR and SEP Correlation 2053 

1. Open a web browser and travel to the virtual appliance at https://192.168.190.170. Log in with 2054 
your administrator account. 2055 

2. From the settings menu, select global settings. 2056 

3. Select Download Synapse Log Collector for SEPM Embedded DB. 2057 

4. After the SEPMLogCollector.msi finishes downloading move to the SEP Manager (SEPM). 2058 

5. Launch the SEPMLogCollector.msi file from SEPM. 2059 

6. Continue through the setup wizard prompts by clicking Next to use the default settings. 2060 

7. After installation is complete, launch the Log Collection for SEPM embedded database 2061 
configuration utility, and enter the values below: 2062 

 Service Hostname (optional): Leave blank 2063 

 Service IP address: 192.168.190.172 2064 

 Service port: 8082 2065 

 Log Collector connection password: enter connection password 2066 

 Confirm connection password: enter connection password again 2067 

 SEPM embedded database configuration password: enter embedded database password 2068 

8. After entering values into configuration utility, click Confirm. 2069 
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 2070 

2.8 Endpoint Protection & Security 2071 

2.8.1 Symantec Data Center Security: Server Advanced (DCS:SA) 2072 

Symantec DCS:SA utilizes a software agent to provide various server protections, including application 2073 
whitelisting, intrusion prevention, and file integrity monitoring. For this project, a DCS:SA agent was 2074 
installed on both PACS servers in our architecture. 2075 

System Requirements 2076 

CPU: 4 2077 

Memory: 8 GB RAM 2078 

Storage: 120 GB (Thin Provision) 2079 

Operating System: Microsoft Windows Server 2016 Datacenter 2080 

Network Adapter: VLAN 1901 2081 

Symantec Data Center Security Installation 2082 

1. Launch server.exe. 2083 

2. Click Next >. 2084 
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 2085 

3. Check I accept the terms of the license agreement. 2086 

4. Click Next >. 2087 

 2088 

5. Verify install location. 2089 

6. Click Next >. 2090 
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 2091 

7. Review settings. 2092 

8. Click Install >. 2093 

 2094 

9. Wait for setup and install process to complete. 2095 
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 2096 

10. SQL Server will automatically be installed during the setup process. 2097 

 2098 

11. Provide the information below, and click on Next: 2099 

 Agent port: 443 2100 
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 Bridge port: 2443 2101 

 Console port: 4443 2102 

 Web server administration port: 8081 2103 

 Web server shutdown port: 8006 2104 

 2105 

12. Uncheck Enable CWP Bridge and click Next. 2106 

 2107 
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13. Verify settings for FQDN Hostname as WIN-RUQDO7KL8A7, Static IP Address as 192.168.120.207, 2108 
and Java Heap Size as 6144 and then click Next. 2109 

 2110 

14. Create a password for the database connection. 2111 

15. Click Next. 2112 

 2113 

16. Verify Unified Management Console connection settings. 2114 

17. Create a password for Unified Management Console connection. 2115 
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18. Click Next. 2116 

 2117 

19. Verify configuration settings and click Next. 2118 

 2119 

20. Wait for configuration process to complete. 2120 

21. Click Finish. 2121 
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 2122 

22. Wait for install to complete and click OK. 2123 

 2124 

Symantec Datacenter Security Windows Agent Install 2125 

1. Run agent.exe. 2126 

2. Click Next >. 2127 
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 2128 

3. Check I accept the terms in the license agreement. 2129 

4. Click Next >. 2130 

 2131 

5. Verify installation and log files directories. 2132 

6. Click Next >. 2133 
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 2134 

7. Provide the information below, and click on Next>: 2135 

 Agent Name: WIN-RUQDO7KL8A 2136 

 Polling Interval (sec): 300 2137 

 Check Enable Intrusion Prevention 2138 

 Notification Port: 2222 2139 

 Agent Protocol: HTTPS 2140 

 2141 
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8. Provide the information below and click Next: 2142 

 Primary Management Server: 192.168.120.207 2143 

 Agent Port: 443  2144 

 Alternate Management Servers: 2145 

 Management Server Certificate: C:\User\Administrator\Desktop\agent-cert.ssh 2146 

 2147 

9. Specify a Server Security Group created through Symantec Datacenter Security Server or leave it 2148 
blank to use the default security group. 2149 

10. Click Next >. 2150 
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 2151 

11. Verify installation and configuration settings and click Install. 2152 

 2153 

12. Wait for the installation process to complete. 2154 
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 2155 

13. Click Finish. 2156 

 2157 

14. Click Yes to restart the agent machine. 2158 
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 2159 

2.8.2 Symantec Endpoint Protection 2160 

Symantec Endpoint Protection is an agent-based security solution that provides antivirus, intrusion 2161 
prevention, application whitelisting, and other capabilities. For this project Symantec SEP is used to 2162 
protect endpoints from malicious software and integrates with Symantec Endpoint Detection and  2163 
Response to detect suspicious behavior. 2164 

System Requirements 2165 

CPU: 4 2166 

Memory: 8GB RAM 2167 

Storage: 240GB (thin provisioned) 2168 

Operating System: Microsoft Windows Server 2016 2169 

Network Adapter: VLAN 1901 2170 

Symantec Endpoint Protection Manager Installation 2171 

1. Launch Symantec_Endpoint_Protection_14.2.0.MP1_Part1_Trialware_EN.exe file. 2172 

2. Select Install Symantec Protection Endpoint Manager option. 2173 
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 2174 

3. Proceed through the install wizard by clicking Next >. 2175 

 2176 

4. Check I accept the terms in the license agreement. 2177 

5. Click Next >. 2178 
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 2179 

6. Select the location you want to install Symantec Endpoint Protection Manger and click Next >. Keep 2180 
the default location of C:\Program Files (x86)\Symantec\Symantec Endpoint Protection Manager\. 2181 

 2182 

7. Select Install. 2183 
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 2184 

8. After installation is complete, click Next > to continue with configuration of the management 2185 
server. 2186 

 2187 

9. Select Default configuration for new installation; click Next >. 2188 
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 2189 

10. Provide the following information and click Next>. 2190 

 Company Name: NCCoE 2191 

 User name: admin 2192 

 Password: ******** 2193 

 Confirm password: ******** 2194 

 Email address: admin@nccoe.labs 2195 

mailto:admin@nccoe.labs


DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 210 

 2196 

11. Confirm that Run LiveUpdate during installation is checked; click Next >. 2197 

 2198 
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12. Uncheck Send anonymous data to Symantec to receive enhanced threat protection intelligence 2199 
and click Next >. 2200 

 2201 

13. After installation is completed, check Launch the Symantec Endpoint Protection Manager to 2202 
configure your hosts; click Finish. 2203 
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 2204 

Symantec Endpoint Protection Host Windows Installation 2205 

1. Launch the Symantec Endpoint Protection Manager and log in as the admin. 2206 

 2207 

2. Select Install the client software on your computers from the Getting Started screen. 2208 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 213 

 2209 

3. Confirm that New Package Deployment is checked and click Next >. 2210 

 2211 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 214 

4. Confirm the settings Install Packages: Windows - Symantec Endpoint Protection version 2212 
14.2.1023.0100 - English, Group: My Company, Install Feature Sets: Full Protection for Clients, 2213 
Install Settings: Default Standard client installation settings for Windows. Click Next >. 2214 

 2215 

5. Confirm that Save Package is selected and click Next >. 2216 
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 2217 

6. Specify the location to save the installation files and click Next >. 2218 
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 2219 

7. Confirm details of custom installation files and click Next >. 2220 
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 2221 

8. Move the installation package to the Operating System on which you want to install Symantec 2222 
Endpoint Protection. 2223 

9. Launch the executable file and follow the prompts to install Symantec Endpoint Protection. 2224 

2.9 Data Security 2225 

No specific solution was implemented in the NCCoE lab to address data-at-rest encryption. 2226 

The NCCoE lab used several different solutions to address data-in-transit encryption. As described in 2227 
Section 2.6.2, DigiCert PKI, the lab implements SSL/TLS encryption using DigiCert-issued certificates. 2228 
Communications between modalities and clinical systems are secured using HIP, as described in Section 2229 
2.7.3, Tempered Networks Identity Defined Networking (IDN). 2230 
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2.10 Secure Remote Access 2231 

2.10.1  TDi Technologies ConsoleWorks 2232 

The NCCoE lab implemented a VendorNet using TDi ConsoleWorks, which is a browser interface that 2233 
enables HDOs to manage, monitor, and record activities from external vendors in the IT infrastructure. 2234 

System Requirements 2235 

CPU: 1 2236 

Memory: 8 GB RAM 2237 

Storage: 40 GB  2238 

Operating System: CentOS 7  2239 

Network Adapter: VLAN 1097 2240 

TDi ConsoleWorks Installation 2241 

The TDi ConsoleWorks installation in this PACS environment replicates the installation in the Wireless 2242 
Infusion Pumps project. For detailed installation guidance, please refer to the Section 2.1.8 TDi 2243 
ConsoleWorks External Remote Access in NIST SP 1800-8C, Securing Wireless Infusion Pumps [19]. 2244 

TDi ConsoleWorks Radius Authentication Configuration 2245 

In our project, we integrated TDi ConsoleWorks with the Symantec VIP, for two-factor authentication. 2246 
This section explains how to enable external authentications for ConsoleWorks. In the next section we 2247 
explain how we configured Symantec VIP to integrate with ConsoleWorks. 2248 

1. Download extern_auth_radius.so file from ConsoleWorks support site [20].  2249 

2. Move extern_auth_radius.so file to /opt/ConsoleWorks/bin directory. 2250 

3. Restart ConsoleWorks by executing cw_stop and cw_start scripts located in the 2251 
/opt/ConsoleWorks/bin directory. 2252 

4. From the ConsoleWorks web interface, navigate to Security and click External Authentication. 2253 

5. Click add to create a new external authentication source. 2254 

6. Fill out the required fields. Below is the setup we used: 2255 

 Record Name: Radius 2256 

 Ensure Enable is checked 2257 

 For Library select radius 2258 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 219 

 Parameter 1: 192.168.120.190:1812/******* 2259 

 Parameter 2: 30 2260 

 Parameter 6: 15 2261 

 Template User: CONSOLE_MANAGER 2262 

7. Continue through the prompt by clicking Next; click Save on the final prompt. 2263 

 2264 

8. Ensure that Enable External Authentication is checked. 2265 

 2266 
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2.10.2 Symantec Validation and ID Protection (VIP) 2267 

Symantec Validation and ID Protection is an authentication service that provides various forms of 2268 
authentication such as push, SMS, and biometric. For this project, Symantec VIP is used as a second form 2269 
of authentication for remote access to the PACS architecture through TDi Technologies ConsoleWorks. 2270 

System Requirements 2271 

CPU: 4 2272 

Memory: 8192MB RAM 2273 

Storage: 240GB (thin provisioned) 2274 

Operating System: Microsoft Windows Server 2016 2275 

Network Adapter: VLAN 1201 2276 

Symantec VIP Installation 2277 

1. Right click on the setup.exe file for VIP Enterprise Gateway 9.8.0; select Run as administrator. 2278 

 2279 

2. Proceed through the install wizard by clicking Next >. 2280 
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 2281 

3. Check I accept the agreement. 2282 

4. Click Next >. 2283 

 2284 

5. Create a username as admin and password and click Next >. 2285 
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 2286 

6. Keep the default installation location by clicking Next >. 2287 

 2288 

7. Click Install. 2289 
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 2290 

8. Click Finish after installer is complete. 2291 

 2292 

9. On the Symantec VIP local machine, open a web browser and navigate to http://localhost:8232. 2293 
Sign in with the User Name as admin and corresponding Password specified during installation. 2294 
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 2295 

10. Select User Store from the menu bar. 2296 

 2297 

11. Add a user store with the following information: 2298 



DRAFT 

 

NIST SP 1800-24C: Securing Picture Archiving and Communication System (PACS) 225 

 Name: AD PACS 2299 

 Connection: ad-main 2300 

 Host: ad.pacs.hclab 2301 

 Port: 389 2302 

 User DN: CN=symantec, DC=pacs, DC=hclab 2303 

 Password: ********* 2304 

 Base DN: DC=pacs, DC=hclab 2305 

 User Filter: (&(&objectClass=user)(objectCategory=person))(sAMAcountName=%s)) 2306 

 2307 

12. Log into VIP Manager by navigating to https://manager.vip.symantec.com/vipmgr. Use the account 2308 
provided by Symantec. 2309 

13. Select Register Your VIP Credential. Provide the Credential ID and Security Code of your 2310 
credentials. Credentials can be downloaded by navigating to https://vip.symantec.com/.  2311 

https://vip.symantec.com/
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 2312 

14. After registering the credential, select Go to My Account. 2313 

 2314 

15. Select Account from menu bar, then select Manage VIP Credentials. 2315 
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 2316 

16. Select Request a Certificate. 2317 

 2318 

17. Provide a Certificate Name as NCCoE_VIP_Cert; click Submit Request. 2319 
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 2320 

18. Select PKCS#12 format and create a password for the requested certificate. Then select Download 2321 
Certificate. 2322 

 2323 

19. Save the certificate on the Symantec VIP local machine. 2324 
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20. Navigate to http://localhoat:8232. After logging, select Add VIP Certificate. 2325 

 2326 

21. Select Browse and upload the certificate from the previous step. Enter the correct password and 2327 
alias for the certificate, then click Submit. 2328 

 2329 

22. Select Validation from the menu bar, select Custom configuration, and provide the information that 2330 
follows: 2331 

 Server Name: vip 2332 

 Local IP: 192.168.120.190 2333 
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 Port: 1812 2334 

 RADIUS Shared Secret: ***** 2335 

 Confirm RADIUS Shared Secret: ***** 2336 

 Enable First Factor: Checked 2337 

 Authentication on: Enterprise 2338 

 Authentication Sequence: LDAP Password – VIP Authentication 2339 

 User Store: AD PACS 2340 

 2341 

23. Click Submit. 2342 
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 2343 

24. Ensure VIP Server Status is set to ON. 2344 

2345 
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Appendix A List of Acronyms 
 

AD Active Directory  

AES Advanced Encryption Standard  

AE Title Application Entity Title 

CA Certificate Authority 

CID Cryptographic ID 

CSR Certificate Signing Request 

CPU Central Processing Unit 

DB Database 

DC Domain Controller 

DCS:SA Data Center Security: Server Advanced 

DHCP Dynamic Host Configuration Protocol 

DICOM Digital Imaging and Communications in Medicine 

DNS Domain Name Service 

EDR Endpoint Detection and Response 

FMC Firepower Management Center 

FTD Firepower Threat Defense 

GB gigabyte 

GUI Graphical User Interface 

HD Hard Drive 

HDO Healthcare Delivery Organization 

HIP Host Identity Protocol 

HL7 Health Level 7 

HTTP Hypertext Transfer Protocol 

HTTPS Hyper Text Transfer Protocol Secure 
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ICMP Internet Control Message Protocol 

IDN Identity Defined Networking 

IHE Integrating Health Enterprise 

IIS Internet Information Services 

IoT  Internet of Things 

IP Internet Protocol 

IPv4 Internet Protocol version 4 

ISO International Standards Organization 

IT Information Technology 

JDK Java Development Kit 

LDAP Lightweight Directory Access Protocol  

MB megabyte 

MPPS Modality Performed Procedure Step 

NAT Network Address Translation 

NCCoE National Cybersecurity Center of Excellence 

NIC Network Interface Controller 

NIST Nation Institute of Standards and Technology 

NTP Network Time Protocol 

OS Operating System 

OVA Open Virtual Appliance or Application 

OVF Open Virtualization Format 

PACS Picture Archiving and Communication System 

PKI Public Key Infrastructure 

QR Code Quick Response Code 

RAM Random Access Memory 

RIS Radiology Information System 
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SCP Service Class Provider 

SCU Service Class User 

SEP Symantec Endpoint Protection 

SEPM Symantec Endpoint Protection Manager 

SNMP Simple Network Management Protocol 

SP Special Publication 

SQL Structured Query Language 

SSL/TLS Secure Socket Layer/Transport Layer Security 

TCP/IP Transmission Control Protocol/Internet Protocol 

UDM Universal Data Manager 

UDP User Datagram Protocol 

URL Uniform Resource Locator 

VLAN Virtual Local Area Network 

VM Virtual Machine 

VNA Vendor Neutral Archive 

WAN Wide Area Network 
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